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Introduction
In this chapter

� Autodesk Land Desktop 3

� What’s New in Autodesk 
Land Desktop

� First things to know

� How to use the 
documentation set

� Finding information
Autodesk Land Desktop 3 is based on AutoCAD 2002 

and Autodesk Map 5. Using Autodesk Land Desktop 3, 

you can create, maintain, output, and analyze all of the 

data in your land development projects.

New features include integrated LandXML data import 

and export, updated Point Group Manager, and updated 

dialog boxes for listing and editing points.
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Autodesk Land Desktop 3

Autodesk Land Desktop 3 is the foundation of the Autodesk Land Solutions 
suite. Designed for professionals in the land planning and development 
industries, the Land Solutions suite includes the following products:

� Autodesk® Land Desktop 3: This is the AutoCAD for land development 
professionals. It provides a base level of functionality for land planners, 
surveyors, civil engineers, drafters, and anyone who creates supporting 
documents. 

Autodesk Land Desktop 3 contains all of the functionality of 
AutoCAD 2002 and Autodesk Map 5.

Autodesk Land Desktop provides an Application Programming Interface 
(API), so that other add-on products can be designed to work with 
Autodesk Land Desktop. 

� Autodesk® Survey 3: An add-on to Autodesk Land Desktop that provides 
a streamlined ability to communicate survey data to and from the field. 

� Autodesk® Civil Design 3: An add-on to Autodesk Land Desktop that 
provides transportation and site engineering tools, and hydrology and 
hydraulics design and analysis.

NOTE Autodesk Land Desktop 3 is an upgrade to AutoCAD Land 
Development Desktop Release 2i. You can install and use both products on your 
machine at the same time.

To use Autodesk Land Desktop 3 .dwg files with earlier releases, save version 3 
drawings in R14 format by using the Save As command from the File menu. 
Otherwise, all Land objects display as proxy graphics.

Installing Autodesk Land Desktop

Instructions for installing a stand-alone version of Autodesk Land Desktop 
are provided in Chapter 2 of this guide. Network installation instructions are 
available during installation from within the Installation Wizard. 
2 | Chapter 1 Introduction



What’s New in Autodesk Land Desktop

New Features in Release 3

Product Name and Version Changes

� The product name, formerly AutoCAD Land Development Desktop, is 
now Autodesk Land Desktop. 

� The default project folder is now \Land Projects 3.

Windows® ME Support

� Autodesk Land Desktop now supports the Windows Millennium Edition 
(ME) operating system in addition to Windows 2000, Windows 98, and 
Windows NT 4.0. Windows 95 is no longer supported.

Documentation

� The instructions for installing a stand-alone version of Autodesk Land 
Desktop are provided in Chapter 2 of this guide. 

� The instructions for installing a network version of Autodesk Land 
Desktop are provided online. You can view the instructions when you 
begin the installation process. You can also access the instructions after 
installation from the Help table of contents.

� The information in the online Help is now organized into Concept, 
Procedure, and Reference tabs. For more information, see “Concepts, 
Procedures, and Reference Information in Help” on page 16.

LandXML Import/Export

� You can use the Import LandXML and Export LandXML commands to 
import and export Autodesk Land Desktop project data in LandXML 
format. This feature was previously provided as an extension to AutoCAD 
Land Development Desktop 2i. For more information, see Chapter 8, 
“Importing and Exporting Data in LandXML Format” on page 221.

Point Groups and Point Selection Dialog Boxes

� The Create Point Group dialog box has been updated to provide a new 
method for selecting the points to add to a point group (on the Raw 
Desc Matching tab) and for reviewing the points selected (on the 
Summary tab).

� Point groups now have persistent properties and can be updated when 
point data (such as elevation or description) change, or if points are added 
to or removed from the point database. 
What’s New in Autodesk Land Desktop | 3



� You can now save point groups to, and load point groups from, 
a prototype.

� The point selection dialog boxes for editing and listing points have been 
updated. Similar to the new Create Point Group dialog box, they now 
contain Raw Desc Matching, Include, Exclude, and Summary tabs. Also 
included is a tab from which you can select point groups to list or edit.

� You can now insert points into the drawing, erase points, remove points 
from the drawing, and lock and unlock points from within the Point 
Group Manager and the point selection dialog boxes.

Support for Trimble Products

� During the installation process, you can choose to install a Trimble menu, 
which provides commands to import and export data from and to Trimble 
equipment. To use some of these Trimble Link™ commands, such as 
Import Job and Export Road, Autodesk Survey or Autodesk Civil Design 
must be installed. 

Features in Release 2i
If you are upgrading from Release 1.0 or 2.0 of AutoCAD Land Development 
Desktop, read the following list that describes some of the key features that 
were added to AutoCAD Land Development Desktop Release 2i. 

� Internet Collaboration Tools.
� The Today Window replaced the Startup dialog box.
� The Label Slope command labels the slope between two selected points on 

a surface, or labels the slope of a TIN triangle.
� The DEM support within the Terrain Model Explorer can be used to 

include DEM files (Digital Elevation Models) in surfaces.
� The ActiveX Object Model for parcels can be used to create custom com-

mands for working with parcels.
� The GIS Data Transformer provides greater data translation abilities when 

importing and exporting file formats. Drivers are available for formats 
such as SDTS and VML. For example, you can import SDTS files into a 
drawing and then export to VML to view the drawing in a Web browser.

� The Live Enabler automatically downloads Object Enabler functionality 
from the Internet for AutoCAD users when they open an Autodesk Land 
Desktop drawing that contains custom objects. 
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Features in Release 2.0
If you are upgrading from Release 1.0 of AutoCAD Land Development 
Desktop, read the following list that describes some of the key features that 
were added to AutoCAD Land Development Desktop Release 2.0. 

� DBX support was provided for inter-operability with other AutoCAD 
programs such as 3D Studio Viz® .

� The ActiveX Object Model was added, which you can use to create custom 
projects, points, contours, terrain, and alignments commands.

� The Point Group Manager and the List Points dialog box display both the 
full and raw point descriptions.

� Point objects can be rotated and leaders can be turned off.
� The alignment database was updated to support multiple users.
� Certain grading commands were moved from the Civil Design Grading 

menu to the Points and Terrain menus.
� The Building Offset Label command was added to Labels menu.
� 3D Orbit interface was added to the Object Viewer.
� The Set Text Style command was replaced with the standard AutoCAD 

Text Style command.
� Support for AutoCAD lineweights and plot styles was added to the 

Layer Manager.
� Lineweight was added to the Build Selection Set dialog box.
� The Curve Solver command was added to Utilities menu.
� The Join 3D Polyline command was moved to the Terrain menu.

First Things to Know

This section is designed to introduce you to the elements that form the foun-
dation of Autodesk Land Desktop: projects, prototypes, templates, setup 
profiles, settings, and menu palettes.

Projects

The project is a basic unit of Autodesk Land Desktop. It is a directory structure 
that contains all the data and settings relevant to the job you are designing. 
Data includes points, surfaces, drawings, and any other data that you create 
or reference in your work. Drawings within a single project might illustrate 
separate aspects of the design yet share a common databases and use 
common styles.

 Land Desktop 

tarted

rch Help for…
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When you install Autodesk Land Desktop, a project folder (c:\Land Projects 3, 
by default) is created. Each time you create a project, a subfolder named 
<project name> is created within the project folder. For example, if you create 
a project named 97201, then Autodesk Land Desktop creates the following 
folder:

c:\Land Projects 3\97201

Autodesk Land Desktop requires that drawings be associated with projects so 
that it has a location in which to store its external files. When you start a new 
drawing, you are prompted to select a project for the drawing. You can either 
create a new project or assign the drawing to an existing project. The drawing 
remains associated with that project as long as the project exists in the cur-
rent Project Path. If you delete the project or if you change the project path, 
then you are prompted to select a project the next time you open the draw-
ing. You can also associate an existing drawing (already assigned to a project) 
with a different project by using the Reassociate Drawing command.

NOTE If you open a drawing, or create a new drawing, without using the 
Autodesk Land Desktop versions of the New and Open commands, you are 
prompted to select a project with which to associate the drawing. If you decline 
to select a project, then Autodesk Land Desktop automatically creates a project 
called _scratch and links the drawing to it.

When you create a new project, you must specify a name and a prototype 
(default settings for new drawings that are associated with the project) for the 
project. You can also add a description of the project and any keywords that 
help you identify the project. When you are searching for a project, you can 
filter the list of projects based on the keywords to find a particular project.

For more information, see “Working with Projects” on page 58.

TIP Although it is not required, we suggest that you save the drawings in the 
\dwg subfolder that is created in the project folder. This keeps the drawing and 
the project files together for easier archiving. 
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Prototypes

Prototypes provide a convenient way for you to maintain standard settings for 
the drawings. After you set up the drawing settings by using the Drawing 
Settings command on the Projects menu, you can save them back to a proto-
type. When you create a new project, you can select a prototype to use for 
the default settings for new drawing creation. 

At first, prototypes may seem similar to templates. However, each serves a 
distinct purpose: 

� Templates are comprised of drawing setup values that control the 
elements of a drawing. These might include standard layers, text styles, 
line types, dimension styles, and AutoCAD variables like Aperture. They 
can also store blocks, such as a border or a company logo. For more infor-
mation, see the following section, “Templates.” 

� Prototypes store settings that determine how Autodesk Land Desktop 
behaves. For instance, a prototype might control point settings, output 
settings, and standard point groups.

When you install Autodesk Land Desktop, a root prototype folder 
(c:\Program Files\Land Desktop 3\data\prototypes) is created. Each prototype 
is represented by a subfolder of this root prototype folder. For example, if you 
create a prototype named MYPROTO, then Autodesk Land Desktop creates 
the following folder:

c:\Program Files\Land Desktop 3\data\prototypes\myproto

Autodesk Land Desktop always maintains default prototypes, one for feet 
and the other for meters. If you delete these prototypes, then they are 
recreated, using the default system settings, the next time you start 
Autodesk Land Desktop. For more information about prototype settings, see 
“Prototype Settings” on page 53.

TIP When you base a new project on a prototype, the entire prototype folder 
is copied to the new project folder. You may want to store commonly-used files 
in a prototype folder so they are automatically copied to new projects. 

es - concept

rch Help for…
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Templates

When you create a new drawing, you can base it on a drawing template. 
A drawing template is a drawing file with pre-established settings for new 
drawings and has the extension .dwt. For example, you can set up all stan-
dard layers in a drawing and save the drawing as a .dwt file. If you base a new 
drawing on this template, then the new drawing is created with all the stan-
dard layers. Templates also store text styles, line types, dimension styles, and 
AutoCAD variables like Aperture. They can also store blocks, such as a border 
or a company logo. 

A template also stores drawing setup values. For example, if you use the 
Drawing Setup Wizard or the Drawing Setup command to set up a drawing, 
and then you save that drawing as a .dwt file, then the next time you create 
a new drawing based on the drawing template, all of the drawing setup 
values are added.

Setup Profiles

Each new drawing can have different units, scale, zone, orientation, text 
style, sheet size, and border settings. These settings are collectively known as 
a setup profile. 

Several setup profiles are included with Autodesk Land Desktop. You can load 
one of these profiles, or you can customize a setup profile by using the 
Drawing Setup Wizard or the Drawing Setup command. 

You have three options for drawing setup: 

� The Drawing Setup Wizard guides you through the setup process by using 
tips and context-sensitive help that describe each option on each page of 
the wizard. At the end of the Wizard, you can save the settings to a setup 
profile you can use again.

� The Drawing Setup command presents all the drawing settings necessary 
for setting up a drawing, such as units, text style, current zone, and so on, 
including saving and loading setup profiles. 

� The User Preferences command has an option you can select to load a 
pre-existing setup profile automatically.

 Templates - 

rch Help for…
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Settings

Autodesk Land Desktop settings are comprised primarily of two types: user 
preferences and drawing settings.

� The User Preferences control program-wide preferences such as the project 
paths for various files, the AutoCAD overrides, and the drawing setup 
method. 

The preference settings are stored in the following folder:

c:\Program Files\Land Desktop 3\data\pref

The file name is <AutoCAD login name>.dfm. The preference path settings 
are stored in the sdsk.dfm file in the program folder.

� Drawing settings control many different parameters in Autodesk Land 
Desktop, such as output settings, label settings, and point settings. When 
you create a new drawing in a project, the drawing is assigned default 
drawing settings based on the prototype. 

After you change the drawing settings, you can save the settings to a pro-
totype so the settings can be used by other drawings in the project. When 
you create a new drawing in a project that is based on that prototype, then 
the drawing settings that you saved to the prototype are used for the draw-
ing. If you changed settings and you want to restore them to the original 
drawing settings, then you can reload the prototype settings.

The drawing settings file is stored in the project’s \dwg folder. The current 
drawing name is used as the file name with a .dfm extension. For more 
information, see “Establishing Settings” on page 49. 

Menu Palettes

Autodesk Land Desktop menus are arranged in palettes. A menu palette 
defines the pull-down menus that are available. When you first start 
Autodesk Land Desktop, the Land Desktop 3 menu palette is loaded. If you 
want to use Autodesk Civil Design commands, for example, then you must 
switch to the Civil Design palette.

The default menu palettes that are installed with Autodesk Land Desktop 
include the following:

� Land Desktop 3: Contains all the Autodesk Land Desktop menus 
(Projects, Points, Lines/Curves, Alignments, Parcels, Labels, Terrain, 
Inquiry, Utilities, Help), the Map menu, and the AutoCAD File, Edit, and 
View menus. This menu palette is loaded by default when you start 

g the User 
es - concept

rch Help for…
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Autodesk Land Desktop for the first time. This menu palette also includes 
the Trimble menu if you chose to install Trimble.

� Land Desktop 3 Complete: Contains all the Autodesk Land Desktop 
menus, the Map menu, and the AutoCAD File, Edit, View, Insert, Format, 
Tools, Draw, Dimension, and Modify menus. This menu palette also 
includes the Trimble menu if you chose to install Trimble.

� Autodesk Map 5: Contains the standard Autodesk Map 5 menu, the 
Autodesk Land Desktop Projects menu, and the AutoCAD File, Edit, View, 
Insert, Format, Tools, Draw, Dimension, and Modify menus.

� Civil Design 3 (If installed): Contains the Civil Design menus (Grading, 
Layout, Profiles, Cross Sections, Hydrology, Pipes, Sheet Manager), the 
Autodesk Land Desktop Projects, Points, Terrain, Alignments, Inquiry, 
Utilities, and Help menus, the Map menu, and the AutoCAD File, Edit, 
and View menus. This menu palette also includes the Trimble menu if you 
chose to install Trimble.

� Survey 3 (If installed): Contains the Survey menus (Data Collection/
Input, Analysis/Figures), the Autodesk Land Desktop Projects, Points, 
Lines/Curves, Labels, Terrain, Inquiry, Utilities, and Help menus, the Map 
menu, and the AutoCAD File, Edit, and View menus. This menu palette 
also includes the Trimble menu if you chose to install Trimble.

To create a custom menu palette, you can use the MENULOAD command to 
set up the AutoCAD, Autodesk Map, and Autodesk Land Desktop menus the 
way you want them, and then save this configuration as a palette.

Menu palettes are saved in the following folder:

c:\Land Desktop 3\data\Menu Palettes

Release 3, 2i, and 2.0 menu palettes have the file extension .apm2, whereas 
Release 1 menu palettes had the file extension .apm.

NOTE When you save a menu palette, only the pull-down menu configura-
tions are saved. Toolbar configurations are not saved with menu palettes. 

Selecting a Menu Palette
By default, the Land Desktop 3 menu palette is displayed the first time that 
you run Autodesk Land Desktop. You can select a different menu palette, 
such as the Land Desktop 3 Complete menu palette, if you want to access 
different menus.

There are three ways to select a menu palette:

� You can choose Menu Palettes from the Projects menu and select a menu 
palette from the Menu Palette Manager dialog box.
10 | Chapter 1 Introduction



The following illustration shows the Menu Palette Manager.

� You can type a macro at the command line to load a default menu palette, 
such as MLC to load the Land Desktop 3 Complete menu palette.

� You can type a command at the command line to access a custom-named 
menu palette. 

For more information, see “Selecting a Menu Palette” on page 41.

How to Use the Documentation Set

The documentation set for Autodesk Land Desktop includes both online 
Help files and printed documentation. Because Autodesk Land Desktop com-
bines the features of AutoCAD and Autodesk Map along with the Land 
Desktop features, the online AutoCAD and Autodesk Map documentation is 
also included in the documentation set. 

� Autodesk Land Desktop documentation provides help with commands in 
the Projects, Points, Lines/Curves, Alignments, Parcels, Labels, Terrain, 
Inquiry, and Utilities menus.

� AutoCAD documentation provides help with commands in the File, Edit, 
View, Insert, Format, Tools, Draw, Dimension, and Modify menus. 

� Autodesk Map documentation provides help with commands in the 
Map menu.

NOTE If you installed the Trimble features, you can access Help about these 
commands by choosing Trimble Link Help from the Trimble menu.
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The Autodesk Land Desktop documentation set includes the following 
documents:

� Autodesk Land Desktop Network Administrator’s Guide (online)
� Autodesk Land Desktop Getting Started (printed and in Adobe PDF format)
� Autodesk Land Desktop User’s Guide (online)
� Autodesk Land Desktop Tutorial (online)
� Autodesk Map Tutorials (online)
� Autodesk Land ActiveX and VBA Developer’s Guide and Autodesk Land 

ActiveX and VBA Reference (online)
� AutoCAD Learning Assistance (online)
� A complete set of online AutoCAD documentation
� A complete set of online Autodesk Map documentation

Recommendations for New Users

Learning Autodesk Land Desktop
Use this guide and the Autodesk Land Desktop tutorial to learn the main 
concepts and functionality of the program. For more in-depth information, 
go to the Autodesk Land Desktop Help.

The Autodesk Land Desktop tutorial is an excellent way to become familiar 
with tasks that you can perform with the program. The Autodesk Land 
Desktop tutorial has step-by-step lessons that you can do independently of 
each other. You can access the Autodesk Land Desktop tutorial by choosing 
Land Desktop Tutorials from the Help menu.

Learning AutoCAD
If you have never used AutoCAD, then you may want to start by using the 
AutoCAD Learning Assistance to learn the AutoCAD basics. To use the 
Learning Assistance, place the AutoCAD Learning Assistance CD-ROM in 
your CD-ROM drive and choose AutoCAD Learning Assistance from the 
Help menu. 

Learning Autodesk Map
Autodesk Land Desktop has a Map menu that contains all the functionality 
of Autodesk Map 5. If you have never used Autodesk Map 5, then you can 
start learning the program by using the online Autodesk Map tutorials. You 
can access the Autodesk Map tutorials by choosing Autodesk Map Tutorials 
from the Help menu.
12 | Chapter 1 Introduction



Path Naming Conventions

When referring to the Autodesk Land Desktop program folder, the documen-
tation uses the following convention to represent the program path:

c:\Program Files\Land Desktop 3

Of course, if you installed the program on another drive or if you used 
another folder name, please substitute that path for the path described in 
the documentation. 

When you install the program, a folder for storing the project data is 
also created. The documentation uses the following convention for the 
project path:

c:\Land Projects 3

If you installed the program on another drive, or you renamed the 
project folder, please substitute that path for the path described in the 
documentation.

Finding Information

The following sections describe how to access the online Help, how to find 
information in Help, how to use the online tutorial, and how to use this 
Getting Started guide.

Accessing Help

You can access Help files for Autodesk Land Desktop by using the 
following methods:

Accessing Help files

Method Result Benefits

From within Autodesk Land 
Desktop, choose Help Topics 
from the Help menu, type 
Help on the command line, 
or press F1. 

Displays an introductory 
topic in the online Help. 
Includes links to AutoCAD 
Help and Autodesk Map 
Help.

This Help file displays a 
combined index and 
table of contents, as well 
as a combined search 
mechanism so you can find 
the Help topics you need. 
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Key Concepts

� Within a Help topic, you can move to other relevant topics or definitions 
by selecting the blue underlined text. 

� Click  on the navigation bar to move to the previous topics that you 
viewed. Only those topics that you have already viewed in the current 
instance of online Help are included in this Back button sequence. 

� Click  to hide the navigation pane of the Help system. Click  to 
redisplay the navigation pane.

Help Navigation

The Help system has a variety of methods that you can use to locate informa-
tion about Autodesk Land Desktop commands, including the table of con-
tents, index, and search. There is also a Favorites tab to which you can add 
frequently used topics.

From the Autodesk 
Land Desktop 3 program 
group, select the Autodesk 
Land Desktop 3 Help icon.

Displays an introductory 
topic in the Land Desktop 
online Help. Use the table 
of contents, index, or 
search mechanism to 
locate information.

Using this method, you can 
run the online Help 
independently from 
Autodesk Land Desktop.

Move the pointer over a 
command in a menu using 
the up and down keyboard 
arrows and press F1.

Displays the Help topic 
that describes the 
commands in the menu.

This topic has links to 
specific Help topics for the 
commands in the menu.

From a dialog box, click a 
Help button.

Displays the Help topic 
that describes how to use 
the dialog box.

This topic provides the 
information you need 
without having to search 
for it.

Accessing Help files (continued)

Method Result Benefits
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Each of these methods has its own tab in the left pane of the Help system, as 
shown in the following illustration:

� The Contents tab has books with topic pages listed below each book. To 
view a topic, click a book or a page. 

� The Index tab lists words organized numerically and alphabetically. Type 
a keyword to display the index entries, select a topic to view, and then 
click Display. If more than one topic shares the same index entry, you can 
choose the topic that you want to view. Only those topics that are indexed 
are listed on the Index tab.

� The Search tab can locate keywords in the Help system regardless of 
whether the topic is indexed. You can use options such as AND and NEAR 
to help narrow down the search.

� The Favorites tab is a location where you can store frequently-accessed 
Help topics. When you are viewing a Help topic you want to add to your 
favorites, click the Favorites tab and then click Add.
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Concepts, Procedures, and Reference 
Information in Help

Many of the topics in Help are organized into concept, procedure, and refer-
ence information, making it easier to find relevant information. When such 
a topic is open, you can switch between concept, procedure, and reference 
information by clicking the tabs in the right pane of the Help window.

� Concept tabs contain overview information and links to subtopics.
� Procedure tabs contain step-by-step procedures or contain links to 

subtopics. 
� Reference tabs contain information about how to access Autodesk Land 

Desktop commands and what the commands do. If there is more than one 
command listed on the Reference tab, move your mouse over the com-
mand name to dynamically update the information.

The following illustration shows how the information on the Reference tab 
changes as you move your mouse over a different command name.

Using the Tutorial 

Autodesk Land Desktop has an online tutorial that you can use to learn the 
basic program concepts. The tutorial is set up in lessons that you can perform 
sequentially or non-sequentially. 

Access the online tutorial by choosing the Land Desktop Tutorials command 
from the Help menu. Double-click the Autodesk Land Desktop Tutorial book 
icon and double-click the first page to start the tutorial. 
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Click the browse button to move through the tasks in the tutorial. The tuto-
rial window stays on top of the Autodesk Land Desktop window so it stays 
visible while you perform the steps.

If you prefer to print the tutorial, select Land Desktop Tutorials from the Help 
menu to display the contents window, click the Autodesk Land Desktop 
Tutorial book icon, and then click Print at the bottom of the contents 
window.

Using this Getting Started Guide

This guide introduces you to Autodesk Land Desktop. Each chapter focuses 
on one or two areas of the land development process, and each topic 
describes how you can use one or more commands to complete a project task.

In many sections of this guide, you are referred to topics in the Help for more 
information. For example,

To find the topics mentioned, use the Search tab in Help.

Some sections in this guide have numbered steps that you can perform to 
complete a task, such as setting up the point database. To the right of certain 
steps in a task are titles of relevant Help topics. For example,  

The above example shows that you can use the Search tab in the Help to 
locate the topic, “Changing the Point Database Setup Settings.” 

To set up the point database

Step Use  to locate

1 From the Points menu, choose Point 
Management ➤ Point Database Setup to display the Point 
Database Setup dialog box.

Changing the Point 
Database Setup Settings

Work in Paper Space 
and Model Space

Overview of Layouts

Search Help for …
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The following example describes how you can locate a specific topic title in 
the Help. 

To use Help to locate a topic title

Steps

1 Start Help by using one of the methods listed in “Accessing Help” on page 13.

2 Click . 

The following illustration shows the search tab.

3 For best results, select the Search Titles Only check box, and clear the Match Similar 
Words check box.

4 In the edit box on the Search tab, type the Help topic title that you want to find, and 
then click List Topics. 

5 From the Select Topic list, locate the topic title you are searching for.

6 Click the name of the topic, and then click Display to view the Help topic.
18 | Chapter 1 Introduction



2
Installation
In this chapter

� System requirements

� Install Autodesk Land 
Desktop 3

� Use customized files and 
settings from Release 2i

� Register and authorize 
Autodesk Land Desktop 3

� Add Autodesk Land Desktop 3 
components

� Reinstall or repair Autodesk 
Land Desktop 3

� Uninstall Autodesk Land 
Desktop 3

� Uninstall Trimble Link

� Uninstall Volo View Express
This section provides instructions for installing and 

authorizing Autodesk®  Land Desktop 3 on a stand-alone 

computer. If you are installing Autodesk Land Desktop 3 

for a network, see the Network Administrator’s Guide 

located in the \netsetup\support\Adlm\docs folder on the 

Autodesk Land Desktop 3 CD.

NOTE Installation instructions are provided in this chapter for 
both unlocked and soft-locked versions of Autodesk Land 
Desktop 3. Where appropriate, notes have been added to 
distinguish the two types of installations.
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System Requirements

Before you begin installing Autodesk Land Desktop 3 on a stand-alone 
computer, make sure that your computer meets the minimum recommended 
requirements. See the following table for hardware and software 
requirements.  

Hardware and software requirements

Hardware/Software Requirements Notes

Operating system Windows® NT 4.0 with SP 5.0 
or later
Windows 98
Windows Millennium Edition (ME)
Windows 2000

It is recommended that you install and run 
Autodesk Land Desktop 3 on an operating 
system in the same language as your 
version of Autodesk Land Desktop 3 or on 
an English version of the operating system.

Windows 2000 users must have either 
Power User or Administrator permissions to 
install Autodesk Land Desktop 3. Not 
assigning these permissions can cause 
Autodesk Land Desktop 3 and third-party 
applications to perform incorrectly. See 
Windows 2000 Help for information about 
assigning user permissions.

To run the Autodesk Land Desktop 
application on Windows 2000, users must 
have either Power User or Administrator 
permissions. In Windows 2000, Power Users 
have all the capabilities that Windows NT 
4.0 users had. See Windows 2000 Help for 
more information about user permissions.

To use the Oracle8i TM Spatial features in 
Autodesk Land Desktop 3, you must run 
Autodesk Land Desktop 3 on Windows 98, 
NT, or 2000.

Processor Pentium®  233 (minimum)
Pentium 450 or higher 
(recommended) 
Equivalent processor

RAM 64 MB (minimum)
128 MB (recommended)

Video 800 x 600 VGA with 256 colors 
(minimum)
1024 x 768 SVGA with 64 
thousand colors (recommended)

Requires a Windows-supported display 
adapter
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Hard disk 350 MB of hard disk space 
(minimum); approximately 340 
MB is required for a typical 
installation. Approximately an 
additional 55 MB of free hard disk 
space on your system drive is 
required for swap files.

Pointing device Mouse, trackball, or other device.

CD-ROM Any speed (for installation only).

Optional hardware Open GL® -compatible 3D video 
card.
Printer or plotter
Digitizer.
Modem or access to an Internet 
connection.
Network interface card (required 
for network versions of Autodesk 
Land Desktop 3).

The OpenGL driver that comes with the 
3D graphics card must have the following:

� Full support of OpenGL or later.
� An OpenGL Installable Client Driver 

(ICD). The graphics card must have an 
ICD in its OpenGL driver software. The 
"miniGL" driver provided with some 
cards is not sufficient for use with 
Autodesk Land Desktop 3.

The network interface card must be 
compatible with existing Ethernet network 
infrastructure and is required for installing 
and running the network version of 
Autodesk Land Desktop 3.

Oracle Spatial 
(optional)

Oracle8i Spatial client, 
version 8.1.6, updated with the 
patch 8.1.6.3.10 for the Oracle 
Object for OLE (OO4O).

Required to use the Oracle8i Spatial features 
in Autodesk Land Desktop 3. The Oracle 
Spatial client can be installed either before 
or after you install Autodesk Land 
Desktop 3. 

Web browser Microsoft®  Internet Explorer 5.0
NetscapeTM Navigator 4.5 or later.

Internet Explorer 5.5 is installed with 
Autodesk Land Desktop 3.

NOTE Additional space may be required for rollback. The rollback feature allows you to restore 
your computer to the state it was in prior to running setup. This feature is useful if the setup 
process is interrupted. This feature requires additional hard drive space to store information and 
files prior to setup. If you do not have the additional hard drive space for the rollback feature, you 
will be informed and have the option to disable rollback to continue with setup. You may also end 
setup and clear hard drive space or choose a different drive and then re-run setup. 

Hardware and software requirements (continued)

Hardware/Software Requirements Notes
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3D Graphics System Requirements

Autodesk Land Desktop 3 uses the Autodesk Heidi® 3D graphics system and 
supports dynamically loadable Heidi 3D Display Drivers. These Heidi Drivers 
are linked into Autodesk Land Desktop 3 at run time and allow Autodesk 
Land Desktop 3 to take advantage of 3D graphics hardware. 

There are two Heidi 3D Display Drivers at present, Heidi Software and Heidi 
OpenGL. A third, Heidi Direct3D, will be provided in the future as a down-
loadable update to Autodesk Land Desktop 3. 

To use Autodesk Land Desktop 3 with OpenGL, the OpenGL driver provided 
by the 3D graphics card vendor must have the following characteristics:

� Full support of OpenGL: Version 1.1 or later.
� An OpenGL Installable Client Driver (ICD): The 3D graphics card must 

provide a full ICD in its OpenGL driver software. The “miniGL” driver 
provided by some 3D graphics cards and associated drivers is not sufficient 
for use with Autodesk Land Desktop 3.

Install Autodesk Land Desktop 3

This section includes information for installing Autodesk Land Desktop 3 on 
a stand-alone computer.

Before you install

1 Make sure you have write permission to the following locations:

� Folder where you are installing Autodesk Land Desktop 3
� System registry
� Windows System folder

NOTE To use Autodesk Land Desktop 3 with Windows NT or Windows 2000, 
you must have Administrator or Power User permission to write to the system 
registry.   

2 Close all running applications.

3 Disable virus-checking software. Please refer to your virus software documen-
tation for instructions.
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NOTE Some files required by Autodesk Land Desktop 3 are installed in your 
system folder (for example, c:\Windows\System, or c:\Winnt\System32). This 
folder may be on a different drive than the folder you specify as the installation 
folder (for example, d:\Program Files\Land Desktop 3). You may need up to 
55 MB of space in your system folder, depending on the components you select 
to install. You are alerted if there is insufficient free space on the drive that con-
tains your system folder.

To install Autodesk Land Desktop 3 on a stand-alone computer

1 Insert the Autodesk Land Desktop 3 CD into the CD-ROM drive.

� Autorun starts the installation process unless you hold down the SHIFT key 
when you insert the CD.

� If Autorun is turned off, you must designate the CD-ROM drive. From the 
Start menu, choose Run. Enter the CD-ROM drive letter and setup. For 
example, enter d:\setup.

2 On the opening page of the Installation wizard, click Next to continue. 

3 On the Software License Agreement page, select your country of residence 
from the list. 

4 Review the Autodesk software license agreement. You must accept this 
agreement to complete the installation. To accept, choose I Accept, then 
choose Next.

5 On the Serial Number page, enter the serial number and CD key located on 
the Autodesk Land Desktop 3 package. Choose Next.

NOTE If you are installing a soft-locked version of Autodesk Land Desktop 3, 
the Serial Number field defaults to zeros. If you have not yet purchased Autodesk 
Land Desktop 3, you can install a trial version of Autodesk Land Desktop 3 by 
leaving the zeros in Serial Number field and continuing with the installation. On 
the User Information page, enter your user information and choose Next.

6 On the User Information page, enter your user information and choose Next.

7 If this is a first-time installation, and you do not have any previous version 
of AutoCAD Land Development Desktop on your computer, go to step 8.
Install Autodesk Land Desktop 3 | 23



If an existing version of AutoCAD Land Development Desktop is detected on 
your system and the existing version of AutoCAD Land Development 
Desktop is Release 1 or Release 2i with SP2, you have two options:

■ You can install Autodesk Land Desktop 3 in a separate directory.
■ You can uninstall your existing version of AutoCAD Land Development 

Desktop and then install Autodesk Land Desktop 3.

NOTE You can install Autodesk Land Desktop 3 side-by-side with either 
AutoCAD Land Development Desktop R1 or AutoCAD Land Development 
Desktop 2i with Service Pack 2 (SP2). If you have any other version, you must 
upgrade to 2i with SP2 or uninstall your existing version of AutoCAD Land 
Development Desktop and then install Autodesk Land Desktop 3.

NOTE If you choose to uninstall your existing version of AutoCAD Land 
Development Desktop, you need to uninstall any additional product extensions 
that you have installed. 

NOTE Your previous version of AutoCAD Land Development Desktop may 
have had a hardware lock. Hardware locks are no longer required in Autodesk 
Land Desktop 3. 

8 On the Select Installation Type page, specify the type of installation you 
want, and then choose Next.

Typical installs the following features:

■ Program files. Executables, menus, toolbars,  templates, TrueType® fonts, 
additional support files, and Land ActiveX components

■ Internet tools. Support files and VoloTM View Express
■ Fonts. SHX fonts
■ Database. External database tools and support files
■ VBA support. Microsoft Visual Basic®  application support files
■ Batch Plotting. Batch plotting application and support files
■ Plot Lessons. 
■ Samples. Sample drawings, images, and DesignCenterTM files
■ Tutorials. Autodesk Land Desktop
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■ Dictionaries. American English
■ Help files. Online documentation
■ Land ActiveX API Samples. 

Compact installs only the program files and fonts. 

NOTE Soft-locked, compact installations also include Portable License 
Management. 

Soft-locked licenses are limited to one machine at a time. By using the Portable 
License Utilities, you can transfer a soft-locked license from one stand-alone 
machine to another. For more information on the Portable License Utilities, 
launch Portable License Utilities from the Autodesk Land Desktop 3 Program 
Group and then choose Help. You can also view the AutoCAD Portable License 
Guide from the Help system (Contents tab) by choosing AutoCAD Online 
Manuals ➤ Customization Guide ➤ Change the AutoCAD Setup ➤ Use the 
AutoCAD Stand-Alone License Manager ➤ AutoCAD Portable License Utility.

Custom installs only the files you select. By default, the Custom installation 
option installs all Autodesk Land Desktop 3 features that are installed with a 
Typical installation. To install additional features, select the drop-down next 
to the feature, and then choose Entire Feature Will Be Installed on Local Hard 
Drive. To remove a feature from the installation, select the drop-down next 
to the feature and choose Entire Feature Will Be Unavailable. 

Installation options on the drop-down list are:

■ Entire Feature Will Be Installed on Local Hard Drive: Installs a feature and 
its components on your hard drive

■ Entire Feature Will Be Unavailable: Makes the feature unavailable.

Full installs the following features in addition to the files installed by a 
Typical installation:

■ Internet Tools. Internet support files
■ Samples. Visual LISPTM samples
■ Dictionaries. French-Canadian
■ Texture maps. Maps for photorealistic rendering
■ OLE/ADI Plot. 
■ Tutorials. Visual LISP tutorials
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9 On the Destination Folder page, do one of the following:

� Choose Next to accept the default destination folder. 
� Choose Browse to specify a different drive and folder where you want 

Autodesk Land Desktop 3 installed. Choose any folder that is mapped to 
your computer (including network folders), or enter a new path. Choose 
OK, and then choose Next. 

NOTE To preview disk space requirements, select Disk Costing from the 
Destination Folder page. Choose OK to return to the Destination Folder page.

10 On the Support Directories page, do one of the following to specify the 
Project directory, Temp directory, and Data directory:

� Choose Next to accept the default folders or directories. 
� Choose Browse to specify a different drive and folder where you want to 

create Support directories. Choose any directory (including network 
directories) or enter a new path. Choose OK and then Next. 

NOTE A warning is displayed if you choose a directory where existing data or 
project files will be overwritten.

NOTE For soft-locked installations, critical licensing information is stored in 
the c:\C_dilla folder. To insure proper operation of your application, do not 
modify or delete the contents of this folder.

11 On the Start Installation page, choose Next to start the installation.

The Updating System page is displayed, showing the progress of the 
installation. 

12 If an existing version of Microsoft NetMeeting®  is identified, you can choose 
to update it to Version 3.01. Choose Yes to update, or No to bypass. 

NOTE If you choose not to upgrade NetMeeting, you will not be able to use 
the Meet Now feature until you upgrade. 
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13 If you selected a Typical or Custom installation including Volo View Express, 
Volo View Express is launched at the end of the Autodesk Land Desktop 
installation. Follow the instructions to complete the installation.

NOTE Volo View Express is necessary for DWF file support and for the Publish 
to Web feature. If an existing version of Volo View Express is identified, it will be 
automatically upgraded to the latest version. Volo View Express will not over-
write an existing version of Volo View. If you require the full functionality of Volo 
View, you may purchase an Autodesk Land Desktop-compatible version 
separately.

14 Trimble LinkTM is now available for Autodesk Land Desktop 3. 

To install Trimble Link now, choose Yes when prompted and follow the 
instructions.

NOTE There are some commands in Trimble Link that are only available after 
you install Autodesk Civil Design 3 or Autodesk Survey 3.

15 When the installation is complete, the Setup Complete page is displayed.

16 The Readme file is opened from this page when you choose Finish. This file 
contains information that was unavailable when the Autodesk Land 
Desktop 3 documentation was prepared. If you do not want to view the 
Readme file at this point, clear the check box next to Readme.

Choose Finish. 

NOTE You can also view the Readme file after you have installed Autodesk 
Land Desktop 3 by choosing Start ➤ Autodesk Land Desktop 3 ➤ Autodesk Land 
Desktop 3 Readme Files ➤ Autodesk Land Desktop 3 Readme. 

17 It is strongly recommended that you restart your computer at this point in 
order for the installation settings to take effect. Do one of the following:

� Choose Yes to restart your computer now. 
� Choose No to manually restart your computer at another time. 
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NOTE You will not see the Restart prompt if you chose to view the Readme file 
from the Setup Complete page.

WARNING! If you do not restart your computer, you may have problems 
running Autodesk Land Desktop 3.

Congratulations! You have successfully installed Autodesk Land Desktop 3. 
You are now ready to register your product and start using the program. To 
register the product, double-click the Autodesk Land Desktop 3 icon on your 
desktop and follow the instructions. 

Use Customized Files and Settings from 
Release 1 or Release 2i (with SP2)

If you choose to install Autodesk Land Desktop 3 in a different folder, and 
you want to use your customized files, copy the files from the previous 
version custom files into the appropriate folder:

(Land Desktop 3\Data or Land Desktop 3\Support).

The following are types of customized files:

� Exported AutoCAD Land Development Desktop profiles.
� LISP files that are loaded during AutoCAD Land Development 

Desktop Startup.
� AutoCAD Land Development Desktop standard linetype definition files.
� AutoCAD Land Development Desktop menu files.
� AutoCAD Land Development Desktop files contained in the \Data folder.
� Digitizer and plotter configuration information.
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Register and Authorize Autodesk Land 
Desktop 3

The first time you start Autodesk Land Desktop 3, the Authorization wizard 
is displayed. You can authorize Autodesk Land Desktop 3 at that time, or run 
Autodesk Land Desktop 3 and authorize it later. Autodesk Land Desktop 3 
displays the Authorization wizard for 15 days. Each time you start the pro-
gram, you are prompted to provide an authorization code. After 15 days, you 
must enter an authorization code in order to run Autodesk Land Desktop 3.

You can register and authorize Autodesk Land Desktop 3 in one of the 
following ways:

� Internet. Guides you through entering your registration information and 
sends it to Autodesk over the Internet. Once you submit your information, 
registration and authorization occur almost instantly.

� Fax. Guides you through entering your registration information. Saves 
the information in a file that you can print and fax to Autodesk. 

� Email. Guides you through creating an email message with your registra-
tion information, which you can send to Autodesk.

� Post/Mail. Guides you through entering your registration information. 
Saves the information in a file that you can print and mail to Autodesk.

To authorize Autodesk Land Desktop 3

1 Double-click the Autodesk Land Desktop 3 icon on your desktop.

2 On the Begin page of the Authorization wizard, select Authorize Autodesk 
Land Desktop 3, and then choose Next. 

3 Do one of the following:

� Select Register and Authorize, which will guide you through the electronic 
registration process. 

� Select Enter Authorization Code, where you will enter your authorization 
code (which you’ll receive after you’ve registered your product). 

4 Choose Next and follow the on-screen instructions. 

5 After you complete the authorization process, choose Finish to exit 
registration.
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Add Autodesk Land Desktop 3 Components

You can add custom components at any time by running Setup.

To add components

1 From the Start menu, choose Settings ➤ Control Panel.

2 In the Control Panel, choose Add/Remove Programs. 

3 Do one of the following: 

� Windows®  98, NT, and ME. In the Add/Remove Program Properties dialog 
box, on the Install/Uninstall tab, select Autodesk Land Desktop 3. Choose 
Add/Remove.

� Windows 2000. In the Add/Remove Programs dialog box, select Autodesk 
Land Desktop 3, and choose Change.

4 In the Add/Remove Application dialog box, select Add or Remove Features, 
and choose Next.

5 In the Autodesk Land Desktop 3 Setup dialog box, select a feature and then 
select one of the following options from the drop-down list. Then choose 
Next:

� Entire feature will be installed on local hard drive. Installs a feature and 
its components on your hard drive.

� Entire feature will be unavailable. Makes the feature unavailable.

6 On the Start Installation page, choose Next. 

When the components have been added, choose Finish. 

7 Restart your computer.

Reinstall or Repair Autodesk Land Desktop 3

If you accidentally delete or alter files required by Autodesk Land Desktop 3, 
you can reinstall or repair them. When you perform a reinstallation of 
Autodesk Land Desktop 3, the procedure automatically repairs damaged or 
missing files. The reinstallation or repair uses the choices you made during 
the last installation and requires little interaction. 
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To reinstall Autodesk Land Desktop 3

1 From the Start menu, choose Settings ➤ Control Panel.

2 In the Control Panel, choose Add/Remove Programs. 

3 Do one of the following:

� Windows® 98, NT, and ME. In the Add/Remove Program Properties 
dialog box, Install/Uninstall tab, select Autodesk Land Desktop 3. 
Choose Add/Remove.

� Windows 2000. In the Add/Remove Programs dialog box, select Autodesk 
Land Desktop 3, and choose Change.

4 In the Add/Remove Application dialog box, select Reinstall Autodesk Land 
Desktop 3, and then choose Next.

5 In the Autodesk Land Desktop 3 Setup dialog box, do one of the following, 
and then choose Next:

� Select Reinstall Autodesk Land Desktop 3.
� Select Repair Errors in My Autodesk Land Desktop 3 Installation. If you 

select this option, you also restore your shortcuts if they do not point to 
the location of your Autodesk Land Desktop 3 files. If you do not want to 
restore your shortcuts, clear the corresponding check box. 

6 In the Start Installation dialog box, choose Next, to begin installation.

7 In the Backup Files dialog box, highlight the files to back up, and then 
choose Next.

8 In the Autodesk Land Desktop 3 dialog box, when the components have 
been added, choose Finish.

9 Restart your computer.

NOTE You can find information on optimizing and configuring Autodesk Land 
Desktop 3 in the online AutoCAD Customization Guide. You can view it by 
choosing Help ➤ Autodesk Land Desktop 3 Help and, from the Contents tab, 
choosing AutoCAD Online Manuals ➤ Customization Guide. 
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Uninstall Autodesk Land Desktop 3

When you uninstall Autodesk Land Desktop 3, all components are removed 
in the process. This means that even if you’ve previously added or removed 
components, or if you’ve reinstalled or repaired Autodesk Land Desktop 3, 
the uninstall procedure removes all files, making the uninstallation easy. 

To uninstall Autodesk Land Desktop 3

1 From the Start menu, choose Settings ➤ Control Panel.

2 In the Windows Control Panel, choose Add/Remove Programs. 

3 Do one of the following:

� Windows®  98, NT, and ME. In the Add/Remove Program Properties dialog 
box, on the Install/Uninstall tab, select Autodesk Land Desktop 3. Choose 
Add/Remove.

� Windows 2000. In the Add/Remove Programs dialog box, select Autodesk 
Land Desktop 3, and choose Change.

4 In the Add/Remove Application dialog box, select Remove Autodesk Land 
Desktop 3, and then choose Next. 

5 In the Autodesk Land Desktop 3 Uninstall dialog box, choose Next to start 
the process of removing Autodesk Land Desktop 3. 

6 On the Autodesk Land Desktop 3 Setup page, after the program is unin-
stalled, choose Finish. 

7 Restart your computer.

Uninstall Trimble Link

To uninstall Autodesk Land Desktop 3 Trimble Link

1 From the Start menu, choose Settings ➤ Control Panel.

2 In the Control Panel, choose Add/Remove Programs. 

3 Do one of the following:

� Windows®  98, NT, and ME. In the Add/Remove Program Properties 
dialog box, on the Install/Uninstall tab, select Trimble Link. Choose 
Add/Remove.

� Windows 2000. In the Add/Remove Programs dialog box, select Trimble 
Link, and choose Change.
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4 In the Confirm File Deletion dialog box, choose Yes to remove the 
application.

5 InstallShield®  removes the files from your system. 

6 When the program has been uninstalled, choose OK. 

Uninstall Volo View Express

To uninstall Volo View Express

1 From the Start menu, choose Settings ➤ Control Panel.

2 In the Control Panel, choose Add/Remove Programs. 

3 Do one of the following:

� Windows®  98, NT, and ME. In the Add/Remove Program Properties 
dialog box, on the Install/Uninstall tab, select Volo View Express. 
Choose Add/Remove.

� Windows 2000. In the Add/Remove Programs dialog box, select Volo 
View Express, and choose Change.

4 In the Confirm File Deletion dialog box, choose Yes to remove the 
application.

5 InstallShield removes the files from your system. 

NOTE When uninstalling Volo View Express, you might be prompted to 
remove shared files that were installed with the application. If you are sure that 
no other applications are using these shared files, you can choose to remove 
them from your system.

6 When the program has been uninstalled, choose OK. 
Uninstall Volo View Express | 33



34 | Chapter 2 Installation



3
Getting Started with 
Autodesk Land Desktop
In this chapter

� Starting Autodesk Land 
Desktop

� Using Autodesk Land Desktop 
Today

� The Autodesk Land Desktop 
drawing environment

� Accessing Autodesk Land 
Desktop commands

� Establishing settings

� Working with projects

� Working with drawings

� Viewing drawings

� Organizing drawings with layers

� Using drafting settings

� Plotting drawings

� Exiting Autodesk Land
Desktop
To start working with Autodesk®  Land Desktop, you 

need to know the basics of operating the program. 

These basics include menu palettes, and project, 

prototype, and drawing management.
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Starting 
Session

Sea
Starting Autodesk Land Desktop

To start Autodesk Land Desktop, select the Land Desktop 3 icon from the 
Autodesk Land Desktop 3 program group or from the Windows desktop. 

When you start Autodesk Land Desktop, the Today window is displayed, 
shown in the following illustration. 

 

Today provides quick access to drawings. When you place the cursor over a 
drawing name, a preview of the drawing is displayed. You can also view four 
of the most recent drawings, or you can view drawings by date, file name, or 
location by changing the display of the Open/Create tab. 

a Drawing 

rch Help for…
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The User
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From the Open/Create tab, you can click New, Open, and Project Manager to

� start a new drawing.
� open an existing drawing by specifying the project name.
� manage projects.

NOTE When you install Autodesk Land Desktop, a Land Enabled Autodesk 
Map 5 icon is created. Use this icon to start an object-enabled version of 
Autodesk Map. You can use this version of Autodesk Map to open Autodesk Land 
Desktop drawings and to view custom objects without having to select a project. 
Using this version, you cannot use Autodesk Land Desktop commands, but you 
can open multiple drawings at a time and use all of the AutoCAD 2002 and 
Autodesk Map 5 commands.

Using Autodesk Land Desktop Today

In addition to providing quick access to drawing files, you can use the Today 
window to do the following:

� Connect to the Internet via the Point A portion of the window.
� Post messages to a work group via the Bulletin Board.
� Access symbol libraries via the Symbol Libraries tab.

TIP If you want to redisplay the Today window after closing it, you can do one 
of the following: 

�  Type today at the command line.
�  Select the Today command from the Help menu.

�  Click the Today icon  in the Standard Toolbar.

 of the Today 

 Interface

rch Help for…
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The Autodesk Land Desktop Drawing 
Environment

The Autodesk Land Desktop drawing environment is shown in the following 
illustration: 

The menus in the Autodesk Land Desktop 3 menu palette, plus the Image 
menu, are displayed by default. The Image menu, which is not included in 
the default menu palettes, provides information about Autodesk 
CAD Overlay®. For more information about menu palettes, see “Selecting a 
Menu Palette” on page 41.

When you start Autodesk Land Desktop, the Autodesk Map® Project 
Workspace is displayed by default. You can use the Project Workspace to 

Menu bar Model spaceMap project workspace

Command line Status bar
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attach drawings to the current Map project (or current drawing), to define 
queries, and to attach databases.

NOTE You can run multiple sessions of Autodesk Land Desktop 3 on one com-
puter. Within each session, however, only one drawing can be open at a time.

The following section describes how to access Autodesk Land Desktop 
commands by using menu palettes, shortcut menus, toolbars, the status bar, 
and the command line.

Accessing Autodesk Land 
Desktop Commands

You can access Autodesk Land Desktop commands in a variety of ways. All 
commands are available from the pull-down menus, and you can select some 
commands from toolbars, shortcut menus, or by typing them on the com-
mand line. Many Autodesk Map commands are available from shortcut 
menus in the Map Project Workspace, as well as from the Map pull-down 
menu. 

You can control the pull-down menus and toolbars that are displayed by 
selecting a menu palette. To use Autodesk Land Desktop commands, use the 
Land Desktop 3 menu palette (loaded by default when you start the pro-
gram). You must load the Survey 3 menu palette to access the Autodesk 
Survey commands, and you must load the Civil Design 3 menu palette to 
access the Autodesk Civil Design commands.

Key Concepts

� When you carry out a command, prompts and messages display on the 
command line. You can view a complete history of the prompts and 
messages of the current drawing session by pressing F2 to open the 
AutoCAD text window which records the commands. For more informa-
tion, see “Text Window” on page 49.

� To quit a command at any time, press ESC.
� Autodesk Land Desktop has additional context-sensitive menus that you 

can access by selecting an object and right-clicking. For more information, 
see “Shortcut Menus” on page 47.

nd Toolbars

nu Palettes

 Land Desktop 
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Pull-Down Menus 

You can access most commands and dialog boxes by using the pull-down 
menus on the menu bar at the top of the Autodesk Land Desktop window. 

Key Concepts

� After you select a pull-down menu, choose a command by clicking its 
name.

� If a command name on pull-down menu is shaded, then it is not available 
at that point in the drawing session.

� Ellipses (…) following a command name indicate that further options are 
displayed in a dialog box.

� To view online Help about a command, highlight a command in the 
menu and press F1.

� On the command line, the spacebar usually works like the ENTER key.

You can access pull-down menus and commands in the following ways:

� Select a command on a pull-down menu by clicking its name.
� You can run some commands by typing the whole command name at the 

Command prompt, or by typing macros. For more information, see 
“Command Line” on page 48.
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� Select a pull-down menu by clicking the menu name to display a list of 
commands, or press ALT and the underlined letter of the menu name. For 
example, to access the Points menu, hold down the ALT key and press the 
s key (hereafter: ALT + S). These key combinations are called hot keys.

NOTE If you are using Windows 2000, by default the hot keys do not appear 
until you press the ALT key. 

Selecting a Menu Palette

When you first start Autodesk Land Desktop, the menu bar displays as shown 
in the following illustration.

To change the group of menus, you can select a different menu palette.    

To select a menu palette 

Steps Use  to locate

1 From the Projects menu, select Menu Palettes to display 
the Menu Palette Manager.

Selecting a Menu Palette

2 Choose a menu palette to load. 

Under Description, a brief summary about that selected 
menu palette is displayed.

3 After you have selected the menu palette, click Load.
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To load a menu palette quickly, use a macro. 

� To load the Autodesk Land Desktop menu, type MLD. 
� To load the complete Autodesk Land Desktop menu (which includes all 

AutoCAD menus), type MLC.
� To load the Autodesk Civil Design menu, type MCD.
� To load Autodesk Survey, type MSV.   

Customizing a Menu Palette

To customize a menu palette, you can add other menus to an existing menu 
palette, or you can create a new menu palette. For example, if you installed 
Autodesk Civil Design, then you could add the Autodesk Civil Design 
Grading menu to the Autodesk Land Desktop menu palette so that you 
always have access to the Grading commands. 

To create a menu palette, add the menus that you want to save to the menu 
palette by using the MENULOAD command, and then use the Menu Palette 
Manager to save the palette.

NOTE Toolbars cannot be saved as part of menu palettes.

Create a Custom Menu Bar
You can customize the menu bar and create menu palettes to contain 
commands that you use most often. For example, you can set up an 
Annotation menu palette that contains the AutoCAD Dimension menu and 
the AutoCAD Draw menu.  

To create a menu palette

Steps Use  to locate

1 On the command line, type menuload to display the 
Menu Customization dialog box.

Menuload Command

2 Click the Menu Bar tab, and under Menu Group choose a 
menu name from the list.

For example, if you want to add AutoCAD menus to the 
menu bar, then choose ACAD.

3 Under Menus, choose a pull-down menu from the list. 

 Land Desktop 
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Toolbars

When you start Autodesk Land Desktop, the AutoCAD Standard and Object 
Properties toolbars are displayed at the top of the window, and the Modify 
and Draw toolbars are displayed on the left side of the graphics screen. 

To learn how to display the Autodesk Land Desktop toolbars, see the task at 
the end of this topic.

You can display other toolbars with various tool categories. Each toolbar 
contains a set of tools that represents specific commands in a category. Start 
a command by clicking a tool. To identify a tool, move the pointer slowly 
over the tool. A small label, or ToolTip, displays the tool name, as shown in 
the following illustration. 

4 Under Menu Bar, select a menu name in the list. The order 
of the Menu Bar list duplicates the order from left to right 
of the menus on the menu bar.

5 Click Insert >>.

NOTE You can also remove menus from the Menu Bar 
list by clicking <<Remove.

6 After you finish adding the menus to the menu bar, click 
Close.

7 To save this customized menu bar as a palette, choose 
Menu Palettes from the Projects menu.

8 In the Menu Palette Manager, click Save. Saving a Menu Palette

9 Type the name and description of the new palette, and 
click OK.

Changing the Name or 
Description of a Menu 
Palette

To create a menu palette (continued)

Steps Use  to locate
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Key Concepts

� You can work with toolbars from the following three categories:
� standard AutoCAD toolbars
� Autodesk Map toolbars
� Autodesk Land Desktop toolbars

� Toolbars can float within the drawing area, or you can organize them as 
needed by docking them at the top, bottom, or sides of the drawing area. 

� To turn a toolbar on or off, select or clear the check box next to its name 
in the Customize dialog box. You can also close a toolbar by clicking the 
Close button in the toolbar’s upper-right corner. The Close button is visi-
ble only when the Toolbar is floating within the drawing area.

� You can customize a toolbar by adding and removing tools or by creating 
new tools.

� You can enhance an existing toolbar by creating a flyout toolbar. 

Tools in the flyout toolbar are nested under the Flyout icon  (indicated 
by a black triangle in the lower-right corner). You can replace the Flyout 
icon with any icon, and then associate a toolbar with it.      

To display Autodesk Land Desktop toolbars

Steps Use  to locate

1 From the View menu, select Toolbars to display the 
Customize dialog box.

You can also move the cursor over any toolbar, right-click, 
and choose Customize from the shortcut menu.

Toolbar Command

2 On the Toolbars tab, under Menu Group, select Land to 
display specific Land Desktop toolbars.

3 Under Toolbars, select a check box on the list to display 
that toolbar.

To close or hide the toolbar, clear the check box.

4 Click Close.
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Using the Standard Toolbar 
You can use several commands in the Standard toolbar to modify objects in 
drawings. You can copy or remove an object from a drawing to the 
Clipboard, and then paste the object from the Clipboard into another 
document. 

The following table lists some of the Standard tools and how you can use 
them in Autodesk Land Desktop. For example, use Print Preview to view a full 
page of the plotted drawing in a WYSIWYG window.   

Standard tools 

Tool Shortcut 
Key 

Command 
Line

Description

CTRL+N new Displays the Autodesk Land Desktop New 
Drawing - Project Based dialog box. 

For more information about setting up a drawing 
that is associated with a project, see “Creating New 
Drawings” on page 62.

CTRL+O open Displays the Open/Create tab in the Today window.

For more information, see “Opening Drawings” on 
page 67.

CTRL+S save Saves the current drawing.

CTRL+P plot Displays the Plot dialog box.

For more information, see “Plotting Drawings” on 
page 83. 

preview Displays a preview of the drawing as it would 
appear on a sheet of paper.
Press ESC to return to the drawing.

find Displays the Find and Replace dialog box to search 
for text strings and replace them.

CTRL+X cutclip Removes the selected object from the drawing to 
the Clipboard. You can retrieve the selected object 
by using the Pasteclip tool.

CTRL+C copyclip Copies the selected object to the Clipboard as a 
block. You can retrieve the block by using the 
Pasteclip tool. 

ows Cut, Copy, 
e
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Status Bar

The status bar at the bottom of the Autodesk Land Desktop window displays 
the X,Y coordinates of the current cursor location and the status of fre-
quently used modes, as shown in the following illustration.

Key Concepts

� You can view the coordinate values of the current cursor location in 
the left section of the status bar. There are three display options for 
coordinates. 

� Double-click the drawing aids SNAP, GRID, ORTHO, POLAR, OSNAP, 
OTRACK, and LWT to turn them on and off. 

� If you have not specified any running object snaps before selecting a 
command, you can then specify the object snap settings by 
double-clicking OSNAP to display the Drafting Settings dialog box. For 
more information, see “Transparent Commands” on page 48.

� Double-click MODEL/PAPER to switch between paper space and model 
space when the drawing is in Layout mode. For more information, see 
“Paper Space and Layout Mode” on page 132”

CTRL+V pasteclip Inserts a selected object from the Clipboard.

CTRL+Z undo Reverses the last action.

For more information, see “Correcting Mistakes” 
on page 152.

CTRL+Y redo Restores the most recent change made by 
the Undo command.

For more information, see “Correcting Mistakes” 
on page 152.

Standard tools  (continued)

Tool Shortcut 
Key 

Command 
Line

Description

oordinates on 
s Bar
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Shortcut Menus

Shortcut menus provide quick access to display, editing, and labeling com-
mands. Autodesk Land Desktop shortcut menus are context-sensitive and 
display different commands depending on the type of object selected. 

For example, if you select a polyline and right-click, a shortcut menu with 
specific options for lines is displayed, as shown in the following illustration.

Key Concepts

� Autodesk Land Desktop has a shortcut menu for grip editing. Select an 
object in the drawing to display the grips, select a grip, and then 
right-click to display the shortcut menu. For more information, see 
“Working with Editing Tools” on page 149.

� As you use real-time panning and zooming, you can right-click to display 
shortcut menus with specific options for those commands.

To display the default drawing tools shortcut menu, hold down the SHIFT key 
and right-click. The shortcut menus are displayed at the cursor location.

 Menus

rch Help for…

AutoCAD editing 
commands

Commands specific to the 
object you selected

Command you can use to 
repeat the last command 
you used

Utilities commands

AutoCAD commands you 
can use to clear or modify 
the selection set, search for 
text, and change the 
object’s properties
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Command Line

You can access some commands by typing them on the command line. At 
the Command prompt, enter either the whole command name or the abbre-
viated name called a command alias, and then press ENTER, the SPACEBAR, or 
right-click to display a shortcut menu. 

To use the same AutoCAD command consecutively, type multiple before the 
command name. For example, if you plan to draw more than one identical 
circle, type multiple circle.

During the drawing session, pay attention to the command line. Many com-
mands display prompts with further options, and other commands display a 
dialog box. If you want to respond to prompts on the command line and 
suppress the display of a dialog box, then type a hyphen (-) before the com-
mand name or command alias. For example, if you type osnap on the com-
mand line, then the Drafting Settings dialog box is displayed. If you type 
-osnap, then you can set the object snap modes on the command line. There 
are slight differences between command line options and dialog box options. 

Transparent Commands 

You can use the command line to access a second command without leaving 
the first command. To use a command transparently, type an apostrophe (’) 
before the command name on the command line. For example, if you are 
using LINE to draw a line, you can type ’zoom (’z) or ’pan (’p) to change the 
view of the drawing and the LINE command remains active. After you have 
finished using a command transparently, the suspended command 
continues.

NOTE The only commands that you can use transparently are commands that 
do not select or create objects, or commands that do not regenerate or end 
drawings.

Key Concepts

� You can use a command transparently by selecting it from a menu or 
toolbar.

� Whenever a command name is documented with a leading apostrophe, 
you can use the command transparently.

mmands on the 
d Line

etween Dialog 
d the Command 

 Land Desktop 

d Aliases

rch Help for…
48 | Chapter 3 Getting Started with Autodesk Land Desktop



Navigate
the Comm

Sea

Changin
Land Des

Sea
� Drafting commands, such as ’snap, ’grid, and ’ortho, are often used 
transparently.

� After you enter a transparent command name on the command line, 
double-angle brackets (>>) precede the prompts to indicate that the 
command is being used transparently.

Text Window

Use a text window to view a complete history of commands that you used in 
the current drawing session.

Press F2 to open a text window, which expands from the command line. 
Press F2 again to return to a drawing window. 

Establishing Settings

Early in a project you should establish the following settings:

� User preferences
� Drawing settings
� Prototype settings
� Data file settings

NOTE When you start a new drawing, you also set up the drawing for units, 
zone, sheet size, and so on. For more information, see “Setting Up Drawings” on 
page 64.

 and Edit Within 
and Window
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User Preferences

The User Preferences control three main aspects of the program: file paths, 
drawing setup method, and AutoCAD overrides.

File Paths
You can control file paths, such as the path for storing menu palettes, proto-
types, setup files, and speed tables. To use these items, you must store them 
in the locations specified in the File Locations settings. For example, to use a 
speed table to calculate a spiral, the speed tables must be located in the path 
that you specify for speed tables.

NOTE When you install Autodesk Land Desktop, these paths are set up auto-
matically. You need to change these paths only if you move any items, such as 
drawing setup files, to a different folder.

AutoCAD Overrides
If you want to use the AutoCAD New and Open commands, instead of 
Autodesk Land Desktop commands, then you can change the AutoCAD 
override settings.

Clear the “New” Drawing Dialog check box to use the AutoCAD New com-
mand every time you use the New command. Select this check box to use the 
project-based Autodesk Land Desktop New command.

Clear the “Open” Drawing Dialog check box to use the AutoCAD Open 
command every time you use the Open command. Select this check box to 
use the project-based Autodesk Land Desktop Open command.

g the User 
es
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50 | Chapter 3 Getting Started with Autodesk Land Desktop



NOTE The AutoCAD New dialog box that is used depends on the Startup 
setting in the Options dialog box.

The Autodesk Land Desktop New and Open dialog boxes are shown in the 
following illustrations.    

First Time Drawing Setup
The First Time Drawing Setup setting controls what happens when you create 
a new drawing. You can use the New Drawing Wizard, the Drawing Setup 
dialog box, or you can automatically load a setup file whenever you create a 
new drawing. The following illustrations show the New Drawing Wizard, the 
Drawing Setup dialog box, and an example of the contents of a setup file.

Land Desktop New Land Desktop Open

New Drawing Wizard Drawing Setup dialog box Sample of a setup file
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Drawing Settings

The Edit Settings dialog box is a centralized location from which you can 
modify settings that are specific to each drawing. To display the Edit Settings 
dialog box, select the Edit Drawing Settings command on the Projects menu.

The settings are arranged by program so you can more easily locate the set-
tings that apply to a project. There are settings for Autodesk Land Desktop, 
Autodesk Civil Design, and Autodesk Survey.

These settings are all available elsewhere in the program. The Edit Settings 
dialog box provides an easy way to change different settings simultaneously 
and then save them back to a prototype. By saving the settings to a proto-
type, they are used automatically whenever you create a new drawing in a 
project that is based on that prototype. You can establish the settings once 
and then apply them to each new drawing.

Key Concepts

� The drawing settings are controlled on a drawing-by-drawing basis unless 
you save them back to the prototype on which the project is based. This 
is designed so that individual drawings in a project can have different 
settings.

� The default drawing settings are based on the project prototype that you 
select when you create a project. For more information, see “Working with 
Drawings” on page 62.

1. Choose 
the program 
that has the 
settings you 
want to 
modify.

2. Choose the 
settings you 
want to edit.

3. Click Edit 
Settings.
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� If you change drawing settings, then you can save them back to the 
prototype and use them for new drawings that you create.

� If you change drawing settings, only new objects are affected. Existing 
objects are not updated with the new drawing settings.

Prototype Settings

Every Autodesk Land Desktop project must be based on a prototype. A pro-
totype stores drawing settings. These settings are copied to each drawing that 
is created in the project. Autodesk Land Desktop includes a prototype for 
meters and a prototype for feet.

The Prototype Settings dialog box provides a centralized location from which 
you can modify prototype settings. To display the Prototype Settings dialog 
box, select Prototype Settings from the Projects menu, select the prototype 
you want to modify, and then click OK.

You can establish the prototype settings in two ways:

� You can use the Edit Prototype Settings dialog box.
� You can use the Drawing Settings command to establish settings and then 

save them to a prototype.

1. Choose 
the program 
that has the 
settings you 
want to edit.

2. Choose the setting 
you want to edit.

3. Click Edit 
Settings.
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Data File Settings

You can use the Edit Data Files dialog box to access data files for Autodesk 
Land Desktop, Autodesk Civil Design, and Autodesk Survey. This dialog 
box provides a centralized location from which you can access and modify 
import/export formats, speed tables, label styles, tag styles, and contour 
styles. 

To display the Edit Data Files dialog box, choose Data Files from the 
Projects menu.

4. The data file is 
opened so you 
can edit or create 
new data files.

1. Choose 
the program.

2. Select the 
data file that 
you want to 
edit.

3. Click Edit 
Data.
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If you have Autodesk Survey, you can modify

� Command synonyms.
� Equipment settings.
� Figure Prefix Library.

If you have Autodesk Civil Design, you can modify

� Sheet Manager label and grid styles

Setting Up the Drawing Environment

After you install Autodesk Land Desktop, you can customize drawing 
environment settings in the Options dialog box. To display the dialog box, 
choose Options from the Tools menu, or type OPTIONS on the command 
line.

The settings are grouped under tabs in the Options dialog box as shown in 
the following illustration.

e the AutoCAD 
ent

Dialog Box
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The following table gives a brief overview of the settings.  

Window Display Options
When you start Autodesk Land Desktop for the first time, the screen colors 
and other settings conform to the Display settings in the Windows Control 
Panel. You can change the display colors, fonts, and other settings in the 
Options dialog box.    

Options dialog box settings

Tab Function

Files Specifies the directories to search for support, driver, menu, and 
other files. Also specifies optional, user-defined settings such as the 
dictionary to use for checking spelling.

Display Customizes the graphics screen display.

Open and Save Controls options that relate to opening and saving files.

Plotting Controls options related to plotting.

System Controls system settings, including the Startup option and Live 
Enabler settings.

User Preferences Controls options that optimize the way you work.

Drafting Specifies a number of general editing options, such as AutoSnap™ 
settings and markers.

Selection Controls settings that relate to object selection methods.

Profiles Controls the use of profiles. A profile is a configuration that you 
define.

You can restore custom options in a saved profile by making that 
profile current. However, when you choose Set Current, the 
operation is immediate. It is recommended that you copy and save 
the original Autodesk Land Desktop profile settings before you 
make changes in the Options dialog box.
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Saving a Profile
You can customize profiles to accommodate different projects and different 
users. When you change settings in the Options dialog box, the group of set-
tings is automatically saved as the default profile. Any changes that you make 
are immediate. You have no warning before you lose the default profile set-
tings. To avoid having to reinstall Autodesk Land Desktop to restore the orig-
inal settings, copy and save them as a backup profile (named, for example, 
LAND) before you make any changes. 

IMPORTANT The Reset button sets the selected profile to the basic 
AutoCAD 2002 settings, removing access to additional functionality from the 
selected profile. It is recommended that you copy and save the original 
Autodesk Land Desktop profile settings before you make changes in the 
Options dialog box.

To change the window display options

Steps Use  to locate

1 From the Tools menu, choose Options to display 
the Options dialog box, and then click the Display tab.

Set Interface Options

2 Under Window Elements, click Colors to display the Color 
Options dialog box.

3 Under Window Element, select Model tab background. 

4 From the Color list, select a basic color for the Model tab 
background, and then click Apply & Close to return to the 
Display tab.

5 Click Fonts to display the Command Line Window Font 
dialog box.

6 Select a font style and then click Apply & Close to return 
to the Display tab.

7 Click OK to exit the dialog box.
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Using the World Coordinate System 
for Creating Data

When you use a default drawing template to start a new drawing in Autodesk 
Land Desktop, you are in the world coordinate system (WCS) automatically. 
The X axis is horizontal, the Y axis is vertical, and the Z axis is perpendicular 
to the XY plane.

WARNING! If you create data with Autodesk Land Desktop, it is very 
important that the coordinate system be set to World. If you create data in 
Autodesk Land Desktop in a coordinate system other than World, that data is not 
processed correctly.

To change the coordinate system to World, type UCS on the command line, 
and then type World.

Working with Projects

Each Autodesk Land Desktop drawing must be associated with a project. This 
section describes in detail the function of projects and how to manage them.

� To work with Autodesk Land Desktop commands, you must have a 
project. You can, however, run AutoCAD or Autodesk Map commands 
without having a project selected.

� You can assign a drawing to only one project. If you want to later associate 
the drawing with a different project, you can re-associate the drawing by 
using the Reassociate Drawing command from the Projects menu.

� Projects can contain multiple drawings. All the drawings in a project share 
data files, such as the point database.

� If you open an existing drawing that is not assigned to a project, then you 
are prompted to select a project. This assignment is saved when you save 
the drawing.

Creating Projects

You can create a new project when you create a new drawing, or you can 
create a new project from the Project Manager. As you create a new project, 
use the Project Details dialog box to establish the project name, description, 

o a View of the 
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and keywords, as well as a prototype on which to base the drawing settings 
and a location for the drawing files.

Basing a Project on a Prototype
When you create a new project, you must specify a prototype (default set-
tings for the project) and a name for the project. Autodesk Land Desktop uses 
prototypes as a convenient way for you to maintain standard drawing set-
tings for project drawings. These standards are important and probably vary 
from project to project. For example, the standards that you use for state 
projects may be significantly different from the standards for local or 
town-related jobs.

You can select a prototype to use for the default drawing settings. All the set-
tings from the prototype are copied into the drawings that are associated 
with the project. 

Project Description and Keywords
When you create a project, you can also add a description and any keywords 
to help you identify the project. The description and keywords can be helpful 
if you have multiple projects. You can search on the keywords to find a par-
ticular project, and check the description to make sure it is the project that 
you are looking for.

Select a prototype 
to establish initial 
drawing settings.

Type a name for 
the project.

Choose a location 
for the project’s 
drawing files.

Type an optional 
description for the 
project.

Type optional 
keywords for the 
project.
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Project Drawing Location
Each project must have a location for all the drawing files that you create 
within a project. It is recommended that you store drawing files in the 
project \dwg folder, for example, c:\Land Projects 3\newproj\dwg. You can, 
however, also establish a different, fixed path for the drawing storage 
location.

By saving the drawings in a project drawing folder, you keep the drawings 
and the project files together, which makes the project easier to archive or 
transfer to someone else.

Managing Projects with the Project Management 
Dialog Box 

As you work with more and more projects, you may need to delete an old 
project, copy a project, rename an existing project, view project locks, or 
change an inaccurate description. You can do all this and more from the 
Project Management dialog box.

To display the Project Management dialog box, choose Project Manager from 
the Projects menu.

g Projects

ocks
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From the Project Management dialog box, you can

� Create new projects. If you are a CAD Manager, then you may want to 
create the projects from within the Project Management dialog box so 
that others can start their drawings and reference the same project data.

� Create new project paths. By default, the project path is c:\Land Projects 3, 
but you can create new project paths if desired.

� View the project details, including project description, keywords, and 
drawing storage location.

� View and manage the file locks. On a network, you can view the file locks 
to see who has files open. 

� Copy, rename, and delete projects. It is recommended that you use the 
Project Management dialog box for copying, renaming, and deleting 
project data. 

Managing Prototypes with the Prototype 
Management Dialog Box

You may need to maintain different prototypes for different clients. You can 
copy, delete, and rename prototypes by using the Prototype Management 
dialog box. To display the Prototype Management dialog box, choose 
Prototype Manager from the Projects menu.

Default prototypes for feet and meters are included with Autodesk Land 
Desktop. If you delete the default prototypes, then they are recreated, 
using the default system settings, the next time that you start Autodesk 
Land Desktop.

When you install Autodesk Land Desktop, a prototype folder 
(c:\Program Files\Land Desktop 3\data\prototypes) is created by default. Each 
default prototype, and each prototype that you create, is represented by a 

es - concept

g Prototypes
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subfolder of this root prototype folder. For example, if you create a prototype 
named MYPROTO, then the following folder is created:

c:\Program Files\Land Desktop 3\data\prototypes\myproto  

Working with Drawings

All Autodesk Land Desktop documents are AutoCAD drawings saved with a 
.dwg file name extension. This section explains how to create drawings, 
establish the drawing settings, and open drawings.

Creating New Drawings

You can create a new drawing from the Today window, by selecting the New 
command from the File menu, or by typing new at the command line.

When you create a new drawing, you name it and associate it with a project. 
Every time you create a new drawing, you are automatically prompted to set 
up the drawing. Depending on which option you select for “First Time 
Drawing Setup” (see “User Preferences” on page 50) either the New Drawing 
Wizard or the Drawing Setup dialog box is displayed, or a setup profile is 
loaded automatically.

The New Drawing Wizard steps you through each setting that you must 
establish for a drawing. The Drawing Setup dialog box contains all the set-
tings available in the New Drawing Wizard, but does not step you through 
the setup procedure.

Whenever you set up a drawing, you can save the setup options to a setup 
profile that you can load later. Autodesk Land Desktop includes several setup 
profiles. If you use a setup profile, then you do not have to step through the 
drawing setup procedure each time you create a new drawing.

Key Concepts

� When you create a new drawing, you must name the drawing and select 
or create a project.

� When you create a new drawing, you can create a new project.
� You can base a new drawing on a drawing template. Template files contain 

all the settings for a drawing and can also include predefined layers, 
dimension styles, and views. For more information about using drawing 
templates, locate “Using Templates” in Help.

a Drawing 
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For more detailed information about setting up a drawing after naming it 
and selecting a project, see the following section, “Setting Up Drawings.”

To create a new drawing

Steps Use  to locate

1 From the Autodesk Land Desktop 3 program group, 
choose the Autodesk Land Desktop 3 icon.

The Today window is displayed. 

Or, if Autodesk Land Desktop is already running, choose 
New from the File menu.

Starting a Drawing Session

2 Click New to display the New Drawing: Project Based 
dialog box, as shown in the following illustration.

Starting a New Drawing

Type the 
name of the 
new drawing.

Choose a 
drawing 
template.

Select the 
project name if 
one exists.

Or you can 
click Create 
Project to 
create a new 
project.
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Setting Up Drawings

By default when you start a new drawing, the Drawing Setup Wizard is dis-
played, as shown in the following illustration.

You can use this Wizard to select the current zone, and to adjust the draw-
ing units, the horizontal and vertical scales, the current text style, and 
other settings.

Key Concepts

� Set up the drawing units and scale based on a plot scale.
� You can insert custom borders into drawings.
� The precision values in the Drawing Setup Wizard control displayed infor-

mation and plotted labels, not the actual values that are stored in the data-
base, which are calculated to the highest internal precision.

� After you modify the settings for a drawing, you can use the Load/Save 
Settings page to name and save the setup so that you can use the same 
settings for each drawing in a project.

� After you initially set up the drawing, you can modify the Drawing Setup 
values by choosing the Drawing Setup command from the Projects menu.

 Setup

 How to Set Up
wings
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Drawing Setup Example: Setting a Base Point 
and North Rotation

The following example describes how to set a base point and north rotation 
using the Drawing Setup options.

Before you bring points into a drawing, you may want to set the drawing 
orientation. The drawing orientation settings include a base point and 
north rotation. These two settings control the drawing coordinate system. 
You can adjust both the base point so that it ties into a known coordinate 
system (that you can specify on the Zone tab of the Drawing Setup dialog 
box), and the north rotation so that all project points fit within the bound-
aries of a plot sheet.

Autodesk Land Desktop uses two coordinate systems for locating points: X,Y 
and northing/easting. When you start a new project, these values all default 
to 0 so that the Y coordinate is the same as the northing, and the X coordi-
nate is the same as the easting.

You can set up a base point to assign a specific northing and easting value to 
a fixed X,Y location. For example, if the drawing points begin at northing 
and easting coordinates of 5000,5000, then you can set a new base point to 
translate these coordinates so they fit onto the drawing screen.

By default, North is always represented in a drawing as the top of the screen. 
But you can define a different orientation of North if the drawing layout 
requires it. You should typically set the north rotation when you create a new 
drawing, but you can change it at any time. You can give different drawings 
that are in the same project different north rotations. This provides different 
views of the project point data relative to the X,Y coordinates.
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To set up the base point and north rotation

Steps Use  to locate

1 From the Projects menu, choose Drawing Setup to display 
the Drawing Setup dialog box.

Setting Up a Drawing Using 
the Drawing Setup 
Command

2 Click the Orientation tab.

3 Under Base Point, type X, Y coordinates for the base point, 
or click Pick and select a point from the drawing. 

Setting a different base point affects the view of the 
project data in the current drawing only and does not 
alter the point database coordinates. All project data files 
store their information as northing/easting coordinates.

Changing the Base Point for 
a Drawing

4 Under Northing and Easting, type the northing and 
easting coordinates to associate with the X,Y base point.

For example, if X,Y is 0,0 (the lower-left corner of the 
drawing screen), then you can specify the local northing/
easting coordinates that were used in a survey of the site, 
such as 5000,5000. This makes 0,0 equivalent to 
northing/easting of 5000,5000.

Changing the North 
Rotation for a Drawing
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Opening Drawings

You can open an existing drawing by using the Today window, by selecting 
the Open command from the File menu, and by typing open at the 
command line. 

If you open a drawing that is associated with an existing project, then the 
drawing is linked automatically to that project. If you open a drawing that is 
not associated with a project, then you must select a project or create a new 
project for the drawing to work with Autodesk Land Desktop commands.

Opening Drawings in Other Types of AutoCAD

Some of the objects, such as points, contours, and labels, that are created 
in Autodesk Land Desktop are called ARX objects. ARX objects cannot be 
modified if the drawing is opened in another AutoCAD program, such as 
regular AutoCAD or Autodesk Mechanical Desktop.

To share an Autodesk Land Desktop drawing with someone using another 
AutoCAD program, it is recommended that the person use Object Enabler 
from the Autodesk Land Desktop CD-ROM. Or, if the other person can 
access the Internet, Live Enabler runs automatically when a custom object 
is detected, as well as provides an option to download Object Enabler 
components.

5 Under North Rotation, select Angle and type a rotation 
angle, or select Define by Points and click Pick Rotation to 
define the rotation angle. Under Points Represent, select 
the angle that rotation angle represents. 

In an AutoCAD drawing, North is always the direction 
toward the top of a drawing. By changing the North 
rotation, you can orient the site however you want. 
Changing the north rotation affects only the commands 
that use a northing/easting coordinate system. It does not 
rotate the X,Y angular base.

6 Click OK to close the Drawing Setup dialog box.

7 From the Inquiry menu, choose Track North/East to 
display a box that tracks the northing and easting of the 
pointer as you move it across the screen.

Tracking Northing and 
Easting Coordinates

To set up the base point and north rotation (continued)

Steps Use  to locate

 an Existing 
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There are two other options to share Autodesk Land Desktop drawings in 
another AutoCAD program:

� Use proxy graphics.
� Explode custom objects to polylines by using the EXPLODE command.

Proxy Graphics
Proxy graphics, which represent the custom objects, are used to indicate the 
locations of custom objects in the drawing. 

NOTE If you share a drawing with another person who uses proxy graphics, 
then make sure when you save the drawing that the PROXYGRAPHICS variable 
is set to 1.

When an Autodesk Land Desktop drawing is opened in another AutoCAD 
program, the Proxy Information dialog box is displayed.

The Proxy Information dialog box identifies the missing application and the 
number of proxy objects in the drawing. The dialog box also contains three 
options:

� Do not show proxy graphics: Does not display proxy graphics.
� Show proxy graphics: Replaces custom ARX objects as proxy graphics.
� Show proxy bounding box: Displays a box surrounding custom ARX 

objects called a bounding box.

h Custom and 
jects
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Viewing Drawings

 A drawing position, orientation, or magnification level is called a view. The 
direction from which you view a drawing is called a viewpoint. To access stan-
dard AutoCAD viewing tools, select 3D Views from the View menu to display 
a submenu with viewing options. For quick access to viewing options, 
display the View toolbar in the ACAD menu group.

Key Concepts

� You can view drawings or objects from a side viewpoint, such as right, left, 
top, or bottom; from isometric angles; and in an elevation view.

� To view a drawing in 2D planes (X and Y planes), use plan view. In plan 
view, the drawing is displayed as if you were directly above and looking 
down on it.

NOTE Plan view has a beneficial and fail-safe property. After you have been 
working in 3D, you can always return to plan view to reorient yourself and 
the drawing.

� You can view objects in perspective by selecting the Object Viewer or 
Camera from the Utilities menu.

Using the Object Viewer

The Object Viewer is a viewing window that displays any objects you select 
within Autodesk Land Desktop. You can view the objects in either 2D or 
3D view. Use the Object Viewer to shade object surfaces and to reorient the 
view quickly. You can also reorient a drawing view to match the orientation 
in the viewer.

Key Concepts

� The initial view in the Object Viewer corresponds to the drawing view.
� If the drawing is in plan view, the objects in the Object Viewer are in 

2D plan view.
� If you are viewing a drawing in 3D, then the objects are displayed in 3D.
� You can shade object surfaces using flat shading or Gouraud shading. Flat 

shading shades the objects between the polygon faces. Gouraud shading 
shades the objects and smooths the edges between polygon faces, giving 
the objects a smooth, realistic appearance.   

 3D View
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Using Zoom and Pan 

The basic display commands, ZOOM and PAN, work much like a lens on a 
camera that can magnify or reduce the image of an object. Use ZOOM to 
enlarge or shrink the drawing and use PAN to move the “camera” eye from 
side to side, up and down, and so on. Zooming does not change the absolute 
size of a drawing, but changes the size of the view within the graphics area.

After you select Zoom from the View menu, or type zoom on the command 
line, you have several options, as shown in the following table: 

To view an object in the Object Viewer

Steps Use  to locate

1 From the Utilities menu, choose Object Viewer. Using the Object Viewer

2 Select the object you want to view in the Object Viewer.

3 Press ENTER to display the Object Viewer dialog box.

4 Use the Object Viewer tools to adjust the view. 

Zoom options

Option Description

Realtime Zooms in and out of the drawing by moving the magnifying glass 
icon. Realtime is the default setting for the ZOOM command. You can 
right-click to display a shortcut menu with additional options.

All Zooms out to include everything within the drawing file. This option 
also regenerates the drawing.

Center Magnifies the screen around a center point by a specified height or 
magnification factor.

Dynamic Displays the drawing within a view box that you can adjust. After 
you specify the extents of the box, press ENTER and that area becomes 
the new display.

Extents Enlarges the drawing to the tightest zoom possible of everything in the 
drawing file.

Previous Restores the prior view. You can select up to 10 previous views 
in succession.

w

a View (Zoom)
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NOTE If you want to zoom or pan in real time without using commands, 
select Aerial View from the View menu. The drawing is displayed in a separate, 
smaller window that remains open while you work, and in which you can navi-
gate around the drawing quickly. For more information, see “Pan and Zoom 
with the Aerial View Window” in the online Help. 

Scaling Views

When you work on the drawing in model space, you work at full scale. In 
paper space, you must specify a drawing scale that is determined by the size 
limits of the sheet of paper, or by how you want the drawing views to display.

You can scale the drawing in two ways. You can specify a scale factor at plot 
time, relative to the paper size, or you can scale the views in paper space float-
ing viewports. Scaling in layout viewports provides instantaneous feedback 
about whether the drawing view fits on the sheet of paper.

TIP You can use the DIST command to measure the model drawing to help you 
determine the scale.

Key Concepts

� To scale a view relative to the current view, use the Scale (X/XP) option of 
the ZOOM command. Add x after the value that you enter. For example, 
enter 2x to double the image size.

� To scale a drawing relative to paper space units, use the Scale (X/XP) 
option of the ZOOM command, and then enter the “xp” (“times paper 
space”) factor. For example, if you want 1 inch in paper units to equal 
1 foot in drawing units, then 1 in. = 1 ft. Enter the scale factor 12xp at the 
prompt.

� Use MVSETUP to scale viewports independently or as a group.  

Scale Zooms the display at a specified scale factor. The value you enter is 
relative to the limits of the drawing. For example, entering 2 doubles 
the apparent display size of any objects from what it would be if you 
were zoomed to the limits of the drawing.

Window Zooms to display an area specified by two opposite corners of a 
rectangular window.

Zoom options (continued)

Option Description

ws Relative to 
ace
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Using Named Views

As you work on a drawing, you may find that you return frequently to the 
same views. For example, you may zoom repeatedly into a particular area in 
the drawing. Rather than using the ZOOM command every time you want to 
view this area, you can name this view, and recall it when you need it. 

From the View menu, select Named Views to display the View dialog box in 
which you can create, save, delete, or restore a view.

Key Concepts

� When you save a view, both the viewing position, such as a specific pan 
or zoom position, and scale are saved.

� If you work in tiled viewports in model space, then only the view in the 
current viewport is saved. If you work in paper space, you can save the 
entire layout, including one or more floating viewports.

� When you restore a named view in model space, it replaces the active 
viewport. In paper space, however, the restored view replaces the entire 
layout, including one or more floating viewports.

� For more information about viewports, see “Paper Space and Layout 
Mode” on page 132.

 Restore Views
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Redrawing and Regenerating

When the drawing is cluttered with blips or temporary markers, you can 
clean up the current viewport quickly by using the REDRAW command. It 
refreshes the screen and redraws objects without updating the drawing from 
the database. If you use more than one viewport, you can use the 
REDRAWALL command.

You can also update the drawing screen by regenerating the drawing. The 
REGEN command reads all the data in the database and calculates the screen 
coordinates of each object on the screen. 

NOTE When you regenerate a complex drawing, it is time consuming. To 
reduce regeneration time, you can freeze layers to keep data from being regen-
erated. Otherwise, you can choose to redraw. 

Organizing Drawings with Layers

All drawing objects in Autodesk Land Desktop are assigned a layer. Layers in 
drawings are like sheets of clear acetate that are positioned one over the 
other. Layers help you organize drawing data, control the drawing display, 
and control what is plotted or printed. You can make objects on a layer 
invisible and prevent them from being plotted by freezing the layer or turn-
ing if off. You can lock a layer to prevent it from being modified.

Key Concepts

� You can group and organize drawing layers by function and other catego-
ries. For example, you can place minor contours on one layer and major 
contours on another.

� Each drawing can have its own layer structure, or hierarchy. You can also 
set up a layer configuration and then save it as a drawing template to 
enforce linetype, lineweight, color, and other standards when you create 
new drawings.

� Assign layers a color, linetype, and/or lineweight to distinguish them from 
other layers. Layer 0 is created when you start a drawing and it cannot be 
deleted. All other layers are layers that you create.

� By turning layers on and off, you can plot the same drawing to serve 
different purposes. 

� In lists, layers are sorted alphabetically by name. 

ommand

mmand
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Changing Properties of Layers and Objects 

You can make changes to objects and layers by using the Object Properties 
toolbar. 

               

Object Properties toolbar

Tool Description

Makes the selected object’s layer the current layer.

Displays the Layer Properties Manager dialog box in which 
you can manage layers and linetypes. 

Turns layers on and off. Layers that are turned off are 
invisible and not plotted.

Freezes and thaws layers in all viewports. Frozen layers are 
invisible and all objects are ignored. You can freeze layers to 
save regeneration time when zooming, panning, or selecting 
a viewpoint in a complex drawing. As you thaw a layer, 
Autodesk Land Desktop regenerates the drawing.

Freezes and thaws layers in the current viewport.

Locks and unlocks layers. To prevent objects on a layer from 
being modified, lock the layer. The objects remain visible, 
and you can use commands that do not alter the objects.

Displays the color assigned to a layer.

Undoes the last change or set of changes made to layer 
settings. 

Makes a color current, displays the color of a selected object, 
and changes the color of a selected object. The list contains 
the colors used most recently. Click Other to display the 
Select Color dialog box for additional color selections.

Makes a linetype current, displays the linetype of a selected 
object, and changes a selected object’s linetype.
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Working with the Layer Manager

In the Layer Manager, you can create, organize, sort, and group layers, as well 
as save and coordinate layering schemes. You can also implement layering 
standards to better organize the drawing layers.

You can use groups of layers to create working views and backgrounds from 
large drawings. You can create filter groups whose layers are assigned to them 
automatically based on filter criteria that you set for the group. If there are 
any layers in external reference files associated with the current drawing, an 
xref group contains those layers. The All layer group is always present and 
lists all the layers and other layer groups in the drawing.

By saving layer and view information in snapshots, you can quickly recall 
specific layer and view configurations from complex data sets. For example, 
a land surveyor might create snapshots of individual site plans and buildings, 
boundaries, and contours to separate this information from a complete site 
layout. After you create a layer snapshot, you can add and delete individual 
layers and then import the snapshot into new drawings to automatically set 
up a layering scheme.

Makes a lineweight current, displays the lineweight of a 
selected object, changes the lineweight of an object, and 
makes a lineweight current. 

Controls the plot style of objects. By modifying an object’s 
plot style, you can override that object’s color, linetype, and 
lineweight for plotting. You can also specify end, join, and fill 
styles as well as output effects such as dithering, gray scale, 
pen assignment, and screening.

Object Properties toolbar (continued)

Tool Description

with the Layer
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Key Concepts

� You can use the Layer Manager to create and manage new layers, and to 
make a layer current.

� You can use layer groups to create working views and backgrounds from 
data sets.

� You can create user groups to which you can assign any layer and filter 
groups. Layers are assigned automatically based on criteria you set.

� Filter groups can be static or dynamic. Dynamic filter groups automati-
cally update when you change the properties of the layers in them. Static 
filter groups do not update automatically. 

� Create a layer snapshot to save and reuse specific layer configurations 
from large data sets.     

To create a snapshot of a layer group

Steps Use  to locate

1 From the Utilities menu, choose Layer Manager. Creating a Snapshot of a 
Layer Group

2 In the left pane of the Layer Manager, click  to display 
all the layer groups in the drawing. 

NOTE If all layer groups are displayed, then skip this 
step.

3 Click the layer group that you want to save as a snapshot, 
right-click, and select Save as Snapshot from the shortcut 
menu.

4 In the Snapshot dialog box, type a name for the 
new snapshot.

5 Click OK to create the snapshot.
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Using Drafting Settings

Several Autodesk Land Desktop tools help you draw with accuracy. For exam-
ple, for maximum control over the drawing, you can set up a background 
grid that limits points you specify to points on the grid (snaps). You can also 
restrict location points on objects, such as the midpoint of a line and the 
center of a circle (object snaps). You can constrain cursor movement to the 
vertical and horizontal (Ortho mode), and you can turn on display markers 
and highlights for reference.

Settings for these drawing modes are in the Drafting Settings dialog box, 
which you can access by selecting Drafting Settings from the Tools menu.

 Settings 
ox
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The following table describes the drafting settings.          

Drafting settings

Drafting 
setting

Description

Snap Restricts cursor movements to measured intervals, or invisible “snap” 
points. You can specify snap distances and whether to display a grid that 
corresponds to the snap points. 

Grid Displays a web of visible dots that you can use as a guide. The dots are 
spaced according to the value that you specify in the Snap section of the 
Drafting Settings dialog box.

The following illustrations show the grid turned on. In the illustration on 
the left, Snap is turned off. The cursor does not snap to the grid points. In 
the illustration on the right, Snap is turned on. The cursor snaps to the grid 
points.

Polar 
Tracking

Sets the angles used with polar tracking and sets options for object snap 
tracking. Sets the basis by which polar tracking alignment angles are 
measured. The following illustration shows an example of polar tracking.

Object 
Snap

Controls running object snap settings and object snap tracking. Running 
object snaps automatically snap to points in the drawing when using a 
command. For more information see “Object Snaps” on page 79.

Snap off, Grid on Snap on, Grid on
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Using Reference Points in the Drawing

Autodesk Land Desktop provides tools to help you specify points precisely for 
accurate placement of objects and for reference.

Object Snaps
You can use object snaps (osnaps) to move the cursor to defined points on 
objects, such as the center of a circle, the midpoint of a line, or the intersec-
tion of two lines. For example, you can start a new line from the exact end-
point of another line. Set the object snaps you want to use in the Drafting 
Settings dialog box, which is displayed when you choose Drafting Settings 
from the Tools menu.

During a drawing session, if you do not want to use an object snap that you 
set, you can turn it off temporarily before you select a point. Double-click 
Osnap on the status bar, or press F3 to turn the settings off. Double-click 
Osnap again or press F3 to turn the same settings back on. 

ct Snaps

ocations on 
Object Snaps)
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The Object Snap tab also controls the use of object snap tracking. With object 
snap tracking, the cursor can track along alignment paths based on other 
object snap points when specifying points in a command. For more 
information, see “Verifying and Changing Object Snap Settings” in the 
online Help, and “AutoTrack” on page 82.

You can use the Object Snap shortcut menu, shown in the following illustra-
tion, to specify a specific object snap to use for a point, even when running 
object snaps are not turned on.

To display the Object Snap shortcut menu, run a drawing command like 
LINE, then press the SHIFT key and right-click.

AutoSnap
After you set snap point locations in the Drafting Settings dialog box, you 
can select AutoSnap options to preview and confirm locations during a 
drawing session before using the pointing device to specify a point. To access t Snap Visual 

oSnap)
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the AutoSnap settings, choose Options from the Tools menu and click the 
Drafting tab.

When the cursor moves over an object snap location, a marker is displayed 
(when the Marker check box is selected). If you pause, a ToolTip shows the 
name of the location (when the Display AutoSnap Tooltip check box is 
selected).

The following illustration shows the marker that is displayed over the 
endpoint, and the ToolTip that explains the snap point the cursor is 
snapped to.

AutoSnap works even when you set multiple object snaps. Press TAB to cycle 
through the snap points on an object.
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AutoTrack
AutoTrack is another way to specify a point in relation to existing points 
by using the pointing device. AutoTrack helps you draw objects at specific 
angles or with specific relationships to other objects in the drawing.

When you turn on AutoTrack, temporary alignment paths help you create 
objects at precise positions and angles. AutoTrack includes two tracking 
options: polar tracking and object snap tracking. You can turn AutoTrack on 
and off by choosing Polar and Otrack on the status bar.

Use polar tracking to track the cursor along temporary alignment paths 
defined by polar angles relative to a command’s From or To points. Polar 
tracking is used only when ORTHO mode is turned off. For an illustration of 
polar tracking, see “Using Drafting Settings” on page 77.

Object snap tracking works in conjunction with object snaps. You must set 
an object snap before you can track from an object’s snap point. The 
AutoSnap aperture settings control how close you must be to the alignment 
path before the path is displayed.

To use AutoTrack for object snap tracking

Steps Use  to locate

1 Start by drawing a line or polyline in a drawing, such as 
the line shown here.

Use the following steps to use AutoTrack to draw another 
line based on the snap points of this line.

Draw Lines

Draw Polylines

2 Turn on a running object snap like ENDPOINT by using 
the Drafting Settings command from the Tools menu.

Use Object Snaps

3 If AutoTrack is not currently active (the OTRACK button on 
the status bar appears indented when AutoTrack is active), 
turn on AutoTrack by clicking OTRACK on the status bar.

Track to Points on Objects 
(Object Snap Tracking)

4 Run a drawing command, like LINE.

5 When you are prompted to select a point, hold the cursor 
over one vertex on the original line you drew in step 1, 
but do not click. 

A small plus sign (+) is displayed over the point.
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Plotting Drawings

When you are ready to plot a drawing, set up a layout and configure the 
settings in the Plot dialog box. These settings include the printer or plotter 
you want to use, the plot style table, the layout(s) to plot, the plot area, scale, 
orientation, and other parameters.

To set up a drawing to plot, you work in a layout (also known as paper space). 
You can click the Model and Layout tabs at the bottom of the drawing screen 
to switch between model space and paper space. You use the Layout mode to 
set up the view that you want to plot by configuring viewports. You can have 
multiple layouts set up within one drawing to plot different views of the 
drawing. For more information about model space and paper space, see 
“Paper Space and Layout Mode” on page 132.

6 Move the cursor to a second vertex on the original line 
you drew in step 1, but do not click.

A small plus sign (+) is displayed over the second point.

7 Move the cursor to locate an alignment point, as shown 
in the following illustration.

8 Click to place the start point of the line at this location that 
AutoTrack identified.

To use AutoTrack for object snap tracking (continued)

Steps Use  to locate

 of Plotting

 of Plot Styles
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Key Concepts

� A plot style, which is an object property, can change the way a plotted 
drawing looks. By modifying an object’s plot style, you can override that 
object’s color, linetype, and lineweight. You can use plot styles if you need 
to plot the same drawing in different ways.

� Plot settings are saved in the drawing. 
� The Layout configuration is affected by the following plot settings: paper 

size, printable area, plot area, plot scale, and plot offset. If you modify the 
plot settings from the Plot dialog box, the layout paper image reflects the 
new plot settings after a drawing has been plotted. 

Exiting Autodesk Land Desktop

You can exit the Autodesk Land Desktop program by using the following 
methods:

� From the File menu, choose Exit.
� Type exit or quit.
� Click the close box in the upper-right corner of the Autodesk Land 

Desktop window.

Key Concepts

� When you quit a drawing, you are prompted to save any changes that you 
have made but not yet saved. 

� To allow multi-user read/write access to the point database and the align-
ment database, the point and alignment information is written directly to 
the databases, so they never need to be saved.
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4
Working with 
COGO Points
In this chapter

� Point markers and labels

� Points and CAD commands

� Upgrade information for users 
of S8 Civil/Survey

� Working with the 
project point database

� Establishing point settings

� Creating points

� Importing points

� Using point filters

� Editing points

� Point synchronization

� Working with point groups

� Working with description keys

� Working with external data 
references

� Geodetic transformations
COGO points are used in almost every land 

development project to identify locations in space. 

COGO points contain northing, easting, elevation, 

description, and name information that is stored in an 

external point database.
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Introduction

Points that Autodesk Land Desktop creates are called COGO points. COGO 
stands for Coordinate Geometry. COGO points are stored in an external 
database and are organized by their point numbers. COGO points have 
extended entity data associated with the points that includes point number, 
point name, description, elevation, northing, and easting. 

COGO point data is stored in an external database file called points.mdb, 
which is referenced by all drawings in a project. Because project points are 
stored externally, you can reference them without drafting them in a 
drawing. Point data can be accessed by multiple people on a network.

To add points to the point database, you can do the following:

� Create points using the Create Points commands on the Points menu.
� Import ASCII files.
� Import data from a Microsoft Access database file.
� Download from a data collector.

The following diagram illustrates the several ways to add points to a project.

ints
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The Points menu contains most of the point commands that you use to 
change point settings, add points to a project, and edit points in Autodesk 
Land Desktop.

Point Markers and Labels

When you create points, you have the option to display point markers or 
point labels, or both. Point markers can include point number, elevation, 
and either raw or full description, and are controlled by settings on the Text 
and Marker tabs in the Point Settings dialog box. If you want to label points 
with additional data and insert description key symbols, you must use 
point labels. 

es Between Point 
and Point Labels
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Point markers can stay the same size relative to the AutoCAD graphics 
window, or they can be a fixed size in the drawing. The following illustra-
tion shows point markers that are sized relative to the graphics window 
zoom level.

Point markers include a point marker node and point marker text for point 
number, description, and elevation. Although you must use labels to achieve 
full description key substitution, you can substitute full descriptions for raw 
descriptions using point markers.

In contrast, point labels can label any number of items. You can customize 
point labels to display any type of information about points. You can label 
points with data from external databases by using External Data References 
(XDRefs). You can also set up point label styles that perform description key 
substitution.

For more information about point markers, see “Changing the Point Marker 
and Point Text Settings” on page 95. For more information about description 
keys and point labels, see “Working with Description Keys” on page 114.

Points and CAD Commands

The commands from the Points menu create COGO point objects that have 
extended entity data. These objects are different from the simple CAD point 
nodes that you can create with the POINT command. 

The following illustration shows a CAD point node created with the POINT 
command on the left. On the right is a COGO point object created with a 
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command from the Points menu. The point text was dragged away from the 
marker and a leader was created automatically.

The COGO points are usually assigned description and elevation data as well 
as a required point number and northing and easting coordinates. This point 
data is stored in the point database. In contrast, a point node exists only in 
a drawing file, and it has only X, Y, and Z data associated with it.

You can convert CAD point nodes to COGO points by using the Convert 
from AutoCAD Points command from the Points ➤ Point Utilities menu.

Upgrade Information About Points 
for Users of S8 Civil/Survey

If you are familiar with Autodesk S8 Civil/Survey programs, this section 
summarizes new point features that were added to Autodesk Land Desktop.

� A COGO point is an object instead of a block with attributes. All point fea-
tures are now placed on the same layer, the current layer, unless you use 
description keys or point labels. The point object can stay the same size 
regardless of the zoom level magnification you use.

You can create leaders for points by dragging the point grip away from the 
point node, or you can turn this option off in the Point Settings dialog box 
so that leaders are not created when you move the markers.
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� The point database is a Microsoft Access database in Access 97 format.
� You can label points by using point labels. You can label the number, 

name, description, and elevation, as well as data from external databases. 
For example, you can label a point with different elevations obtained from 
borehole data.

� You can set up external references (or XDRefs) to external databases by 
using the XDRef Manager to display extended point data. Or, you can use 
the point object as a database display object for information other than 
point data.

� You can use the Point Group Manager to create point groups, which make 
it easier to manage a large number of points.

� When you reference points in a point group, you can override point 
database values with either fixed information or information from an 
external database.

� The Description Key Manager creates and manages description keys. 
Description key definitions are now stored in databases. You can have 
multiple description key files per project.

For more information about changes to points for Autodesk Land Desktop 3, 
see “What’s New in Autodesk Land Desktop” on page 3.

Working with the Project Point Database

Autodesk Land Desktop uses a project point database to store the point infor-
mation for a project. This file is named points.mdb and is stored in the project 
\cogo folder.

(For example, c:\Land Projects 3\newproj\cogo\points.mdb.)

You are prompted to set up this point database whenever you start a new 
project.

The Points commands in Autodesk Land Desktop, and any commands in 
Autodesk Civil Design or Autodesk Survey that create points, add points to a 
point database. If you use Autodesk Survey to import a fieldbook file, then 

 the Point 
e

int Database 
ox
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the point data is added to the point database and the observation data is 
added to the observation database.

� All programs in the Autodesk Land Solutions suite use the point database.
� You can set up the point database so multiple people can access it over a 

network.
� The point database stores all the point information outside of the draw-

ings, which keeps the size of the drawing files smaller.

Because all the project point information is stored in one file, it is easier to 
manage point data for a project. This is especially true when you work on a 
large project that contains several different drawings or when you work on 
the same project with other people on a network.

All commands that use point data, such as when you draw a line between 
points, refer to the point database, not to the drawing. Therefore, you can 
perform these functions even when the points are not drafted in the drawing. 
This gives you added flexibility when you work on large projects with thou-
sands of points. By keeping the points out of the drawing, you can speed up 
redraw time significantly.

Because all point information is stored in a database, you can create a new 
drawing and insert only the project points that meet specific criteria, such as 
region, point number range, or description. For example, you can insert 
points with descriptions associated with the boundary, such as iron pipes, 
corner points, or fence points.

You can limit access to the point database to one person, or you can share it 
with other people. If you share the point database with other people, then 
you can use the Lock Points command from the Points menu to protect 
against unwanted edits to the database.

Key Concepts

� All drawings in a project share a single point database file.
� Autodesk Land Desktop protects against duplicate point numbers. You are 

prompted for how to resolve any duplicates that may arise.
� For users of Autodesk S8 products: The point database project.pdf is called 

points.mdb. 
Working with the Project Point Database | 91



Setting Up the Point Database

When you start a new Autodesk Land Desktop project, you are prompted to 
create the point database before placing any points in the drawing.

Creating the point database involves

� Setting the character limit for point descriptions (2 to 254).
� Choosing whether to use point names, and then setting the character 

limit for point names (2 to 254).

After you create the point database, you can choose the database open mode 
by running the Point Database Setup command. To run this command, 
choose the Point Database Setup command from the Points ➤ Point 
Management menu.
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You can open the database so that only you have write access to it, or you can 
open it in multi-user mode so that multiple people can open and write to the 
point database.

If other people are using the point database, then you cannot switch from 
multi-user to single-user mode until the other people close the point 
database. To identify the users currently using the point database, click 
Other Users.

Establishing Point Settings

Before you create or import any COGO points into a drawing, you should set 
up the point settings. 

NOTE Changing the point settings does not affect points that are already 
inserted into the drawing. To update points in the drawing with changes to the 
point settings (such as marker style or automatic leaders, for example), re-insert 
the points into the drawing.

Changing the Point Creation Settings

The Point Creation settings affect how COGO points are created in a project 
and how you are prompted for information as you create points. For exam-
ple, you can create points with automatically generated elevations, or you 
can choose to be prompted for elevations. You can create points that are 
numbered sequentially, or you can choose to manually number the points 
that you create.

g the Point 
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To display the Point Settings dialog box, choose Point Settings from the 
Points menu.

When you import points, the Insert To Drawing As Created setting is used, 
but certain point settings, such as elevation, point number, and description, 
are not applied. The Import Points command uses the information in the file 
that you are importing. 

If more than one person working on a project over a network is creating 
points, then each person can adjust the current point number to avoid con-
fusion. One person could set 100 as the current point number, and another 
person could set 200 as the current point number. The same point number 
cannot be used twice in a project.

If you choose the 
Automatic option, 
type a value in the 
Default Elevation 
box.

To insert points 
into the draw-
ing, select this 
check box.

To create points 
with elevations, 
select the 
Automatic or 
Manual option.

Each person can set 
a different Current 
Point Number.
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Changing the Point Marker and Point 
Text Settings

When you create, insert, or import points into a drawing, the appearance of 
the points varies depending on the Point Marker and Point Text settings.

Use the Marker tab to control the style and size of the point marker (the 
symbol that marks the location of the point in the drawing).

Use the Text tab to control how the point text is displayed.

Use a custom marker 
or the AutoCAD 
POINT node style. 

Align the marker 
with the point text 
rotation.

Set the marker size 
relative to the screen 
or an absolute size. 

Choose a custom 
marker style for the 
point node. 

Control the visibility 
of number, elevation, 
and description.

Create leaders auto-
matically when 
moving point text.

Set the test size rela-
tive to the screen or 
an absolute size. 

Show full or raw 
point descriptions. 
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Key Concepts

� If you set the point marker size to a percentage of the screen, then the 
points are always the same size on screen regardless of the zoom level. 

� To change the AutoCAD POINT node style, use DDPTYPE.
� By default, Autodesk Land Desktop uses northing and easting coordinates 

to represent points in space. A northing coordinate is equivalent to a Y 
coordinate; an easting is equivalent to an X coordinate. From the Coords 
tab in the Point Settings dialog box, you can choose a different method of 
coordinate display.

� When you change the point settings using the Point Settings command, 
points already in the drawing are not affected. 

� To change the point marker settings of points already in the drawing, use 
the Display Properties command on the Edit Points submenu. You can 
also select points in the drawing, right-click, and select Display Properties 
from the shortcut menu.

Creating Points

Use Autodesk Land Desktop point creation commands to create points in 
many ways, such as by northing/easting, along an object, by turned angle, 
and so on. You can create points at intersections, on a slope, on alignments, 
by referencing a surface, and by interpolating.

Key Concepts

� Points created by using the commands on the Points menu are always 
added to the point database.

� Point prompts can differ, depending on how you set up the Point Creation 
Settings. Use these settings to assign elevations and descriptions to points.

� To create points by referencing geodetic directions, you must first choose 
the current zone for the drawing from the Drawing Setup dialog box.
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Importing Points

A quick and effective way to place points in a project is to import them. You 
can use the Import Points command to import the following:

� Point ASCII files.
� Data from a Microsoft Access database file.
� Points from another project point database.

For example, if a surveyor collected point data by using a data collector, the 
data can be downloaded as an ASCII file and then imported into the 
Autodesk Land Desktop project by doing the following:

1 Download the point data from a data collector as an ASCII text file using data 
collector software.

2 Create an import/export format that specifies information in the ASCII file.

3 Import the points using the import/export format. 

All points you import are added to the project point database.  

To create points by northing/easting

Steps Use  to locate 

1 From the Points menu, choose Point Settings to display 
the Point Settings dialog box.

2 Click the Create tab to change the Point Creation settings. 
These settings determine the data you are prompted for, 
the data created automatically for the points, and 
whether the points you create are inserted into the 
drawing.

Changing the Point 
Creation Settings

3 Click OK to close the Point Settings dialog box.

4 From the Points menu, choose Create Points ➤ Northing/
Easting.

� Type the northing of the point you want to create.
� Type the easting of the point you want to create.
� Type the description and elevation for the point if you 

are prompted for them.

Creating Points at 
Northing/Easting 
Coordinates

5 Continue to type the northing and easting for additional 
points, or press ENTER to end the command.

g Point Data

g and Exporting 
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To create an import/export format and import points

Steps Use  to locate 

1 From the Points menu, choose Import/Export 
Points ➤ Format Manager to display the Format Manager 
dialog box.

Creating a Point Import/
Export Format

2 You can choose from several default import/export 
formats. You can select one and then click View to see 
how the format is set up.

3 Click Add to display the Select Format Type dialog box.

4 Choose the type of import/export format you want to 
create. For example, to import an ASCII file, select User 
Point File and click OK.

Point File Format Dialog Box
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The Point File Format dialog box is displayed.

5 Click the column headings (the <unused> buttons) to 
establish the format. 

The Select Column Name dialog box is displayed.

Select Column Name Dialog 
Box

To create an import/export format and import points (continued)

Steps Use  to locate 
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6 Select the name of the column. For example, if the first 
column in an ASCII file contains the point number, then 
the first column must be set up for point numbers. 

Each column must be unique—after you use one column 
name option, it is removed from the list of available 
column names.

TIP If you cannot remember the order of the information 
in the ASCII file, then click Load to load the ASCII file into 
the dialog box so you can see the information that it 
contains.

7 Click OK to return to the Point File Format dialog box.

8 Select the Delimited By option and choose the file delimit 
method. For example, if you set up the ASCII file so that 
each piece of information is separated by commas, then 
type a comma (,) in the Delimit box.

9 Name the format, and then close the Point File Format 
dialog box.

10 Click Close to close the Format Manager dialog box.

11 From the Points menu, choose Point Settings and click the 
Create tab.

To import the points into only the database, clear the 
Insert to Drawing as Created check box. This significantly 
increases the speed of the import. You can specify the 
points that you can later bring into the drawing from the 
project point database by using the Insert Points to 
Drawing command from the Points menu.

Adding Points to the 
Drawing as Points Are 
Created

To create an import/export format and import points (continued)

Steps Use  to locate 
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12 From the Points menu, choose Import/
Export Points ➤ Import Options to display the 
COGO Database Import Options dialog box.

13 Use the options in the COGO Database Import Options 
dialog box to determine the following:

� How to resolve duplicate incoming points.
� What to do when point numbers are assigned by the 

source file.
� What to do when point numbers need to be assigned.

Click OK to continue.

Changing the COGO 
Database Import Options

14 From the Points menu, choose Import/Export 
Points ➤ Import Points to display the Format Manager -
Import Points dialog box.

Importing Points into the 
COGO Point Database

15 Select the format and the source file that you want to 
import.

16 Select the Add Points to Point Group check box to add the 
imported points to a point group, then select or create a 
point group.

To create an import/export format and import points (continued)

Steps Use  to locate 
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Coordinate Zone Transformations
You can perform coordinate zone transformations while you import points. 
For example, if you import points based on latitude and longitude into a 
drawing that uses a Universal Transverse Mercator (UTM) zone, then you 
can specify the zone from which the points are being imported. When the 
points are imported, they are converted to the drawing’s coordinate zone. 
For more information about performing coordinate zone transformations 
see “Performing Geodetic Transformations on Points” on page 123.

Using Point Filters

When you are using an Autodesk Land Desktop command that prompts you 
to select a point in the drawing, you can

� Select any point on the screen by using object snaps or by typing 
X,Y coordinates.

� Use an Autodesk Land Desktop point filter.

Point filters make it easy for you to accurately retrieve coordinate points from 
the point database or to accurately select points from the drawing. Point 
filters are a letter preceded by a period that you can type at any “Select 
Points” prompt.

� Type .p, press ENTER, and then type a specific point number.
� Type .g, press ENTER, and then select the point in the drawing.
� Type .n, press ENTER, and then type the point’s northing and easting 

coordinates.

For example, you could use the .g graphical selection filter to select any part 
of a point object on screen. This retrieves the exact coordinates of the point 
object from the point database.

17 Click OK to display the Import Options dialog box. 

18 Click OK to import the points.

To create an import/export format and import points (continued)

Steps Use  to locate 
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Key Concepts

� Point filters remain active until you turn them off by typing the filter 
again, or until you select another filter.

� You can use the .p filter to select points that are in either the drawing or 
in the project database.

� Points must be displayed in the drawing in order to use the .g graphical 
selection filter. 

To use point filters

Steps Use  to locate

1 Select a command that prompts you to select points. For 
example, from the Lines/Curves menu, choose Line.

NOTE The filters work only for Autodesk Land Desktop 
commands. They do not work for AutoCAD commands 
such as LINE.

Drawing a Line by Selecting 
Start and End Points

2 At the Starting point prompt, type .p to turn on the point 
number filter.

The command line changes to a prompt for a Point 
number.

Using Point Filters to Select 
Points

3 Type the number of the point at which you want to start 
the line.

The command line prompts you for another point 
number.

4 If you want to select the next point by selecting it from the 
screen, then type .g.

The command line prompts you to select a point object, 
and the cursor turns into a pickbox.

5 Select the next point from the screen using the pickbox.

6 Continue to select points, or press ENTER to end the 
command and draw the line.

NOTE You can turn off a point filter by retyping the same 
filter on the command line.
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Editing Points

The recommended method to edit COGO points is to use the Edit Points 
commands on the Points menu. These commands update the project point 
file and the points in the drawing. Use these commands to automatically 
update the point database to match the graphic changes, or to edit points in 
the project point database that are not visible in the drawing.

NOTE You can also use AutoCAD commands, such as MOVE or ERASE, to edit 
the points in the drawing. However, by default these commands do not update 
the project point database. To update the project point database after using 
these commands, use the Modify Project command from the Points ➤ Check 
Points menu.

Key Concepts

� The commands in the Edit Points menu, such as Points ➤ Edit 
Points ➤ Erase, change both the drawing and database simultaneously. 
AutoCAD editing commands, such as ERASE, change only the drawing 
and not the database.

� You can lock points to protect them against unwanted edits by choosing 
Points ➤ Lock/Unlock Points ➤ Lock Points. 

� To edit points by using MOVE, select the Allow Points to be MOVE’d in 
Drawing check box on the Update tab in the Point Settings dialog box. To 
update the project point database, you must also select the Update Point 
Database After MOVE Command check box.    

To edit points using Autodesk Land Desktop commands

Steps Use  to locate

1 With points in the drawing (or in the point database only), 
choose a point editing command, such as Move, from the 
Points ➤ Edit Points menu.

Editing Points

2 Select the points you want to move.

3 Select a base point and a point of displacement to move 
the point(s).
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Selecting Points to Edit

When you use the Autodesk Land Desktop point editing commands, you can 
select points using a point selection dialog box. This style of dialog box is 
used for many commands on the Edit Points submenu, like Edit Points, 
Datum, Move, and Copy. 

This point selection dialog box has been updated with new features for 
Autodesk Land Desktop 3, allowing you to do the following:

� Select all project points, select specific points by using the tabs, or select 
points by typing a point list directly in the Point List box.

� Select points by specifying raw description filters and point groups.
� Include and exclude points based on point numbers, elevations, and 

descriptions, using separate Include and Exclude tabs.
� Turn case sensitive matching on and off. When case sensitive matching is 

turned off, a description typed as “perimeter” will select all points with 
the description “perimeter,” “Perimeter,” “PERIMETER,” and so on.

� View a summary of your selection on the Summary tab.
� Insert points into the drawing, remove points from the drawing, erase 

points, lock, and unlock points, right from the dialog box. These features 
are also now available from within the Point Group Manager.

To edit points using CAD commands

Steps Use  to locate

1 With points in the drawing, select an editing command, 
such as ERASE, and select the point to edit.

Erase Command

2 After you edit the points, choose Modify Project from the 
Points ➤ Check Points menu to update the project with 
the changes that you made to the points in the drawing.

Updating the Project Point 
Database with Drawing 
Point Information

3 In the Modify Project Database Points from Drawing 
dialog box, select the options to modify the project, and 
then click OK.
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In addition, for the Edit Points command (select Points ➤ Edit Points ➤ Edit 
Points) you can now edit multiple points at a time. Select the points to edit, 
right-click in the column you want to edit, and then select Edit, as shown in 
the following illustration.
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When you select the Edit command, the following dialog box is displayed, 
which you can use to enter the new value to apply to all the selected points.

To select multiple points on the Edit tab (or the List tab of any of the other 
point selection dialog boxes, or the Point Group Manager), you can do any 
of the following:

� Hold down CTRL and click non-sequential points in the list.
� Hold down SHIFT and click the first point in a sequence you want to select, 

followed by the last point in the sequence you want to select.
� Click in a blank area outside the columns and drag your cursor over the 

points you want to select, as shown in the following illustration:

Key Concepts

� You can use the point selection dialog box to select points for all of the 
commands on the Points ➤ Edit Points menu except for Unerase. This 
dialog box is also used for the List Points, Insert Points to Drawing, 
Remove from Drawing, Radial Stakeout, and Consecutive Stakeout 
commands.

� To clear a point selection, right-click and select Clear Selection.
� When no points are selected on the Edit tab (for the Edit Points command 

only), you can right-click a column heading and select Edit to edit all of 
the points in the column at once.
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Point Synchronization

In some situations the project points may not match the drawing points. For 
example, the project database will not match the drawing points if you do 
any of the following:

� Use commands such as ERASE or COPY to modify the points.
� Edit points in the drawing and database, and then quit the drawing with-

out saving it.
� Restore an old version of a drawing.
� Edit points in one drawing and then open another drawing that contains 

the same points.

To change the drawing so that it matches the project point database, or to 
change project points to match the drawing, you can use the Check Points 
commands on the Points menu. You can use these commands to

� Add project points to a drawing, or remove them from a drawing, so the 
drawing matches the project.

� Add points in the drawing to the project, or remove points from the 
project that are not in the drawing, so the project matches the drawing.

For example, if more than one person is working on the project and adding 
points to the point database, then the points in the drawing may not match 
the project points. You can update the drawing with the project points by 
using the Modify Drawing command from the Points ➤ Check Points menu. 
The following illustration shows the options available when you use this 
command:

 the Project Point 
e with Drawing 
ormation
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Working with Point Groups

Point groups are named collections of point numbers that you can select when 
you edit and insert points and when you use points as surface data in the 
Terrain Model Explorer. By saving a collection of points to a group, you do 
not need to manually select the points each time you perform an operation. 
A point group does not store point information; the point database always 
handles point storage. The point group feature can help you organize the 
points into smaller, more manageable groups.

To create and manage point groups, use the Point Group Manager, shown in 
the following illustration. Access the Point Group Manager by choosing 
Point Group Manager from the Points ➤ Point Management menu.

New point group features in Autodesk Land Desktop 3 include

� Persistent Properties: Point groups now have persistent properties. This 
means that if points that match the properties of a point group are modi-
fied in some way, or if points were added to or removed from the point 
database, you can be alerted to update the point group. By using the 
Check Status, Show Changes, and Update features, you can check for 
changes to the point groups, show exactly which points that have 
changed, and update the point groups.

� Point Selection by Raw Description Matching: You can now select the 
points to include in a point group by specifying raw description matches 
from the Raw Desc Matching tab. The list that appears on this tab is 
derived from the defined description key codes in the project. All points 
in the point database with raw descriptions that match the selected raw 
description are included in the point group.

ups - concept
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NOTE The list on the Raw Desc Matching tab is derived from the defined 
description keys in the project, but this tab does not use Description Key 
settings, such as the ascending/descending sort order setting. Be sure to 
check the point list derived from selected raw descriptions, especially when 
using wildcard characters.

� Saving To and Loading From a Prototype: You can now save a standard 
point group file to a prototype that you can load into other projects. 

� Simplified Point Selection Methods: The Create Point Group dialog box 
now has separate Include and Exclude tabs for specifying the points to 
include or exclude from the point group. A new Summary tab summarizes 
the properties you define for the group and lists the total number of points 
in the group.

� Additional Point Commands: Insert points into the drawing, remove 
points from the drawing, erase points, lock, and unlock points in the 
Point Group Manager dialog box. Select the points and right-click to dis-
play these options in the shortcut menu.

Key Concepts
� You can show additional columns of data in the Point Group Manager. To 

show all columns (including point name, grid northing, and grid easting, 
which are not shown by default), right-click a column heading and choose 
Show All Columns from the shortcut menu.

� When you assign overrides, point groups can override existing point data 
that is contained in the point database. 

� From within the Point Group Manager, you can lock a point group to 
prevent it from being updated. You can also lock the points in a point 
group so they cannot be edited.  
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To create point groups

Steps Use  to locate

1 From the Points menu, choose Point 
Management ➤ Point Group Manager to display the 
Point Group Manager dialog box.

Creating a Point Group

2 Click  to display the Create Point Group dialog box.

3 Type a name and description for the point group.

4 Select the points for the point group by using the Raw 
Desc Matching tab, the Include tab, and the Exclude tab. 

Click Apply to update the Point List box at the top of the 
dialog box. All the points in the Point List box are 
included in the point group when you click OK.

5 Define overrides for the point groups by using the 
Overrides tab.

Point Group Overrides

6 Click the Summary tab to view a summary of the 
properties you defined for the point group.

7 Click OK to create the point group and return to the Point 
Group Manager.
Working with Point Groups | 111



Checking
Point Gro

Sea
Checking Point Group Status, Showing Changes, 
and Updating Point Groups

Because point groups have persistent properties, you can check to see if point 
groups require updating. A point group may require updating if 

� The properties (such as elevation or description) of points in the project 
have changed so they now match point group properties.

� The properties of points have changed so they no longer match point 
group properties.

� New points have been added to the point database that match point group 
properties.

� Points that match point group properties have been deleted from the 
point database. 

To see if a point group requires updating, you can check point group status. 
There are two ways to check point group status: 

� Select the Check Status on Startup check box in the Point Settings dialog 
box to automatically check point group status when the Point Group 
Manager is opened. 

� Use the Check Status options in the Point Group Manager to manually 
check the point group status. 

When the point group status is checked, the point group properties are 
compared with the point database. If the point group is out-of-date, the 
point group icon changes to . 

To see why a point group is out-of-date, use the Show Changes commands. 
The Show Changes commands provide a detailed list that describes the 
points that need to be added to or removed from the point group. The fol-
lowing illustration shows that points 16-20 should be removed from the 
LOTS point group because these points no longer match the point group 
properties (their descriptions were changed). 

After you review this list, you can update the point groups from within the 
Show Changes dialog box by clicking the Update Point Group(s) icon. You 
can also use the Update All Point Groups command to update the point 
groups without reviewing the changes.

 the Status of 
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Point Group Overrides

You can use the Overrides tab in the Create Point Group dialog box to over-
ride existing point data that is contained in the point database. 

There are two ways to override point data in point groups: 

� You can override the point label style, description, elevation, or name 
with a single fixed value that is used for all points in the group. 

� You can specify an XDRef name to substitute data that is in a Microsoft® 

Access database on a point-by-point basis. Use this option to override each 
point with a different value.

The following illustration shows the Overrides tab in the Create Point Group 
dialog box. Fixed overrides are applied to the point group Elevation and 
Point Label Style properties, and an XDRef override is applied to the 
Description property.

Overrides apply to a point group whenever you reference the point group. 
For example, if you include a point group that has elevation overrides in a 
surface definition, the elevation override values are used in the surface. If you 
insert a point group with description overrides into a drawing, then the 
description overrides are used for the raw descriptions of the points. If the 
override description matches a description key code, then description key 
substitution can occur. 

When you use overrides, no substitution is ever applied to the point 
database itself. 

up Overrides
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Working with Description Keys

You can use description keys to associate symbols with points and to control 
point and symbol layers. Use the Description Key Manager, shown in the 
following illustration, to define new description keys and create new descrip-
tion key files.

By using description keys, you can

� Insert symbols to visually distinguish the different types of points in the 
drawing.

� Specify layers on which to insert the points and the symbols.
� Scale and rotate symbols that are inserted with the points.
� Replace a “raw” (original) point description with a full description.

When you define description keys, you assign a description key code, a 
description format (or “full” description), a symbol, a point layer, and a sym-
bol layer. When you create or import a point with a raw description that 
matches a description key code, the point is placed in the drawing with the 
symbol, the point and symbol are placed on the specified layers, and the raw 
description is replaced with the full description. 

When you create points, you are prompted for the point number, point ele-
vation, and point description. A description key is essentially a replacement 
for the point description. For example, if you type TREE as the description for 
a tree point, and if TREE has been defined as a description key and it has a 
symbol associated with it, then a tree symbol is created for that point.

Autodesk Land Desktop includes many symbols that you can use for 
description keys. Imperial and metric symbols are stored in subfolders of the 
following folder:

c:\Program Files\Land Desktop 3\data\symbol manager

scription Keys
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You can also create a custom symbol to use in the drawing, and then you can 
use WBLOCK to save the block to the symbol folder.

If you edit description keys, you can update the drawing with the new set-
tings by using the Modify Drawing command from the Points ➤ Check 
Points menu.

Description Key Usage, Point Markers, and 
Point Labels

To fully implement description key substitution in a drawing, you must for-
mat and use a label style that is set up to use description keys. The label style 
may insert only a symbol, or it can label the point with point number, full 
description, and any other point value.

When you use point markers, the full description can be substituted for the 
raw description, but symbols are not inserted unless you use a point label 
style.

The following illustrations show the relationship between point markers, 
point labels, and description keys. 

� In the top illustration, the point label style inserts a symbol only (no text 
label), and the point marker text is visible.

� In the bottom illustration, the point label style inserts a symbol and 
creates a text label. The text label expands the description key code 
(dshrub) to its full description (Deciduous Shrub). Point marker text is 
turned off.

The point label style controls whether description key matching is on or off, 
which description key file to use, whether full descriptions are substituted for 
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raw descriptions, and whether description key symbols are inserted. It also 
controls whether the point marker text is turned off when a label is created.

The following illustration shows the options on the Point Label Styles tab 
(select Labels ➤ Edit Label Styles) that control the description keys.

Description Keys and Point Settings

If you create points manually, and you want to use description key substitu-
tion, then you should select the Manual option under Descriptions on the 
Create tab of the Point Settings dialog box, unless all the points have the 
same description key code. When you are prompted for a point description, 
type the description key code.

You do not need to select this setting if you are importing points from a file.

Description Parameters

When surveyors enter data in the field, they can use description parameters. 
Description parameters are entries, separated by a space, that expand the 
description of a point. For example, TREE OAK 7 is a description that has 
three parameters. 

By formatting a description key to use description parameters, you can main-
tain but reorder the point description information. For example, you can set 
up a description key that uses description parameters to convert the raw 
description “TREE OAK 7” to “7-inch Oak Tree.”

Key Concepts

� Description keys are saved to external files. Each project can have mul-
tiple description key files, which can be shared with other users across a 
network. All drawings within a project reference the same description 
key files.

� You can save description key files to prototypes so that you can add them 
into new and existing projects.

� You can use wild card characters when you create description keys. Wild 
cards expand the flexibility of description keys. For example, if you create 
a description key named T*, then any point whose description starts 
with T, such as Topo, T-1, or T2, is assigned the description key symbol.
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Creating a Utility Pole Description Key

The following example shows how you can create a description key using a 
symbol included with Autodesk Land Desktop.

The example describes how to create points that represent utility poles using 
a description prefix “UP.” By using wild card characters, you do not need to 
create a description key for each point description—you create only a 
description key that references the “UP” prefix.   

To create description keys

Steps Use  to locate

1 From the Points menu, choose Point Settings to display 
the Point Settings dialog box.

2 Click the Insert tab. Changing the Point 
Insertion Settings

3 Under Search Path for Symbol Block drawing files, 
click Browse, and locate the following folder.

c:\Program Files\Land Desktop 3\data\symbol manager\cogo

4 Under Point Labeling, select the Use the Current Point 
Label Style When Inserting Points check box.

NOTE In subsequent steps, you create the point label 
style to use for the new points.

5 Click the Create tab. Changing the Point 
Creation Settings

6 Under Descriptions, select Manual.

7 Click OK to close the Point Settings dialog box.

8 From the Points menu, choose Point 
Management ➤ Description Key Manager to display the 
Description Key Manager dialog box.

Using the Description Key 
Manager
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9 Click  to display the Create Description Key dialog 
box.

Creating a Description Key

10 For this example, type UP* as the DescKey Code. 

The asterisk (*) matches any point description that starts 
with UP. For example, UP5A or UP5B.

11 Type $* as the Description Format.

These wildcard characters keep the point description the 
same as when you enter it, so you can distinguish 
between UP5A and UP5B. However, you can assign a new, 
full description and this description would then be used 
for all the utility poles.

Using Wildcard Characters 
in Description Keys

12 Type PTS_UP as the Point Layer. This places the point 
objects on the PTS_UP layer.

13 From the Symbol Block Name list, select U_POLE.

14 In the Symbol Layer box, type the layer for the symbol.

15 Click OK, and then close the Description Key Manager 
dialog box.

16 From the Labels menu, choose Edit Label Styles and then 
click the Point Label Style tab.

Editing Point Label Styles

17 In the Name box, type Desckey style.

18 In the Data list, choose Point Number and click the Text 
button. 

To create description keys (continued)

Steps Use  to locate
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Working with External Data References

If you want to override data in the point database when you use point 
groups, or if you want to label points with information other than that 
which is in the point database, then you can use External Data References 
(known as XDRefs). An XDRef is a link to a column of data in a Microsoft 
Access database.

For example, if you have borehole data with which you want to label the 
points, you can add the data to a Microsoft Access file, create the XDRefs, and 
then label the points with the data. Or, you can use the point object as a data-
base display object for information other than point data. For example, you 
can label the point or override point data with database information, such as 
the abutting names and addresses or parcel areas. You must create an XDRef 
for each column of data that you want to use.

19 After {Number} in the text box, press ENTER to insert a 
carriage return.

20 In the Data list, choose Description and click the Text 
button.

21 Under Description Keys, select the DescKey Matching On 
check box, select the description key file, and select the 
Insert DescKey Symbol check box.

22 Click Save and then click OK.

23 From the Labels menu, choose Show Dialog Bar and make 
the Desckey point label style that you created the current 
point label style.

Selecting the Current Label 
Style from the Style 
Properties Dialog Bar

24 From the Points menu, choose Create Points ➤ Manual. Creating Points at Selected 
Coordinates

25 Select a location in the drawing for the new point.

26 When you are prompted for the description, type UP1A.

The description, UP1A, and the utility pole symbol are 
placed with the point, and the point and the symbol are 
placed on the specified layers.

To create description keys (continued)

Steps Use  to locate
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Key Concepts

� Data substitution in point groups with XDRefs is limited to point name, 
point label style, description, and elevation. However, you can add any 
data to point labels.

� XDRefs never actually change the point database information. They only 
substitute information for that which exists in the database or they 
append data to the labels. However, if you use elevations from an external 
file, then those elevations, not the elevations within the point database, 
are used when creating a surface.

� XDRefs can be made only to Microsoft Access databases. The Access data-
base must be saved in Microsoft Access 97 format.

� The XDRef database, XDRefs.mdb, which contains the links to the 
columns in external databases, is stored in the following folder and is 
used for all XDRefs in the project:

c:\Land Projects 3\<project name>\cogo     

To use XDRefs to label points 

Steps Use  to locate

1 Create a new project based on the default imperial or 
metric prototype.

Creating a Project

2 Select Map ➤ Database ➤ Data Sources ➤ Attach to 
display the Attach Data Source dialog box. 

3 From the Files of Type list, select Microsoft Access Files 
(*.mdb), and select SampleUserDB.mdb in the following 
folder:

c:\Land Projects 3\<project name>\cogo\UserDb 

This sample file is copied into every new project that 
you create that is based on the default prototypes.

4 If the Map Project Workspace is not displayed, select 
Map ➤ Utilities ➤ Project Workspace.

5 From Project Workspace, right-click SampleTable1 and 
select Edit Table. Add some sample description data to the 
DESC1 column for points 1, 2, and 3, and then close the 
file.

NOTE The only column that is required in an XDRef table 
is the point number (PNO) column. 

Using the Project 
Workspace

6 From Project Workspace, right-click SampleUserDB, and 
choose Detach from the shortcut menu.

When prompted, click Yes to detach the database.
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7 From the Points menu in Autodesk Land Desktop, choose 
Point Management ➤ XDRef Manager to display the 
XDRef Manager dialog box.

Using External Data 
References

8 From the Manager menu, choose Create XDRef to display 
the Create External Data Reference dialog box.

Creating an External Data 
Reference

9 Type a name for the external data reference. This name 
should indicate the type of information you are linking to. 
For example, if you are linking to description data for 
boreholes, you can name the XDRef “Borehole-Desc1.”

10 Click  to select the database. 

11 Select SampleUserDB.mdb in the following folder.

c:\Land Projects 3\<project name>\cogo\UserDb

After you select the database, the Table Name and 
Column Name fields become active.

12 From the Table Name list, select SampleTable1. This list 
shows all the tables that exist in the database that you 
selected.

13 From the Column Name list, select Desc1. This list shows 
all the columns that exist in the table that you selected. 
The dialog box should appear as shown in the following 
illustration.

14 Click OK to create the external reference.

To use XDRefs to label points  (continued)

Steps Use  to locate
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15 From the Labels menu, choose Edit Label Styles.

16 Click the Point Label Styles tab. Editing Point Label Styles

17 In the Name box, type a name for the new label style, 
such as Borehole.

18 From the XDRef list, select the name of the XDRef that you 
recently created.

19 Click the Text button to add that XDRef to the label style.

For a borehole label, you may want to label the points 
with multiple descriptions and elevations. You can also 
add any other point data, such as point number, to the 
label style. 

The upper-left section of the dialog box should appear 
similar to the following illustration:

20 Click Save to save the style, and then exit the dialog box.

21 From the Points menu, choose Point Settings. Click the 
Insert tab, and verify that the Use Current Point Label 
Style When Inserting Points check box is selected.

Changing the Point 
Insertion Settings

22 Click the Create tab and verify that 1 is the Current 
Number. 

NOTE For this example, the new points you create in 
step 25 must be numbered 1, 2, and 3 in order to obtain 
their description from the XDRef.

Changing the Point 
Creation Settings

To use XDRefs to label points  (continued)

Steps Use  to locate
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Performing Geodetic Transformations 
on Points

Use the Autodesk Land Desktop geodesy commands to relate survey data to 
mathematical models of the earth. 

Using the geodesy commands you can 

� Calculate the latitude and longitude, State Plane, or UTM coordinates of 
a point.

� Convert point data that is in another coordinate zone into the current 
drawing’s coordinate zone when you import points.

� Convert point data in a project from one coordinate system to another.

Hundreds of different zones are provided in Autodesk Land Desktop, includ-
ing UTM projections, and NAD27 and NAD83 State Plane grids. You can also 
use commands to edit zones and create new zones.

You can use geodetic calculations, related to the current zone, whenever you 
have any high-order survey calculations to complete, or if you must tie a 
survey into either state plane coordinates or UTM map projections.

To relate the assumed local northing/easting coordinates of a survey to the 
selected current zone, you must set the Transformation Settings for the 
drawing. 

23 From the Labels menu, choose Show Dialog Bar. Selecting the Current Label 
Style from the Style 
Properties Dialog Bar

24 Select the Borehole style as the current point label style.

25 From the Points menu, choose Create Points ➤ Manual to 
create three new points in the project.

The points are labeled with the XDRef information.

To use XDRefs to label points  (continued)

Steps Use  to locate
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Key Concepts

� The State Plane coordinates are expressed as grid northing and grid easting 
coordinates. 

� The assumed coordinates, local northing and local easting coordinates, 
are equivalent to the COGO point coordinates in the point database. 

� The Geodetic Calculator supplies “missing” information related to the 
current zone. For example, if you know the latitude and longitude of a 
point, then you can type this information into the calculator to compute 
the grid northing/easting coordinates. You can then use this information 
to set the Transformation Settings for the drawing.

� After you set the Transformation Settings for a drawing, you can enter the 
local northing/easting coordinates into the Geodetic Calculator to com-
pute either the grid coordinates or latitude and longitude of any point. 

Calculating State Plane Coordinates from a 
Known Latitude and Longitude

You can use the Geodetic Calculator to relate local northing and easting coor-
dinates to a State Plane coordinate system by using a known latitude and 
longitude that you collect using a Global Positioning System (GPS) receiver.

After you calculate the grid coordinates, you can set the transformation set-
tings for the drawing. This lets you calculate the grid coordinates or latitude 
and longitude of any point in the survey.

In the following task, two separate GPS latitude/ longitude readings are taken 
on two different points, and the local northing and easting readings of these 
points are recorded. 

To calculate State Plane coordinates from GPS data

Steps Use  to locate

1 From the Projects menu, choose Drawing Setup to display 
the Drawing Setup dialog box.

2 Click the Zone tab and select the current zone 
for the drawing.

Changing the Current Zone 
for a Drawing

3 Click OK to close the Drawing Setup dialog box.
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4 From the Points menu choose Point Utilities ➤ Geodetic 
Calculator to display the Geodetic Calculator dialog box.

Using the Geodetic 
Calculator

5 Type the latitude and longitude of the first point that you 
observed with the GPS.

The calculator automatically displays the grid northing 
and grid easting coordinates for the point that is related 
to the current zone that you selected in step 2.

Make a note of these coordinates.

6 Type the latitude and longitude of the second point that 
you collected and make a note of the grid northing and 
grid easting coordinates.

You can now use these grid northing and easting 
coordinates to set the transformation settings for 
the drawing.

7 Click OK to close the Geodetic Calculator dialog box.

To calculate State Plane coordinates from GPS data (continued)

Steps Use  to locate
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8 From the Projects menu choose Transformation 
Settings to display the Geodetic Transformation Settings 
dialog box.

Changing the Geodetic 
Zone Transformation 
Settings

9 Select the Apply Transform Settings check box.

10 In the Reference Point section, type the grid northing and 
grid easting coordinates for the first point that you 
calculated with the Geodetic Calculator.

Type the local northing and easting coordinates for the 
same point. Or, if you already placed that point in the 
drawing, you can click the Reference Point button and 
select the point from the drawing. You can also type the 
point number to retrieve the local northing and easting 
coordinates.

11 Repeat step 10 using the second set of grid northing and 
easting coordinates, but enter the information in the 
Rotation Point section.

To calculate State Plane coordinates from GPS data (continued)

Steps Use  to locate
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12 Click OK to apply the transformation settings.

13 From the Points menu choose Point 
Utilities ➤ Geodetic Calculator.

Now you can use the Geodetic Calculator to query the 
grid northing/easting and latitude/longitude of any point 
in the survey.

Using the Geodetic 
Calculator

14 Type the local northing and easting coordinates, and the 
grid coordinates and latitude/longitude are calculated 
automatically.

To calculate State Plane coordinates from GPS data (continued)

Steps Use  to locate
Performing Geodetic Transformations on Points | 127



128 | Chapter 4 Working with COGO Points



5
Working with Drawing 
and Editing Tools
In this chapter

� Working in model space and 
paper space 

� Autodesk Land Desktop lines 
and curves

� Working with basic AutoCAD 
commands to create objects

� Working with the Symbol 
Manager

� Working with text

� Digitizing

� Working with editing tools

� Modifying drawing objects

� Attaching external drawings
To increase productivity, take some time to learn the 

Autodesk Land Desktop drawing and editing tools. You 

can work in different modes, snap to objects for 

accuracy, and use grips to modify objects quickly. 
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Introduction

This chapter describes how to use the geometry creation and editing tools in 
Autodesk Land Desktop. Some topics include:

� Working in paper space and model space.
� Working with layout viewports.
� Using drawing tools to create geometry.
� Capturing data by digitizing paper drawings or raster images.
� Editing objects and correcting mistakes.
� Creating blocks.

Working in Model Space and Paper Space

To enhance productivity, it is recommended that you are familiar with model 
space and paper space. In model space, you create drawings and design draw-
ing elements; in paper space, you configure, or lay out, the drawing views on 
a sheet that represents the final plot.

The Model tab and layout tabs at the bottom of the drawing window control 
whether the drawing area is in model space or paper space. Each layout tab 
can display a different paper space drawing environment.

Click a layout tab to view a layout, and then click the Model tab to return to 
model space.

Model Space

When you start a drawing, you usually begin in a single, model space 
viewport where you design and create drawings. As you work in model space, 
you can switch at any time to paper space where you can set up a drawing 
sheet for plotting.

You can work in one or multiple viewports in model space. To make it easier 
to work on more than one portion of a drawing without having to constantly 
zoom or restore views, you can configure model space to use multiple, tiled 
viewports. Only one viewport, however, can be active at a time. Click inside 
a viewport to make it active. 

aper Space and 
ace
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To create tiled viewports 

Steps Use  to locate

1 From the View menu, choose Viewports ➤ New Viewports 
to display the Viewports dialog box.

Viewports Dialog Box

2 Select the name of the viewport configuration that you 
want to use.

3 Click OK to return to the drawing.

4 With the pointing device, click in a viewport to make 
it active.
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Paper Space and Layout Mode

After you complete a drawing in model space, you can arrange drawing 
views, or layouts, to be printed or plotted. Switch to a layout by clicking a 
layout tab at the bottom of the drawing screen, or by clicking MODEL on the 
status bar. In a layout, you can create and arrange layout viewports (also 
known as floating viewports) that contain views of the drawings that you 
created in model space.

Viewports in paper space are different from tiled viewports. Paper space view-
ports, or layout viewports, can be moved, resized, and can overlap and be 
plotted at the same time. This flexibility allows you to better create the final 
layout for plotting or printing. 

When you choose a layout tab for the first time in a drawing session, a single 
viewport is displayed as a sheet with margins to indicate the paper size of the 
current, configured plotter and printable area of the paper. 

Key Concepts

� In paper space, you can place layout viewports anywhere on the drawing 
sheet. Each new layout, by default, has one layout viewport that fills the 
entire display, or you can design a layout sheet with multiple viewports.

� When you use paper space to create text and dimensions, you can apply 
correct scaling relations between drawing objects and text in dimensions.  

To create an irregular viewport in paper space

Steps Use  to locate

1 To change to a layout, click a layout tab or click MODEL 
on the status bar.

2 From the View menu, choose Viewports ➤ Polygonal 
Viewport.

Create a Nonrectangular 
Viewport

3 Draw the viewport shape on the layout. 

You can use straight line segments or curves to draw the 
viewport.

4 Type Close to join the last segment of the viewport 
boundary with the viewport start point.

5 Model space is regenerated and the drawing objects 
become visible in the layout viewport.

h Layout 
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Controlling the Display in Layout Viewports

After you create layout viewports in the paper space layout, you can control 
the visibility of objects in the viewports in several ways. For example, you can 
freeze and thaw layers, hide lines, and use different views of the drawing, 
such as different magnification, orientations, or viewpoints.

After you create a layout viewport on a drawing sheet, you can move it, resize 
it, and overlap it with other viewports. You can use a view of tiled viewports 
within one floating viewport, and then arrange it with other viewports on 
the layout page. 

Key Concepts

� You can edit the contents of the layout viewport by returning to model 
space. To do this, click PAPER on the status bar. 

� Objects that are created in paper space, such as a border, are visible only 
in paper space and cannot be edited in model space.

� To plot viewports with different scales, it is recommended that you add 
dimensions in paper space.

� You can put dimensions and annotations on another layer, and you can 
make that layer visible or invisible.

� You can turn off viewports that you do not want to plot. You can also 
turn off a viewport when you move or resize it to avoid regenerating the 
drawing.

Autodesk Land Desktop Lines and Curves

You can use several methods to draw lines and curves in a drawing. For 
example, you can use

� Autodesk Land Desktop commands, such as Line, Curve, and Spiral, from 
the Lines/Curves menu. 

When you use these commands, you can reference points in the COGO 
point database.

� AutoCAD commands, such as LINE, ARC, and POLYLINE, to draw simple 
objects. 

For more information, see “Working with Basic AutoCAD Commands to 
Create Objects” on page 136.

� Autodesk Survey Command Line commands (if installed).
� Special Lines commands to create lines with symbols, such as tree lines 

and fence lines.
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When you use the Autodesk Land Desktop commands, such as Line and 
Curve, you can draw lines and arcs by referencing COGO points in the 
project point database. You can then use point filters to select points by 
number or from the drawing area.

Line and Curve commands can be simple or complex. For example, you can 
draw a line by selecting two points, or you can draw a more complex line by 
drawing a best fitting line between points using the least squares adjustment 
method.

Key Concepts

� Usually it does not matter how you draw objects. You can use the 
commands that work best for you. An exception is when you draw vertical 
curves or spirals as you design a roadway. To draw spirals, use Autodesk 
Land Desktop spiral commands; to draw vertical curves, use the Autodesk 
Civil Design vertical curves commands.

� After you draw the basic geometry of lines and curves, you can use the 
Autodesk Land Desktop database definition commands to define the 
geometry to databases. For example, you can use the objects to define 
parcels or roadway alignments. 

Drawing Spiral Curves

Spiral curves are frequently used in roadway design to achieve gradual 
transitions. Instead of having the constant curvature of an arc, a spiral 
curvature is adjusted for gradual curvature at the beginning and then 
increased curvature to the SC (spiral-to-curve) intersection.
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Autodesk Land Desktop supports four types of spirals: clothoid, quadratic, 
cosinusoidal, and sinusoidal. Each spiral type has a different rate of 
curvature, as shown in the following illustration.

For most purposes, you can use the clothoid spiral. However, when you 
design for extremely high-speed travel, such as for the rail systems of Europe 
and Japan, use spirals with quadratic, cosinusoidal, or sinusoidal curvature 
functions.

Key Concepts

� It is recommended that you create spiral curves by using the spiral com-
mands, rather than by using ARC or POLYLINE. 

� You can create spiral curves using speed tables. Superelevation informa-
tion, or the E value, is associated with spirals created from speed tables. 
You can use this superelevation data in Autodesk Civil Design when 
designing superelevated roads.
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Special Lines

To help you distinguish features on a terrain, such as fence and tree lines, 
Autodesk Land Desktop has a Special Lines command that draws lines or 
curves using symbol linetypes. The following illustration shows a tree line, 
which is a line with a series of curves.

Special lines include styles for a shore line, various fences, walls, and railroad 
tracks. You can also add annotation or symbols to special lines.

Working with Basic AutoCAD Commands to 
Create Objects

You use basic AutoCAD drawing tools to create lines, polylines, curved 
objects, hatched areas, and text.

Key Concepts 

� Most drawing tools generally display prompts to specify a start point and 
then an endpoint. You can specify these points with the pointing device 
or by entering coordinates on the command line.

� As you use drawing tools, it is important to pay attention to the prompts 
on the command line. Many drawing commands contain additional 
options.

� You can use basic objects as reference. For example, polylines can define 
boundaries, and construction lines can define limits.

Lines

The line is the most basic and functional drawing object. You can draw a 
line as a single segment or as a series of segments. To start a new line 
segment at the endpoint of the last line drawn, enter the LINE command 
again and press ENTER. 
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Line segments can also contain arcs. You can draw multiple parallel lines and 
freehand sketch lines. You can draw lines in a variety of styles by using dif-
ferent linetypes and colors. Each line segment is a single object. You can also 
draw a series of line segments as a single object, known as a polyline. For more 
information, see “Polylines” on page 137.

Key Concepts

� Draw a line segment by specifying a start point and an endpoint. A line 
can be one segment or be composed of a series of connected line 
segments. You can close line segments by joining the start point of the 
first line segment with the endpoint of the last segment.

� To draw lines with accuracy, enter coordinates on the command line.
� Specify settings such as object snaps or grid snaps to ensure precision. Use 

orthogonal locking, or the Ortho mode, which restricts the cursor to the 
horizontal and vertical axis, and assists in constructing 90-degree corners.

� To end the LINE command, you can press ENTER or ESC at any time. If you 
press ENTER twice, the LINE command is interrupted, and you can start a 
new line.

Polylines

Polylines are a series of line segments connected at vertices, or intersections, 
as shown in the following illustration.

The segments in a polyline are not separate objects; therefore, a polyline is 
created as a single object. Unlike standard line segments, polyline segments 
can be straight or curved, thin or wide, or tapered. When you edit a polyline, 
you change all its line segments at once instead of one at a time. After you 
select the polyline’s start point, you are prompted to select the following 
polyline options:

Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

lylines

r Join Polylines
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Key Concepts

� To create a curved segment in a polyline, select the Arc option and then 
use the pointing device to specify the arc endpoints. To return to drawing 
straight line segments, type L (Line) on the command line.

� To change the width of a polyline segment, select the Width option and 
specify a width greater than 0. You can also taper the width within each 
polyline segment by selecting the Halfwidth option. Specify a width at 
both the start point and the endpoint of the segment.

NOTE To draw a solid wide line, make sure that the Apply solid fill option 
on the Display tab of the Options dialog box is selected, or type fill at the 
command line and select ON.

� Specify the start point and endpoint of the polyline segments with the 
pointing device or by entering coordinates. To close a polyline (the start 
point of the first line segment joins with the endpoint of the last segment) 
use the Close option.

� You can also create a polyline from the boundaries of overlapping objects 
or from an object that was drawn using lines and arcs by using the 
Boundary command.

� To modify a polyline, choose Polyline from the Modify menu, or type 
pedit on the command line to display options for editing polylines. 

Curved Objects

You can use various methods to create curved objects, such as circles, arcs, 
ellipses, and donuts. 

Key Concepts

� Create a circle by specifying a center point, radius or diameter, or tangent 
points. You can choose a method to create circles according to how you 
want to control the sequence of point selection.

� There are several ways to create an arc, but one of the points that you 
specify is either the center point or the start point. 

� To draw an ellipse, you can specify center points or endpoints. The size of 
the ellipse is determined by its major (long) axis and its minor (short) axis. 
After you create the ellipse, you can move the cursor along one or both 
axes to adjust its size.

rved Objects
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� You can draw an elliptical arc by specifying endpoints and axis distance as 
if you were drawing a full ellipse. A start angle and an end angle that you 
specify define the arc’s start point and endpoint.

� To create either filled rings or solid-filled circles, you can create donuts, 
which are closed polylines that have widths. Create a donut by specifying 
the inside and outside diameter and the center.

Curved Lines

To draw irregularly shaped curves, you can draw a spline. A spline is a smooth 
curve passing though or near a given set of points in a drawing. 

You can create a spline by specifying points. You can close the spline so that 
the start and endpoints are coincident and tangent. 

You may have to experiment with the placement of the start and end tangent 
points. After you draw a spline curve, you can edit it with grips.

Hatch Patterns

In a complex drawing, you can use hatch patterns to distinguish different 
components or areas in the drawing.

To draw a curved line

Steps Use  to locate

1 From the Draw menu, choose Spline. You are prompted 
to select a polyline object or specify a point.

Draw Splines

2 Specify points along a path where you want to create the 
curved line.

3 Press ENTER, and you are prompted for the start tangent 
and end tangent. These points determine how the spline 
is displayed.

4 Return the cursor to the start point of the spline to locate 
the start tangent point, and then do the same for the end 
tangent point.

Modify Splines

 of Hatch 
and Solid Fills
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Key Concepts

� You can choose from a variety of predefined hatch patterns, or you can 
define your own.

� You can define an area to be hatched either by specifying a point inside a 
boundary, or by selecting an object to be hatched, if it is a closed object.

� To create complex boundaries for hatching, create a closed polyline or 
region, or any closed object. You can use advanced hatching options to 
detect any areas (islands) inside the boundary and control whether they 
are hatched.

� When you edit the hatch boundary, the hatch object adjusts to fit.
� To control where hatch patterns display in a drawing, place them on their 

own layers.  

To hatch an area

Steps Use  to locate

1 From the Draw menu, choose Hatch to display the 
Boundary Hatch dialog box.

Boundary Hatch Dialog Box
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2 In the Boundary Hatch dialog box, click the pattern that is 
displayed in the Swatch box.

The Hatch Pattern Palette dialog box is displayed.

Use Predefined Hatch 
Patterns

3 Select a pattern, and then click OK to return to 
the Boundary Hatch dialog box.

4 To hatch an enclosed area, click Pick Points. To hatch 
objects, click Select Objects.

5 Specify a point inside a closed boundary, or select an 
object.

6 In the Boundary Hatch dialog box, click OK.

To hatch an area (continued)

Steps Use  to locate
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Working with the Symbol Manager

Symbols are an important element in the preliminary design phase, in site 
drawings, and in completed as-built road plans. As a working tool, symbols, 
such as fire hydrants and benchmarks, can be placed in a site plan to produce 
the finished drawing. You can access over 700 symbols through the Symbol 
Manager and insert them into a drawings

Key Concepts

� Symbol palettes and symbol blocks based on APWA (American Public 
Works Association) symbol standards have been added to Autodesk Land 
Desktop.

� Symbols are organized into three levels in the Symbol Manager: sets, 
categories, and palettes.

� Before you add symbols to a drawing, you can preview them in the 
Symbol Manager.

� You can add symbols and create new symbol sets. You can create new 
symbols by editing existing symbols or by creating your own symbols.

To access symbols in the Symbol Manager

Steps Use  to locate

1 From the Utilities menu, choose Symbol Manager. Symbol Management

2 In the Symbol Manager, locate a symbol to insert by 
selecting a Symbol Set, Category, and Palette.

Using the Symbol Category 
and Palette Dialog Box

3 Select the symbol either graphically or from the list.

4 Click OK to insert the symbol into the drawing.
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Working with Text

An important part of drawing documentation is the text information, such 
as dimensions, specifications, labels, titles, and other annotation, that you 
can add. When you create single line or multiline text, the current text style 
is used. Each text style has associated fonts, heights, and any special effects, 
such as inserting text upside down or backwards. 

To use different text styles, such as leroy, you must load them into the 
drawing by using the Text options in Drawing Setup, shown in the following 
illustration.

To select the current text style, use the Text Style dialog box, which you can 
access by selecting Text Style from the Format menu. As you select different 

 of Text Styles

h Text Styles
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styles and settings, you can view a sample of the text in the Preview section 
of the dialog box.

After you have selected a text style, create text in the drawing by selecting 
either the Single Line Text or Multiline Text command from the Draw ➤ Text 
menu.

Key Concepts

� You can adjust the text height and width (compressed or expanded). You 
can also specify display effects, such as upside down, backwards, or 
vertical, for the text.

� Some text styles, such as Standard, are zero-height styles, which means they 
do not have a predefined text height. For these styles, specify a text height 
in the Height box. 

� The text can be rotated at an angle to align with angled lines in the 
drawing.

� You can adjust the slant of the text by specifying the oblique settings for 
the text. For example, you can place text on a line drawn at a 30-degree 
angle by entering 30 for the oblique value of the text.

� To insert short, simple text entries, use single-line text (TEXT command).
� For longer text entries, use a multiline text (MTEXT) command. You are 

then prompted to define a rectangular area to indicate the text’s position 
in the drawing. To enter the text, and to customize how the text is 
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displayed, use the Multiline Text Editor dialog box, shown in the 
following illustration.

Working with Curved Text

A curved text object is called CText (or AEC Curvetext). You can create, edit, 
or move curved text on any curve or circle object in a drawing. 

Key Concepts

� Select the CText grip and rotate the label around the curve. CText always 
remains legible. The text is flipped automatically, as necessary, so that you 
can read it in plan view.

� To explode the CText to individual text objects, use EXPLODE.
� If you change the position of the curve or circle on which you have placed 

the text, the text adjusts its position accordingly.     

To create text on a curve

Steps Use  to locate

1 From the Utilities menu, choose Curve Text ➤ Draw Curve 
Text, or type ctext at the command line.

Drawing Text on a Curve

2 Select the curve or circle object that you want to label.

3 Press ENTER to display the Curve Text Editor dialog box.

4 In the Text Above box, type the text you want placed 
above the curve.

5 In the Text Below box, type the text you want placed 
below the curve.

6 Select a text style. If you select a zero-height style, then 
also specify a text height.
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Attaching Notes to Objects

You can attach text or an external reference document to any AutoCAD 
object in a drawing by using Notes. 

Key Concepts 

� You can add detailed information to a selected AutoCAD object by 
selecting the Text Notes tab in the Notes dialog box.

� You can attach an external file (document, spreadsheet, image, or photo) 
to any AutoCAD object by selecting the Reference Documents tab in the 
Notes dialog box.

7 Specify an offset. The offset value is a factor that is 
multiplied by the text height to produce an offset 
distance.

8 Click OK to draw the text on the curve.

9 Change the position of the label using grips, if 
necessary. If you change the position of the curve 
that you have placed the text on, the text adjusts its 
position accordingly.

Grip Editing Label Text

To attach text to an object

Steps Use  to locate

1 From the Utilities menu, choose Notes. Attaching Text to an Object

2 Select the object in the drawing to which you want to 
attach a note.

3 Press ENTER to display the Notes dialog box.

4 Under Text Notes, type the text you want to attach to the 
object.

5 Click OK to attach the text to the selected object 
in the drawing.

6 To view notes for an object, choose Notes from the 
Utilities menu, and then select the object.

To create text on a curve (continued)

Steps Use  to locate
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Adding Leaders to a Drawing

Lines that connect annotation with objects in a drawing are called leaders. 
You can insert leaders that have text or symbols attached to them. There are 
two methods for adding leaders to a drawing. You can define the attributes 
of a leader with the annotation settings and then insert the leader in a 
drawing, or you can insert a predefined leader. 

Key Concepts

� You can define attributes of a leader by changing the Leader Settings.
� You can use a leader with predefined styles.
� You can insert a leader with text, describing the properties of an object.         

To insert a leader that you define

Steps Use  to locate

1 From the Utilities menu, choose Leaders ➤ Leader Settings 
to make changes to the default leader attributes.

Changing the Leader 
Settings

2 From the Utilities menu, choose Leaders ➤ Text Leader, 
and then select the type of leader you want to insert.

Inserting a Leader with Text 

3 Specify a start point and endpoint for the leader.

4 Do one of the following: 

� If you are inserting a text leader, enter the text that you 
want to be displayed at the end of the leader.

� If you are inserting a symbol leader, enter any symbol 
attributes that you want to be displayed in the leader 
symbol.

To insert a predefined leader

Steps Use  to locate

1 From the Utilities menu, choose Leaders ➤ Predefined 
Leaders to display the Leaders dialog box.

Inserting Leaders with 
Variable Pointers

2 Select the leader that you want to insert and click OK.

3 Depending on the leader that you select to insert, specify 
the leader attributes.
Working with Text | 147



Digitizin

Digitizin

Sea
Digitizing

You can digitize paper documents or raster images, such as bitmap files. 
Digitizing is synonymous with vectorizing, which is the process of creating 
AutoCAD vectors by tracing paper documents or raster lines.

Vector objects are produced when you draw objects in Autodesk Land 
Desktop. For example, when you draw a line by using the LINE command, it 
is a vector object. Vector objects are described by a set of mathematical equa-
tions, whereas raster data is made up of pixels. Raster data is produced when 
you scan a paper drawing or photograph with a document scanner. Autodesk 
Land Desktop cannot recognize raster lines and arcs as separate objects.

For example, if you have a raster image of contour lines, then you can insert 
the image into the drawing (at world coordinates and correct scale) and then 
use the Digitize Contours command from the Terrain ➤ Contour Utilities 
menu to trace the raster image on screen. If you have a paper contour map, 
then you can use a tablet and a table pointer, or puck, to trace the contours, 
creating polylines on screen that you can later turn into contour objects that 
you can use when building an existing ground surface.

Digitizing Methods

You can choose from the following digitizing methods and procedures.

� You can digitize by using polylines, lines, and arcs. 
� To digitize contours, you can use the Digitize Contours command, which 

draws straight line segments only. You can assign an elevation to the con-
tour as you digitize it, and you can make this elevation relative to other 
contours you draw. 

� You can specify to use a tablet to digitize when you set up Autodesk Land 
Desktop.

g Contours

g Tablets
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� Use the advanced digitizing tools in Autodesk CAD Overlay® to digitize 
raster images and create contour objects. For more information about 
CAD Overlay, contact your authorized Autodesk dealer.

Key Concepts

� You can rubber-sheet vectors by using the Map ➤ Tools ➤ Rubber Sheet 
command if their source (raster image or paper drawing) is distorted. For 
example, you can match points on the new vectors you created to control 
points in a drawing. You can also match points on an image frame 
(a vector object) to points in the drawing. For more information, see 
“Rubber Sheeting Two Maps” in the online Help.

� When you convert raster objects to vector objects, the drawing can be 
easily modified. Vector objects can also reduce a project’s total file size.

Working with Editing Tools

To edit objects in the drawing, you can choose from the following two 
options:

� Select the editing command first, and then select the objects that you 
want to edit. 

� Select the objects first and then select the editing command (noun-verb 
selection method).

Whether you choose the editing command first or later, you must distin-
guish objects that you want to edit from others by creating a selection set. 
A selection set contains one or more objects that a command can act upon 
at the same time.

Key Concepts

� You can group objects in a selection set according to properties such as 
color, linetype, lineweight, or layer.

� You can apply more than one editing command to the same selection set.
� You can name and save a selection set of objects, known as a group.
� When you select one member of a group, all members are selected.
� To use the noun–verb selection method to select objects and then select 

the editing command, the PICKFIRST variable must be set to 1. 

jects
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Creating a Selection Set with Filters

When you use the Build Selection Set command, you can create a selection 
set by setting up object property filters to specify the objects in a drawing you 
want to include in the selection set. Objects in the current drawing that do 
not satisfy the filter criteria are not part of the selection set.

Key Concepts

� You can specify the object properties that you want to include in the filter 
by name.

� You can select objects in the current drawing with the object properties 
that you want to include in the filter.    

To filter objects by specifying properties

Steps Use  to locate

1 From the Utilities menu, choose Build Selection Set to 
display the Build Selection Set dialog box.

Filtering Objects by 
Selection

2 Under Names in Drawing, click the button that 
corresponds to the property type that you want to include 
in the filter.

3 Select the property that you want to include in the 
selection set.

4 Click OK.

5 Click Build Selection to add all the objects in the current 
drawing that meet the filter criteria to the selection set.

6 Click Apply to accept the current selection set.
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Editing with Grips

The standard way to select objects in the drawing is to use grips. Grips are 
small boxes, or “handles,” displayed at various points on a selected object 
that you can use to edit the object. Each Autodesk Land Desktop object 
contains grips that you can use to stretch, copy, move, rotate, and change the 
height of an object.

NOTE To make sure that grips display, choose Options from the Tools menu, 
and then click the Selection tab. Under Grips, select Enable Grips. To help you 
distinguish between unselected and selected grips, specify different colors for 
Unselected grips and Selected grips.

The following illustration shows the grip points on objects and text.

   

To edit with grips

Steps Use  to locate

1 To display grips, press ESC twice to clear any commands. Use Grips to Edit Objects

2 Click the object that you want to edit, and then click a 
specific grip.

3 Right-click and choose an editing command from the grip 
editing shortcut menu.

NOTE Some commands prompt you to enter further 
options on the command line.

Use Grip Modes

4 After you finish editing, press ESC twice.
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Correcting Mistakes

You can correct errors in several ways. Most editing commands require that 
you select drawing objects either before or after the editing process. However, 
the Undo, Redo, and Oops commands rely only on previous actions that you 
have taken. The following table describes the most frequently used methods 
of correcting mistakes.   

Modifying Drawing Objects

You can easily revise drawings in Autodesk Land Desktop. You can use either 
the commands from the Modify menu, or you can use several editing com-
mands in combination with grips. Select a specific grip, and then right-click 
to display the grip editing shortcut menu. By using the shortcut menu, you 
can move, mirror, rotate, scale, and stretch objects. The following sections 
describe the most common commands used to modify objects.

Frequently used editing commands

Command Access Description

undo Edit ➤ Undo, or type u on 
the command line.

Reverses the most recent action in the 
current drawing session. You can move 
back through as many actions as you want 
by entering a number on the command 
line. However, a more accurate way is to 
step back incrementally by entering 1 at 
the prompt. 

redo Edit ➤ Redo, or type redo 
on the command line.

Reverses the UNDO command to reverse 
the most recent undo action.

erase Modify ➤ Erase, or type 
erase on the command 
line.

Removes selected objects from the 
drawing. Use any method to specify the 
objects to be erased. 

oops Type oops on the 
command line.

Restores objects that were removed by 
Erase.
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Copying Objects 

You can copy objects to any location in the drawing independent of, or in 
relation to, the original object. To copy one or more objects, select one or 
more objects or a block, and then specify a start point (base point) and an 
endpoint (point of displacement).

Key Concepts

� You can copy selected objects multiple times in succession by typing 
m (Multiple) on the command line.

� To mirror an object, create a mirror line by specifying two points. The new 
object is placed along the line in a mirror image of the original object. You 
can either keep or delete the original object.

� You can offset a copy of an object a specified distance from the original 
object. You can offset objects such as lines, arcs, circles, 2D polylines, 
ellipses, and so on. The offset object has the same linetype, color, and 
layer properties as the original object.

� You can create an array of identical objects (multiple copies of an original) 
in a rectangular or circular (polar) arrangement. For a rectangular array, 
you can specify the number of rows and columns.

� In a polar array, you place objects around the circumference of a circle or 
arc. You specify the center of the circle, the number of identical objects 
that you want in the array, and the angle, or rotation, of each object from 
the center.

Moving Objects

To move an object, select the object and specify a start point (base point) and 
an endpoint (point of displacement).

Key Concepts

� The MOVE command is similar to the basic COPY command, but it does 
not leave the original object in place.

� You can use various methods, such as snaps, coordinate values, and object 
snaps, to move objects with precision in a drawing.

� You can move objects without changing their size or orientation.
� You can rotate objects using the ROTATE command after you specify a 

start point (base point around which the object rotates), and a relative or 
absolute rotation angle. You can use the pointing device to position the 
object, or you can enter an exact angle value at the command line.  
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Resizing Objects 

You can change the size of objects by using commands from the Modify 
menu that stretch, scale, extend, lengthen, and trim objects. 

Key Concepts

� To stretch an object, choose Stretch from the Modify menu, select the 
object with a crossing selection, and then specify a base point and a point 
of displacement. To stretch an object with accuracy, use the Stretch grip 
mode in combination with object snaps or grid snaps, or enter relative 
coordinate values. For more information about using the crossing selec-
tion method, search Help for “Move Objects.”

� You can use various methods to scale objects with the same scale factor in 
the X and Y directions. You can enter a scale factor, or you can scale in 
relation to an existing object. When you use an object as a reference, you 
can either enter a scale factor or you can select two points to drag the 
object to the scale you want and then click to select it.

� If you want an object to end precisely at an implied boundary (construc-
tion line) or another object, you can extend the object.

� You can cut an object so that it does not overlap another object by 
trimming it to the first object. To define the edge at which you want to 
trim the object, select a line, polyline, arc, circle, or other object.

� You can alter the length of objects in various ways, such as specifying the 
distance to lengthen in units or as a percentage, entering the total length 
of the object, or dragging the object’s endpoint.

Inserting Breaks in Objects

You can erase a specified portion of objects, such as lines, circles, arcs, 
polylines, ellipses, splines, and construction lines. After selecting BREAK, you 
can choose one of two ways to break an object.

� Use the pointing device to select the object at the first break point, and 
then select the second break point.

� Select the whole object, enter f to select the first point, and then select the 
second point.

In arcs and circles, the BREAK command always removes the specified part in 
a counterclockwise direction.

 Reshape

 Modes

xtend Objects
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Using the Utilities Edit Commands

You can use the Utilities Edit commands to change blocks, text, and object 
properties. You can also perform a quick scale of an object or a layer, as well 
as erase all objects on a layer.

Key Concepts

� You can make blocks and text smaller or larger in the drawing.
� You can change Z coordinates of selected objects to a specified value.

To rescale blocks and text

Steps Use  to locate

1 From the Utilities menu, choose Edit ➤ Rescale Blocks/
Text.

Rescaling Blocks and Text

2 Type the scale factor or reference that you want the block 
or text to display, and then press ENTER.

3 Type the rotation angle and press ENTER.

4 Select the objects that you want to rescale.

To set the Z coordinate of an object to a new elevation

Steps Use  to locate

1 From the Utilities menu, choose Edit ➤ Flatten Z Values. Setting the Z Coordinate of 
an Object to Zero

2 Select the objects whose Z values you want to adjust.

3 Type a new elevation for the objects.

 Utilities Editing 
ds

enu (Utilities)
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Creating Blocks

A block is a group of objects that you can define as one object, or block defi-
nition. For example, you could use individual objects, such as lines and 
curves, to draw a symbol. You can then define those objects as a block, which 
can be reused from drawing to drawing. If, at some point, you must modify 
the individual objects within the block, then you can explode the block.

Key Concepts

� Use BLOCK to define blocks to exist in the current drawing only. Use 
WBLOCK to define blocks as .dwg files that are independent of the current 
drawing.

� You can create a library of blocks in which each block is a frequently used 
combination of objects.

� You can create custom blocks and save them as external files to use as 
symbols.

� If you change the original block definition, then all references to the block 
definition are updated automatically. However, if you import a block 
definition from another file and that file is not attached as an external 
reference (xref), any changes you make to the block definition are not 
updated in the current file.

� After you insert a block, you can scale, rotate, or explode it. When you 
explode a block, it is broken down into its component objects. You can 
then modify the objects or redefine the block.

You can use AutoCAD block creation and definition tools as shown in the 
following tasks.      
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To create a block definition

Steps Use  to locate

1 From the Draw menu, choose Block ➤ Make to display the 
Block Definition dialog box.

Overview of Blocks

2 In the Name box, type a name for the block.

3 Click Select Objects. Use any object selection method to 
select the objects that you want to include in the block 
definition, and then press ENTER to return to the Block 
Definition dialog box.

4 Select Convert to Block to convert the original objects to 
a block definition. You can also select Retain to keep the 
original objects in the drawing, or select Delete to remove 
the objects from the drawing.

Create Blocks Within 
a Drawing

5 Click Pick Point to define an insertion base point. Insert Blocks

6 Click OK. The block is defined as an internal block, and 
exists in the current drawing only.
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Attaching External Drawings

You can link another drawing to the current drawing by using the external 
reference (xref) option. If you insert a drawing as a block, the block definition 
is stored in the current drawing, but it is not updated if the original drawing 
changes. However, if you attach a drawing as an external reference, then the 
current drawing is updated if the original changes.

Key Concepts

� You can either attach or overlay an xref drawing.
� During a drawing session, you can keep the current drawing updated 

while changes are being made to an attached xref drawing by periodically 
reloading the xref.

� You can completely remove, or detach, an xref drawing from the 
current drawing.

� To save memory and increase speed, you can unload an xref drawing that 
you are not using. The pointer to the xref drawing remains and you can 
reload it when you need it.

� You can make an xref drawing a permanent part of the current drawing by 
binding it. Binding converts an xref to a block that is no longer updated 
when the original drawing changes.     

To insert a block

Steps Use  to locate

1 From the Insert menu, choose Block. Insert Blocks

2 In the Insert dialog box, select a block or a drawing file to 
insert as a block.

3 Specify the insertion point, scale, and rotation, and then 
press ENTER to insert the block.

TIP To view the insertion point for the block, type 
blipmode at the command line.

Use Precision Tools 
(Reference tab)
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To attach an xref drawing

Steps Use  to locate

1 From the Insert menu, choose External Reference to 
display the Select Reference File dialog box.

Attach External References

2 Select the drawing file, and then click Open to display the 
External Reference dialog box.

3 Select Attachment and specify the external reference 
parameters, and verify that under Insertion point, the 
Specify On-screen check box is selected.

4 Click OK to select the insertion point in the drawing.

NOTE If you do not use all the xref drawing in the 
current drawing, then type xclip (clipping boundary) to 
remove a portion of an xref drawing from the display.

Clip External References 
and Blocks
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6
Working with Surfaces
In this chapter

� Working with the 
Terrain Model Explorer

� Creating surface data

� Building surfaces

� Editing surfaces

� Working with surface output 
and visualization tools
You can use points, DEM files (digital elevation models), 

contours, breaklines, and boundaries to generate a 

model of the earth’s surface. From this model, you can 

create contours and sections, and by comparing two 

surfaces, you can calculate volumes. 
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Introduction

After you have entered data into a project, you can create a surface model 
from that data. A surface model is a three-dimensional geometric representa-
tion of the surface of an area of land. Surface models in Autodesk Land 
Desktop are made up of triangles, which are created when Autodesk Land 
Desktop connects the points that make up the surface data.

The triangles form a triangulated irregular network (TIN) surface. A TIN line is 
one of the lines that makes up the surface triangulation, as shown in the 
following illustration. 

To create TIN lines, Autodesk Land Desktop connects the surface points that 
are closest together. These TIN lines interpolate surface elevations, filling in 
the gaps where no survey data or contour data is known, to create an approx-
imation of the surface.

Using Point, DEM, Contour, Breakline, and 
Boundary Data in Surfaces

Random point data, points taken at a variety of elevations and coordinates 
as opposed to interpolated contour data, often makes the best surface data. 
To use points for a surface, you can select point groups, select COGO points 
from the drawing, or import point files. You can create point groups from the 
points in the COGO point database. Point files can be ASCII text files or 

 Surface Models
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Microsoft® Access database files. If you have blocks or lines at elevations in a 
drawing, then their coordinates can also be selected as point data to use in 
surfaces. 

In addition to points, you can also build surfaces from DEM files (Digital 
Elevation Models), contour, breakline, and boundary data. You can have the 
contours treated as individual points where the contour vertices are used as 
surface points, or you can have the contours treated as breaklines that 
prevent triangulation lines from crossing the contours. Surface TIN lines 
typically do not cross contour lines. 

To build a surface accurately, you must provide more information than 
points and contours. For example, to prevent surface triangulation across 
features such as roads or streams, you can define breaklines. Breaklines are 
constraint lines used by the model that represent abrupt changes in the 
surface. TIN lines can be drawn to and from breakline vertices, but they do 
not cross the breakline. 

By including boundaries in the surface definition, you can control how the 
surface extends to its outer limits, and you can hide internal areas to prevent 
triangulation from occurring.

Surface Accuracy

When you gather data for the surface model, you must be thorough so that 
you create an accurate model. 

At the beginning of a project, you can make a quick surface model by 
digitizing a contour map of the existing site, or by using a DEM file. If the 
project is more advanced, and you already have survey data, then you can 
use the point data from that survey to create a more accurate surface model. 

If you do not have enough surface data, then the surface elevations may not 
be interpolated correctly. By being thorough, you can ensure that the surface 
output—such as contours, volumes, watershed models, profiles, and cross 
sections—is as accurate as possible. 

urfaces

Data and 
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Working with the Terrain Model Explorer

The Terrain Model Explorer consolidates all the surface creation and manage-
ment features in one place. You can use the Terrain Model Explorer to create, 
open, build, and view surfaces. 

The left pane of the Terrain Model Explorer contains a Terrain and a Volume 
folder. To create a new surface, right-click the Terrain folder and choose 
Create New Surface from the shortcut menu. After you create a surface, a 
surface folder with icon is created below the Terrain folder. Click the surface 
icon to display the surface data icons. You can access commands by 
right-clicking the icons to display a shortcut menu.

Use the shortcut menus to add the surface data to the surface folder, and then 
build the surface. 

The Volume folder in the left pane of the Terrain Model Explorer contains 
information about grid and composite volume surfaces that are created from 
the volume calculations commands on the Terrain menu. Use the Terrain 
Model Explorer to view properties about the volume surfaces, as well as open, 
close, and view volume surfaces.

You can keep the Terrain Model Explorer open while you use other com-
mands. Use the buttons in the upper-right corner of the dialog box to 
minimize, maximize, and close the Terrain Model Explorer.

 Terrain 
plorer

 Surface Models

g Surfaces
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Creating Surface Data

Before you can build a surface, you must create surface data in the Terrain 
Model Explorer by using the shortcut menu commands, such as Add Point 
Group.

When you add the surface data into the Terrain Model Explorer, you are 
determining the objects to include in the surface. These objects can be point 
groups, point files, points, DEM files, breaklines, contours, and boundaries.

Key Concepts

� When you import a point file into the Terrain Model Explorer, the point 
data is not added to the point database. The data is used exclusively for 
building the surface.

� To add contour data to a surface, you must have contour objects or 
polylines in the drawing.

� To add breaklines, you must use the commands on the Breaklines shortcut 
menu in the Terrain Model Explorer. 

Creating Breaklines to Use in Surface Generation

Breaklines are constraint lines that represent abrupt changes in a surface, 
such as retaining walls, stream banks, and curb; or breaklines represent 
objects with known elevations, such as contours. You can use breaklines to 
prevent surface triangulation across these objects.

Breaklines prevent TIN lines from crossing the breakline. This is essential if 
the breakline represents a constant elevation, and you do not want eleva-
tions to be interpolated across such a breakline. The breakline also forces 
retriangulation of the surface based on the breakline vertices. 
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The following illustration shows how a surface triangulates before and after 
breaklines are created. When you define breaklines, you can control triangu-
lation with regard to abrupt changes in the terrain.

You can define three types of breaklines. 

� Proximity breaklines: Defines breaklines using the surface points nearest 
to the breakline that you draw. You do not have to snap to exact points. 

� Wall breaklines: Defines the elevations of a wall-type object on both 
sides of the wall. For example, triangulation is linked to the bottom of 
the wall on one side, and then begins again from the top of the wall on 
the other side. 

� Standard breaklines: Defines the breaklines using the exact points or 
polylines that you select. 
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Creating Contours to Use in Surface Generation

You can use vector contours, either polylines or contour objects, in surface 
generation. However, contour data differs greatly from data taken randomly 
in the field. Since contour map data is interpolated, the information may be 
less accurate than direct field data. The accuracy of the final surface model 
depends on the quality of both the contour map and the contour interval.

Unlike breaklines, which you create directly from within the Terrain Model 
Explorer, contours (as contour objects or polylines) must already be in the 
drawing in order to select them as surface data.

You can use contour data either as breaklines or as points when you add the 
contour data to the Terrain Model Explorer. When you add contour data to 
the surface folder, the Contour Weeding dialog box is displayed. 

When the Create as Contour Data check box is selected, the contours are 
treated as breakline data, so no triangulation occurs across contours. When 
the Create as Contour Data check box is cleared, the contour vertices are 
treated as point data for the purposes of triangulation.

Creating Boundaries to Use in 
Surface Generation

Boundaries can help eliminate certain surface editing tasks. 

� Boundaries control how the surface TIN lines extend to the outer limits of 
a surface.

� Boundaries hide internal areas of a surface. 

 Contour Data 
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For example, if a pond exists on the surface, you can either build the surface 
and then delete the triangulation lines that cross the pond, or you can create 
a boundary around the pond before building the surface so that the area of 
the pond is hidden. The same applies to outer surface boundary lines. You 
can either delete the TIN lines that extend beyond the survey limits after you 
build the surface, or you can create a boundary around the survey limits 
before building the surface.

The following illustration shows the effect of an outer boundary.

Building Surfaces

After you choose the information to include in a surface, you can build the 
surface. When you build a surface, all the surface data is processed and the 
program calculates the surface triangulation. The triangulation is calculated 
by combining the breakline, contour, DEM file data, and boundary data with 
the surface point data and interpolating the results.

Everything that you add to a surface folder in the Terrain Model Explorer can 
be used in the surface, but you can exclude certain data from build to build 
to examine different results.
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Key Concepts 

� You can have an unlimited number of surfaces in a project or drawing.
� Surfaces are stored in the following folder:

c:\Land Projects 3\<project name>\dtm

� You can access surfaces simultaneously across a network. The first user 
who opens the surface has read/write access to it. All other users have 
read-only access.

To build a surface

Steps Use  to locate

1 From the Terrain menu, choose Terrain Model Explorer 
to display the Terrain Model Explorer dialog box.

Using the Terrain Model 
Explorer

2 Right-click the Terrain folder and choose Create 
New Surface from the shortcut menu.

Creating a New Surface

3 Open the new surface folder to display the icons. 

4 Add the data to be included in the surface. This data can 
be points, DEM files, contours, boundaries, or breaklines. 
To add a point group to the surface, right-click the Point 
Groups icon and select the point group.

To add contour data to the surface, Right-click the 
Contours icon and generate the contour data.

Creating Surface Data and 
Adding It to the Surface 
Folders
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5 After you add all the surface data, Right-click the surface 
name and choose Build Surface from the shortcut menu 
to display the Build Surface dialog box. 

Building a Surface

6 Type a description for the surface.

7 Choose the surface data to use in the surface by 
modifying the Surface Data Options. You can also choose 
to build the watershed model, calculate extended 
statistics, and create an error file when building the 
surface.

8 Click OK to build the surface. A message box is displayed 
when the surface has been built. Click OK to continue.

To build a surface (continued)

Steps Use  to locate
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Building a Watershed Model

You can build a watershed model of the current surface either while building 
the surface or after building the surface. The program uses the surface TIN 
lines to calculate where water would flow along the surface. 

You can then determine the watershed subareas, also known as catchment 
areas or regions. You can import boundaries into the drawing to delineate and 
number the watershed subareas, and you can determine the color of each 
type of watershed boundary by changing the color of the layer that the 
polyline boundary is assigned to.

After you build the watershed model, you can draw slope arrows to show the 
surface slopes, and use the Waterdrop command to draw polyline 
representations of the path that water would flow along the surface toward 
channels, as shown in the following illustration. If the channel splits, then 
new polylines are drawn to follow each water drop path.

Watershed subareas can have different types of drain targets. Drain targets of 
some subareas can be based on a boundary point, the point where water 
would drain off the surface. Drain targets of other subareas can be depression 
areas where the water flows. 

 Watershed

 Water Drop
 the Current
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Key Concepts

� If the Watershed command determines that water from one TIN surface 
triangle could flow into more than one watershed subarea, then it splits 
the TIN triangle to make two triangles. This ensures that each watershed 
consists of complete triangles, and that the boundary of each watershed 
consists solely of TIN edges. 

� If you use contour data to build the surface, then be sure to select the 
Minimize Flat Triangles Resulting from Contour Data option in the Build 
Surface dialog box to minimize the number of flat triangles that make up 
the TIN surface.   

To build a watershed model

Steps Use  to locate

1 From the Terrain menu, choose Terrain Model Explorer to 
display the Terrain Model Explorer dialog box.

Create and build a surface model, if one does not exist.

Building a Surface

2 Click the plus sign (+) next to the surface name to display 
the surface data icons.

3 Right-click the Watershed icon and choose 
Calculate Watershed from the shortcut menu.

Creating Watershed Models

4 Set the watershed model options. You can specify a 
minimum depression and minimum area that a 
depression must have in order to be included in 
the model. 

5 Click OK to calculate the watershed.
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6 Right-click the Watershed icon and choose Import 
Watershed Boundaries from the shortcut menu to display 
the Watershed Display Settings dialog box.

Importing the Watershed 
Boundaries into the 
Drawing

7 Select the options in the upper part of the dialog box to 
control the appearance of the watershed boundaries that 
are imported. 

Select the Fill With Solids check box to import solid fill 
areas, or clear the check box to import polyline 
boundaries. 

When you import polyline boundaries, you can also select 
the Display ID Numbers check box to insert the 
watershed ID numbers within the polyline boundaries.

Watershed Display Settings 
Dialog Box

8 Select options for layers, and click OK to draw the 
boundaries on the surface.

TIP Set each layer to a different color after using this 
command so you can easily distinguish what type of 
watershed is outlined.

9 To show how a drop of water would flow across the 
surface, you can trace that path in the drawing by 
choosing Water Drop from the Terrain ➤ Surface Utilities 
menu. 

Select a point on the surface, and the Water Drop 
command draws a polyline that represents the path that 
water would take as it flows from that point toward the 
drain target.

Drawing Water Drop Paths 
on the Current Surface 

To build a watershed model (continued)

Steps Use  to locate
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Creating Finished Ground Data for Surfaces

Autodesk Land Desktop has many commands that you can use for creating 
finished ground data to use for surfaces. The following table summarizes a 
few of the point, 3D polyline, and contour grading methods you can use for 
creating finished ground surface data.

When you are ready to create the surface based on this grading data, you 
must add the surface data to the surface folder in Terrain Model Explorer. The 
following table shows how to process each type of grading data.

Methods for creating finished ground surface data

Point Grading 3D Polyline Grading Contour Grading

Create points at the vertices 
of a 3D polyline

Create 3D polylines by 
specifying an elevation or a 
slope

Create contours along a 
proposed slope or grade

Create points where two 
slopes or grades intersect

Fillet 3D polylines Create multiple offsets of a 
contour at a specified 
interval and grade until a 
specified distance or 
elevation is reached

Interpolate points between 
two selected points, based 
on total distance

Offset existing polylines in 
the drawing and apply 
elevational changes to the 
offset polylines

Copy existing contours 
that you can update with 
new grading data

Processing different types of surface data

Object How to process as surface data

2D Polylines Select as contours

3D Polylines Select as breaklines or as contours

Points Select as points or point groups
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Editing Surfaces

After building a surface, you should evaluate its accuracy. Did the TIN lines 
generate as expected? If not, you can go back and define new surface data like 
points, breaklines, and boundaries. Or, if the changes are small, you can edit 
the surface TIN directly. 

For example, you can

� Flip the faces of triangles to match ridges or depression areas.
� Add TIN lines to force retriangulation.
� Delete TIN lines that extend beyond survey boundaries.
� Add, delete, move, and edit points.
� Add breaklines.
� Paste surfaces together.
� Change the overall elevation of the surface by an increment.

For example, you can add a TIN line, which forces the other TIN lines that it 
crosses to retriangulate. You can add points to a surface, which also forces the 
surface to retriangulate. You can also trim out surface TIN lines that are 
drawn across a building pad or pond. The following illustration is an example 
of flipping TIN faces.

To combine two or more surfaces into one surface, paste them together. For 
example, you can create a surface that represents only part of a site, such as 
a surface that contains the grading data for a building pad. After you build 
this surface, you can paste it into the existing ground surface to create a fin-
ished ground surface that represents the entire site. 

The surface TIN lines must be in the drawing in order for you to use the Edit 
Surface commands. Use the Import 3D Lines command from the Edit 
Surface menu to import surface lines you can edit. Be sure to set the surface 
you are working with as current. Only the data for the current surface is 
used when editing.

urfaces
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Edit History

Whenever you rebuild a surface, you must reapply the edits that you made 
to it. To save time, all edits that you make to a surface are saved in the Edit 
History folder in the Terrain Model Explorer.

The Edit History folder stores all the edits that you make to a surface so you 
can automatically repeat them when you rebuild the surface later. 

You can open the Edit History folder to view the edits you have made to a 
surface, as shown in the following illustration.

When you select the Apply Edit History check box as you rebuild the surface, 
all previous edits are repeated in the order that you made them. You can also 
change the edit history list. To not repeat a step in the edit history, delete the 
item from the list. 

Working with Surface Output and 
Visualization Tools

After you build a surface, you can use many different methods to output, 
display, and visualize the surface. For example, you can 

� Label slopes.
� Generate contours for the surface.
� View cross sections and profiles of the surface.
� Output volumes.
� Create a 3D rendering of the surface for presentation.
� Create a slope-defined model that shows areas color-coded by slope range, 

indicating unbuildable land because of excessive slope.
� Create a model showing elevational banding of flood plain lines.
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Viewing Surface Statistics

Statistics for each surface are visible by clicking the surface name icon in the 
left pane of the Terrain Model Explorer. 

The following illustration shows the statistics for a surface, including the 
Extended Statistics.

In the Surface Data section of the statistics, each data type displays the num-
ber of points added to the surface. For example, in the previous illustration, 
1701 points were added to the surface from a point group, and 431 points 
were added from contours.

Dynamically Viewing Elevational Characteristics 
of a Surface

When a surface is open, it is added into memory. You can retrieve elevational 
information as you move the pointing device across the surface. This is an 
excellent way to analyze surface characteristics without actually drafting 
objects into the drawing. 

tatistics
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Key Concepts 

� The surface does not need to be drafted in the drawing to obtain eleva-
tional information from it.

� Make sure that the proper surface is set as current.
� The elevation values are displayed in the status bar at the bottom of the 

screen.

Viewing Quick Sections of a Surface

To examine the elevational characteristics of a surface along a line, arc, or 
polyline, you can create quick section views. You can use these sections to 
review the elevational relief of the site and to determine whether modifica-
tions are required.

To create quick sections, select an existing object in the drawing, then 
right-click and select View Section from the shortcut menu. You can create 
section views from lines, curves, 2D and 3D polylines (including arc seg-
ments), spline fit polylines, and circles. 

The section is displayed in a separate window. From this section window, you 
can control properties that affect the appearance of the section, such as grid 
settings, vertical exaggeration, and surface colors. 

To dynamically display surface elevations

Steps Use  to locate

1 From the Terrain menu, choose Set Current Surface to 
make the surface model current.

Making a Surface Current

2 From the Inquiry menu, choose Track Elevations. Tracking Elevations

3 As you move the pointing device to a point, the elevation 
at that point on the surface is displayed on the status bar.

Tracking Northing and 
Easting Coordinates

 Quick Surface 
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Support for Multiple Surfaces
If multiple surfaces are turned on, the section view is created from the 
currently selected multiple surfaces. Use the Multiple Surfaces On/Off and 
Define Multiple Surfaces commands on the Terrain ➤ Sections menu to 
control the use of multiple surfaces. 

Key Concepts

� If you grip edit the object from which you created the section view, the 
quick section views are dynamically updated. If you edit the surface, 
then you can update the section views using the Update Section Views 
command from the Terrain ➤ Sections menu.

� You can display more than one quick section at a time. Each section view 
is initially displayed at the same location on screen. You can move the 
windows to see multiple sections at once.

� You can copy quick sections to the clipboard or save them as Windows 
metafiles and then paste or insert them into the drawing.

� You can also use a separate group of commands on the Terrain ➤ Sections 
menu to plot straight-line sections in a drawing. These commands are 
Define Sections, Process Sections, and Import Sections.

To view a quick surface section

Steps Use  to locate

1 Select the current surface. Making a Surface Current

2 Draw an object, such as a polyline, from which to create 
the quick section.

3 Select the object, right-click, and choose View Quick  
Section.

NOTE You can also choose Sections ➤ View Quick 
Section from the Terrain menu to access this command.

Creating Quick Surface 
Sections

4 To modify the view in the section window, you can grip 
edit or move the object in the drawing. The section in the 
window is updated automatically.

Grip Editing Quick Section 
Lines
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Creating Contours

Contours portray the elevational values of a surface at specified intervals, as 
shown in the following illustration.

You can use Autodesk Land Desktop to create existing ground or finished 
ground contours. To create contours, you can   

NOTE You can use contours to represent features other than elevations. 
For example, contours can represent rainfall intensity, soil contamination lines, 
and so on.

Creating Contours from a Surface

As you create contours from a surface, use a contour style that controls how 
the contour and contour labels display. For example, a contour style controls

� smoothing.
� grip display (for editing contours and contour labels).
� label text style.
� label position.

� Generate contours from the current 
surface model.

� Convert polylines to contours.

� Vectorize contours on a raster image. � Digitize a paper contour map.

� Copy contours. � Offset contours.
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When you create contours, you must choose a style. You can also specify 
elevation ranges, contour intervals, and whether to create the contours as 
AEC contour objects or polylines. All contour definition, editing, and label-
ing commands work on both contour objects and polylines. 

NOTE To edit AEC contour objects in another AutoCAD program (other than 
Autodesk Land Desktop), you must explode the contour objects because they 
are custom objects. Or, you can install the Object Enabler, which is available on 
the Autodesk Land Desktop CD-ROM.

When you create contours from a surface, you base the contours on a 
contour style. Use the Contour Style Manager to define and modify 
contour styles.

Key Concepts

� Contour styles store groups of settings in the drawing so you can use them 
again without having to respecify the settings you want to use. 

� Choose a contour style when you run the Create Contours command 
from the Terrain menu.

� You can use the Manage Styles tab to save contour styles to an external file 
and also to add contour styles from an external file. This is helpful when 
you use the same contour styles in more than one drawing or in different 
projects.

� You can click inside the Preview window on the Contour Style Manager 
and adjust the view angle of the previewed contours by moving the 
pointing device.
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To create contours from a surface

Steps Use  to locate

1 From the Terrain menu, choose Create Contours to 
display the Create Contours dialog box.

Creating Contours from a 
Surface

2 Select the surface from which you can create contours. By 
default, the current surface is displayed in the Surface box.

3 Specify the elevation range.

4 Specify the vertical scale. 

5 Specify the minor and major contour intervals.

6 Under Properties, choose either contour objects or 
polylines.

7 To create contour objects, under Properties, click Style 
Manager to display the Contour Style Manager dialog 
box.

Managing Contour Styles

Using the Contour Styles 
Manager 
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Using a Surface Boundary to Contour Around a 
Building or Pond

Usually you do not draft contours inside a building foundation or 
water-filled pond. One way to prevent contours from being drafted within 
these features is to trim everything within the feature by deleting the surface 
lines in these areas.

Another method is to hide portions of the surface model using a surface 
boundary. By hiding certain areas, you can prevent the areas from being con-
toured. When you create an internal boundary, the surface faces remain 
intact. They are hidden only until you remove the boundary. 

Key Concepts 

� No elevational information for the surface is available while an area is 
hidden by a boundary.

� Depending on how well the surface follows the boundary polygon, you 
may want to make the surface boundary act as a non-destructive 
breakline.

8 Use the Contour Style Manager dialog box to smooth 
contours, and to specify the contour appearance, the text 
style for contour labels, and the label position. You can 
also use this dialog box to save contour styles and add 
styles from other drawings. 

9 Click OK to return to the Contour Style Manager dialog 
box, and then click OK to generate the contours. 

10 You can label the contours using the commands in the 
Terrain ➤ Contour Labels menu. 

Labeling Contours

To create contours from a surface (continued)

Steps Use  to locate
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To contour around a pond by using a surface boundary

Steps Use  to locate

1 Select the current surface. Making a Surface Current

2 If the pond that you define as a boundary is not outlined 
by a polyline, then use the PLINE command to draw the 
boundary.

Pline Command

3 From the Terrain menu, choose Edit Surface ➤ Surface 
Boundaries. 

Defining Surface Boundaries 
After Building a Surface

4 Type Add to add a boundary, press ENTER, and then type 
No to not remove any existing boundaries.

5 Select the polyline boundary. 

6 You can specify that anything inside the polyline is hidden 
(Hide) or shown (Show). For this example, specify Hide to 
hide the area inside the pond polyline.

7 You are prompted whether to create breaklines along the 
edges. 

If you type Yes, a non-destructive breakline is created 
around the polygon boundary area. 

8 Press ENTER at the Select polyline for boundary prompt to 
end the command.

The vertices on the boundary are added to the 
triangulation. The elevations for the breakline are 
retrieved from the surface model.

9 Type Yes to redraw the surface so you can review the 
surface edits.

10 Use the Create Contours command from the Terrain 
menu to create contours from the surface. As the contours 
are generated, you can see that they are not drafted 
within the polygonal boundary.

Creating Contours From a 
Surface
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Comparing Two Surfaces to Calculate Volumes

You can calculate volumes or depths between surfaces by comparing them. 
For example, you may want to compare existing ground surface data with 
as-built data. Or, if you have borehole data, then you may want to calculate 
the volumes between the top surface and rock.

Autodesk Land Desktop includes three volume calculation methods: 

� Grid method: Creates a volume surface that is based on a grid that com-
pares elevational information between the first and second surface. 

� Composite method: Creates a volume surface that includes all the surface 
points from the first and second surface. The Z values in the new surface 
are the elevational difference between the first and second surface. 

� Section method: Calculates volumes based on sampled cross sections. 

You can also calculate parcel volumes, which are based on parcels that exist 
within the larger site. 

In all cases, you need two surface models. From the two surfaces, you must 
define a stratum, which specifies the two surfaces used in volume 
calculations. Before you can calculate volumes, you must define a site that 
represents the stratum area for which you want to calculate volumes.

Key Concepts 

� The volume results are only as good as the surface definitions. The more 
complete the surface data, the better the volume calculations.

� The grid method offers a quick volume result. Because it is a grid, however, 
you can potentially miss surface irregularities, such as a curb or 
depressions, which would affect the volume results. This method creates 
a volume surface that you can view and manage from the Terrain Model 
Explorer.

� The composite method uses all the data from the first and second surfaces. 
This method creates a volume surface, and the results are the exact surface 
difference total. This method creates a volume surface that you can view 
and manage from the Terrain Model Explorer.

� The section method interpolates cross sections from the two surfaces of 
the current stratum, and generates volumes using one of two 
methods: Prismoidal or Average End Area. This gives you sections that 
you can plot to verify areas and submittals. This method does not create a 
volume surface.

alculation

rch Help for…
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To calculate volumes

Steps Use  to locate

1 Define at least two surfaces, such as existing ground and 
proposed ground.

Building a Surface 

2 From the Terrain menu, choose Select Current Stratum to 
create a stratum that defines the two surfaces that you 
compare.

Defining a Stratum

3 From the Terrain menu choose Site Definition ➤ Define 
Site to define the site area. 

A site is essentially a rectangular area in which all volume 
calculations are performed. It also defines the grid size 
that is used when creating a grid surface. 

Defining a Site for Volume 
Calculations

4 To calculate volumes using the section method, select 
Terrain ➤ Section Volumes ➤ Sample Sections to generate 
the cross section data.

Sampling Section Data for 
Volume Calculations

5 Calculate cut/fill volumes for the site. Volumes are 
calculated based on the method that you choose.

� To use the grid method, select Terrain ➤ Grid 
Volumes ➤ Calculate Total Site Volume. 

� To use the composite method, select 
Terrain ➤ Composite Volumes ➤ Calculate Total 
Site Volume. 

� To use the section method, select Terrain ➤ Section 
Volumes ➤ Calculate Volume Total. 

Calculating Total Site 
Volumes Using the Grid 
Method

Calculating Total Site 
Volumes Using the 
Composite Method

Calculating Total Site 
Volumes Using the Section 
Method
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Presenting Cut/Fill Results

You can create presentation graphics to help highlight cut/fill areas in a site. 
When you use the composite or grid surface volume calculation methods to 
calculate the volumes between two surfaces, a volume surface is made. This 
surface is the difference between the two surfaces, which you can use to 
demonstrate the cut/fill areas. 

6 You can create volume reports, print the results, or include 
them in a table in the drawing by using commands from 
the Terrain ➤ Volume Reports menu, as shown in the 
following illustration.

Creating a Total Volume 
Table for a Site

7 If you used the section volume calculation methods, then 
you can plot the cross sections in the drawing by selecting 
Terrain ➤ Section Volumes ➤ Plot Single.

Plotting a Single Volume 
Section

To calculate volumes (continued)

Steps Use  to locate

 Grid Method

 Composite
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Key Concepts

� You can view and manage volume surfaces from within the Terrain Model 
Explorer.

� You can view a grid of ticks and labels that indicate the cut/fill depth 
throughout the site.

� You can create a range map that displays the cut areas in one color and the 
fill areas in another.

� You can create cut/fill contours on a volume surface. The volume surface 
Z value is the cut/fill depth instead of an elevational value.

Creating a 3D Map to Present 
Elevation Conditions

After you create a surface, you can use several tools to help you view the 
surface in three dimensions. For example, you can use various elevation and 
slope commands from the Terrain ➤ Surface Display menu to insert 3D faces 
into the drawing. These commands place surface triangles that fall within a 
defined elevation or slope range onto specific layers. You can then make each 
layer a different color. For example, you can place portions of the site that fall 
within a 100’ to 105’ elevation range on a blue layer to distinguish the 
elevation range.

Key Concepts

� You can draw the range view as 2D solids or 3D faces, and you can view 
the faces in plan or 3D perspective.

� You can use banding methods, which automatically splits surface triangles 
to properly match the range that you define. In other words, if you 

To present volumes results

Steps Use  to locate

1 Select the volume surface as the current surface. Making a Surface Current

2 From the Terrain menu, choose Create Contours to create 
cut/fill contours.

Creating Contours from a 
Surface

3 If you used the grid method to calculate volumes, then 
select Terrain ➤ Grid Volumes ➤ Grid Volume Ticks to 
draw grid ticks that display the elevation difference 
between existing and proposed ground.

Creating a Grid of Ticks 
That Show Cut and Fill 
Areas on Volume Surfaces

 3D Faces Using
ing Method

g the Surface
ased on
 Ranges
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created the triangle between points that range from 90'–120', then the 
program would break this into individual faces at 90', 100', 110', and 
120'. This ensures that the elevational banding is properly presented. 
This does not modify the surface, but it breaks the plotted faces to match 
the elevational criteria.

Projecting 2D Lines onto a 3D Grid 

You can project 2D objects such as lines, curves, and polylines from a flat 
drawing plane onto a 3D surface grid. This is an effective way to present 
information such as a road location, building outline, or property boundary.

Key Concepts 

� You can project lines, curves, and polylines onto the grid.
� The objects are drawn on a separate layer.
� For a smoother site, set the number of “facets” per grid face to a higher 

number.
� If the site contains details such as walls or curbs, you should use the 

3D Faces command on the Terrain ➤ Surface Display menu. This option 
imports all the surface triangles as 3D faces. All surface details show up on 
the imported faces.

To create an elevational range view

Steps Use  to locate

1 Select the current surface. Making a Surface Current

2 From the Terrain menu, choose Surface 
Display ➤ Elevation Settings to define the elevational 
ranges, layers, and layer colors.

Where there is minimal elevational exaggeration, you can 
also define vertical scaling to help see site features.

Changing the Surface 
Elevation Shading Settings

3 Generate the range view by selecting an elevational range 
view command. From the Terrain menu, choose Surface 
Display ➤ Average - 3D Faces or Banding - 3D Faces.

Creating 2D Solids Using 
the Banding Method

Creating 3D Faces Using 
the Banding Method 

4 To manage the layers on which you created the range 
views, select Terrain ➤ Terrain Layers ➤ Range Layers.

Managing the Range Layers
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To project objects onto a grid

Steps Use  to locate

1 Select the current surface. Making a Surface Current

2 Make sure you are working in plan view. Change to a View of the XY 
Plane

3 From the Terrain menu, choose Surface Display ➤ Grid of 
3D Faces to create a grid of 3D faces. You have complete 
control over grid location, size, vertical exaggeration, and 
facets per grid face.

Creating a Surface Grid of 
3D Faces

4 Select all lines, curves, and polylines to be projected, and 
then specify a layer to draw them on.

5 To view the site in 3D, you can use either the DVIEW or 
VPOINT command, or you can use the Object Viewer 
from the Utilities menu.

Using the Object Viewer
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7
Working with 
Alignments and Parcels
In this chapter

� Working with alignments

� Working with parcels
Creating alignments and parcels with Autodesk Land 

Desktop is a two-step process. First, you create the 

geometry, such as the roadway centerlines and parcel 

boundaries, and then you define the geometry as 

alignments and parcels.
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Introduction

You can draft horizontal alignments and parcels at any time during the 
project process. You can begin by drawing objects, such as lines, curves, 
spirals, or polylines, to represent the geometry of an alignment or parcel. 
Then, you can define an alignment or parcel to a database. All data is stored 
in an external database and all drawings in a project can access that data. 

Because of the external database, you do not need to draft alignments or 
parcels in a drawing to reference them. After you define objects, you can 
delete them from the drawing. Then, if you must visually reference 
alignments or parcels, you can import them into the drawing.

Working with Alignments

The plan view of roadway geometry is called a horizontal alignment. For align-
ments, you can define roadway centerlines and create offsets that represent 
lanes, shoulders, and rights-of-way. You can create station labels along an 
alignment, and generate stakeout reports for surveyors.

Because alignment definitions are stored in a database outside the drawing, 
you have the following added flexibility when managing alignments:

� If other projects contain alignments that you want to include in a current 
project, then you can merge alignment databases and import alignments 
into a drawing.

� If someone on a network needs write access to the alignment you have set 
as current, then you can close the alignment database or select a different 
current alignment while you keep a drawing open.

� It is not necessary to keep alignment objects in a drawing. You can delete 
them and import the alignments only when needed.

You can edit the data in the alignment database by using the Alignment 
Editor. Any changes that you make to an alignment in the Alignment Editor 
are updated in the drawing. The Alignment Editor can also generate reports.

Autodesk® Civil Design provides advanced roadway design capabilities, such 
as profile and cross section design. For more information about Autodesk 
Civil Design, contact your authorized Autodesk dealer.

al Alignments

zontal Alignment
e
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Multi-User Alignment Database

The alignment database can be accessed by multiple people working over a 
network. Locking works on a per-alignment basis. To release the lock on an 
alignment, you can set a different alignment current or you can close the 
Alignment database. 

To share an alignment database with someone using Release 1 of AutoCAD 
Land Development Desktop, you can save the alignment database in the 
previous format of the alignment database as a project.adb file. Choose the 
Save as .adb command from the Alignments ➤ Alignment Commands menu. 

Drawing Alignment Geometry

Begin an alignment design by drawing alignment geometry. You need to 
draw an alignment centerline only—you can create offsets later by using an 
automated offset routine. To draw an alignment centerline, you can use line, 
arc, and spiral commands from the Lines/Curves menu, as well as AutoCAD 
commands such as ARC, LINE, PLINE, and FILLET. You can also draw align-
ments as Autodesk Survey Figures either in the field using the Autodesk 
Survey Command Language to input the data in a data collector, or on the 
Autodesk®  Survey command line.

When you draw the alignment, use object snaps to ensure that no gaps exist 
between each object that makes up an alignment.

To create spirals, use the Spiral commands from the Lines/Curves menu. If 
you know the intended speed for an alignment, then you can draw spirals 
using an AASHTO or user-defined speed table, which automatically calcu-
lates superelevation information for an alignment.

Key Concepts

� If you use the Lines/Curves menu commands instead of PLINE or LINE, 
then the lines, curves, and spirals are drawn tangent to their adjacent 
object.

� You can define more than one alignment from the same alignment 
geometry.
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Defining an Object as a Road Alignment

By defining figure geometry as an alignment, all individual geometric com-
ponents (lines, arcs, and spirals) become linked as a single object, and align-
ment data is saved to the database in the project folder.

When you store this data in an external database, you can access the align-
ments from all drawings in the project. After you define an alignment, it is 
not necessary to draft the alignment in a drawing. All commands that refer 
to the alignment geometry reference the database.

When you define an alignment, point data is not added to the point 
database. However, you can place points along the alignment using the 

To create alignment geometry

Steps Use  to locate

1 Create a layer on which the alignment centerline is to be 
drawn. Use a name such as “CL” for Centerline.

Create and Name Layers

2 Use one of the line drawing options from the 
Lines/Curves menu.

Drawing Lines

3 To add curves, use the curve commands from the 
Lines/Curves menu. 

You can add a curve between two tangents, from the 
end of a tangent, and more. These options ensure that 
the curve is drawn tangent to the selected lines.

Drawing Curves

4 To draw a spiral, use one of the spiral commands from 
the Lines/Curves menu.

Drawing Spirals
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Create Points - Alignments commands from the Points menu, as shown in 
the following illustration.   

  

Making an Alignment Current

When you work with alignments, make sure that the correct alignment is 
current. Alignment commands work only with a current alignment, and only 
one alignment can be current at a time. When you define an alignment, it 
becomes the current alignment automatically.

To define an alignment

Steps Use  to locate

1 Draw the alignment geometry. Defining Alignments

2 If you drew an alignment geometry using lines, curves, 
and spirals, then select Define From Objects from the 
Alignments menu to define the alignment.

If you drew an alignment using a polyline, then select 
Define From Polyline from the Alignments menu.

When you define the alignment, you are prompted for 
essential information such as the alignment name, 
description, starting station, and objects that comprise 
the alignment.

Defining an Alignment 
from Objects

Defining an Alignment 
from a Polyline
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You can select the current alignment either from a drawing, from the 
Alignment Librarian, or by alignment number. 

To display the Alignment Librarian, as shown in the following illustration, 
choose Set Current Alignment from the Alignments menu and when you are 
prompted to select an alignment, press ENTER.

Key Concepts

� When you make an alignment current, a lock file is created for the align-
ment so no one else can obtain write access to that alignment.

� You can view the alignment locks by using the Project Manager command 
from the Projects menu. Click File Locks to view the project locks.

� To release a lock on the current alignment, you can either make a different 
alignment current or you can use the Close Database command from the 
Alignments ➤ Alignment Commands menu to close the database and 
release the lock. 
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Editing a Road Alignment

To edit an alignment, you can either modify the geometry and redefine the 
alignment, or you can modify the alignment data from within the 
Horizontal Alignment Editor.

To make an alignment current

Steps Use  to locate

1 From the Alignments menu, choose Set 
Current Alignment.

The cursor turns into a pickbox.

Making an Alignment 
Current

2 Select the alignment using one of the following 
methods:

� If the alignment is drafted in the drawing, then click 
the alignment with the pickbox.

� When prompted to select an alignment, press ENTER, 
and then select the alignment from the Alignment 
Librarian.

� When prompted to select an alignment, press ENTER. 
Click Cancel to close the Alignment Librarian, and 
then type the number of the alignment to make it 
current.
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Use the Horizontal Alignment Editor to modify individual curve, tangent, 
and spiral geometry, and to generate reports based on the alignment. After 
you save the changes, drawing objects are automatically updated, so you do 
not need to redefine the alignment geometry.

Key Concepts

� The Horizontal Alignment Editor is linked dynamically to the drawing. 
Changes that you make in the Editor update the alignment automatically 
in the drawing.

� You can use the Horizontal Alignment Editor to modify PIs (Points of 
Intersection) and alignment curves and spirals.

� The editor is similar to a spreadsheet. You must select inside the cell that 
you want to modify.

� To change the alignment properties, such as the alignment layer, color, 
linetype, or description, use the Modify Properties command from the 
Alignments ➤ Alignment Commands menu.    

To edit a road alignment

Steps Use  to locate

1 Select the current alignment. Making an Alignment 
Current

2 From the Alignments menu, choose Edit to display the 
Horizontal Alignment Editor dialog box.

Editing Horizontal 
Alignments

3 To edit a curve, place the cursor in a cell at a curve point 
of intersection (PI), and then click Edit Curve.

Editing a Horizontal 
Alignment Curve

4 To edit a spiral, place the cursor in a cell at a spiral point 
of intersection, and then click Edit Spiral.

Editing a Horizontal 
Alignment Spiral

5 After you have finished editing, click OK to save all 
changes in the database and update the graphics.
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Deleting and Importing Alignments

If you do not want to view an alignment in a drawing, then you can do the 
following:

� Turn off or freeze the layer that the alignment is on.
� Erase the alignment using the ERASE command.
� Use the Delete command from the Alignments menu.

Erasing the alignment does not remove the alignment database definition. 
To redisplay the alignment in the drawing, import the alignment.

You can use the Delete command to delete the alignment from only the 
drawing (similar to the ERASE command) or to delete the alignment from 
both the drawing and database. Select that data to delete on the command 
line. If you delete the alignment from only the drawing, then you can use 
the Import command from the Alignments menu to re-import it into the 
drawing.

If you delete the alignment from the database, then you can redefine the 
alignment from the drawing objects, if necessary. If you delete the alignment 
from both the drawing and the database, then you cannot restore the 
alignment.

Use the Import command to bring a defined alignment into a drawing; for 
example, when you want to bring project alignments into a new drawing in 
a project. You can also use the Import command to bring alignments into the 
drawing after you have merged alignments from another project into the 
current project’s alignment database.

To delete or import multiple alignments at a time, then use the Multiple 
Selections command from the Alignments ➤ Alignment Commands menu.       

g and Deleting 
ts

 Alignments from 
 Projects
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To delete multiple alignments from the drawing

Steps Use  to locate

1 From the Alignments menu, choose Alignment 
Commands ➤ Multiple Selections to display the 
Multiple Alignments Librarian.

Importing or Deleting 
Multiple Alignments 
Simultaneously

2 Select the alignments that you want to delete. 

3 Select one or more Delete Options. You can delete the 
alignment from the screen, the database, or both. 

You can also delete any vertical files that are associated 
with the alignment. These are the alignment profile and 
cross section files that are created with Autodesk Civil 
Design.

Deleting Multiple 
Horizontal Alignments

4 Click Delete to delete the selected alignments. A 
confirmation dialog box is displayed. Click Yes to 
confirm the deletion.

5 If you want to set an alignment current before you close 
the Multiple Selections dialog box, then select the 
alignment name you want to set as current, and then 
click Select.
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Drafting Road Results

As you create a base map, you can complete a final drafting of an alignment 
by adding roadway offsets, roadway stationing, and station and offset spot 
labels.

You can also use the Autodesk Map commands to create a network topology 
of the alignments from which you can calculate the shortest paths to 
destinations, or show graphically the traffic volumes that travel along each 
alignment.

Key Concepts

� All annotation is based on the current alignment in the database.
� To station or create offsets for an alignment, it must be defined to the 

database.

To draft road results

Steps Use  to locate

1 Select the current alignment. Making an Alignment 
Current

2 From the Alignments menu, choose Create Offsets to 
display the Alignments Offset Settings dialog box.

Creating Offsets for an 
Alignment
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3 Select the offsets that you want to create, and then enter 
names for them.

4 To define the offsets to the Horizontal Alignment 
Database, select the Define Offset Alignments check 
box.

5 Click OK to create the offsets.

6 From the Alignments menu, choose Station Display 
Format.

Changing the Station 
Display Format

7 Select the station format options, and click OK.

To draft road results (continued)

Steps Use  to locate
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8 From the Alignments menu, choose Station Label 
Settings to change the station label settings.

Changing the Alignment 
Station Label Settings

9 From the Alignments menu, choose Create Station 
Labels to create station labels. The labels are displayed 
as shown in the following illustration.

Creating Station Labels 
on an Alignment

To draft road results (continued)

Steps Use  to locate
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Working with Parcels

When you create base maps or work with subdivisions, you must define 
parcels of land. You can define parcels from survey figures, points, lines, 
curves, or polylines. Parcel boundaries define the area and the limits of each 
parcel. If you define parcels by area, then you can use the Parcel Sizing 
commands to create parcels of exact areas.

Like alignments, parcel definitions are stored in an external database so mul-
tiple people can access them. Because parcel definitions are stored externally, 
you can delete the geometry in the drawing and still reference the parcel. 

When defining parcels, you can label them with a parcel number, area, and 
description. To manage parcels, use the Parcel Manager command from the 
Parcels menu. You can use this command to report map check and inverse 
data, as well as to import, delete, and rename parcels. 

After you define a parcel, you can calculate its earthwork volumes using the 
grid and composite volume methods. For more information about earth-
work, see “Comparing Two Surfaces to Calculate Volumes” on page 185.

You can use the Autodesk Map commands to create a database of parcel 
numbers, owners, cost, and so on to help manage parcel maps. 

Drawing Parcel Geometry

To draw the parcel boundaries, you can use the commands from the 
Lines/Curves menu, or other AutoCAD commands such as LINE or PLINE. 
You can also define parcel boundaries from points.

NOTE Do not use spirals in parcel boundaries. Spirals cause incorrect areas to 
be reported.

You can also use Autodesk® Survey to draw parcel boundaries as Autodesk 
Survey Figures. You can use the Autodesk Survey Command Language to 
input the data in a data collector, or you can input the data using the 
Autodesk Survey command line.

NOTE Be sure to draw the parcels as closed regions. If any of the joining lines 
has a break, then you cannot calculate areas.

with Parcels

 Parcels
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If you use polylines to draw parcel geometry, then you must break crossing 
polylines before defining the parcels. Also, delete any duplicate lines that you 
may have drawn where two parcels abut each other. You can break crossing 
lines and erase duplicate lines by using the Autodesk Map Cleanup 
command. 

Draw Parcel Geometry Based on Area
To draw a parcel as an exact area, use the Parcel Sizing commands. Draw the 
parcel with only one open segment, and then use one of the Parcel Sizing 
commands to close the segment. Parcel Sizing commands include Slide 
Bearing, Radial, Swing on Line, and Swing on Curve.

The following illustration shows how a parcel is defined by using the Slide 
Bearing command.

Depending on the parcel settings, these commands can define the parcel to 
the parcel database, and they can also label the parcel that is calculated.

You cannot use the Parcel Sizing commands to modify a parcel that is already 
defined to the parcel database. To change a parcel definition, you must delete 
the existing parcel definition and redefine the parcel. For more information 
about deleting parcels, see “Managing Parcels” on page 207.

Defining Parcels to the Parcel Database

As with alignments, you must define parcels to the parcel database so that 
the individual geometric component points, lines, arcs, or polylines, 
become linked as a single object. This parcel data is stored in a database in 
the project folder.

rcels to a 
 Area

rch Help for…
Working with Parcels | 205



When you define parcels to the database, you can label them and perform 
map check calculations on them, depending on what you specify in Parcel 
Settings.

To define parcels to the parcel database

Steps Use  to locate

1 Draw a parcel using the PLINE command. Drawing Parcels

2 From the Parcels menu, choose Parcel Settings to display 
the Parcel Settings dialog box.

Changing the Parcel 
Settings

3 Under Options, select the Label Parcels as Defined and 
the Automatic Label Placement check boxes.

4 Under Parcel Numbering, select the Sequential On 
check box to number the parcels sequentially.

If you clear this check box, then you are prompted for 
the parcel number each time you define a parcel. You 
can use alpha-numeric characters for parcel numbers.

5 Under Parcel Numbering, select the Labels On check 
box to label each parcel with its number.
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Managing Parcels

You can use the Parcel Manager to

� Import, delete, and rename parcels.
� Report area, inverse, and map check information.

To access the Parcel Manager, shown in the following illustration, choose 
Parcel Manager from the Parcels menu.

6 Under Square Feet/Meters Labeling, select the Labels 
On check box to label each parcel with its area.

7 Click OK.

8 From the Parcels menu, choose Define from Polylines. Defining a Parcel from a 
Polyline

9 Select the polyline that represents the parcel. The parcel 
is then defined to the parcel database. 

To define parcels to the parcel database (continued)

Steps Use  to locate

g Parcel Lines
ls

Parcels

g Parcels
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Key Concepts

� Use the Rename option to assign alpha-numeric names to the parcels.
� Use the Import option to import parcels into a drawing if you have erased 

the parcel lines or if you want the parcels to be visible in a different project 
drawing. Erasing the parcels with the ERASE command does not remove 
the parcel database definitions. To redisplay the parcels in the drawing, 
import them with the Parcel Manager.

� Use the Delete option to permanently delete the parcels. This option 
deletes the parcel from the parcel database.

� You can report parcel information such as area, perimeter, map check, and 
inverse results. After you review the results, you can either print them or 
save them to a text file for final reports.

� If you created a parcel definition from an Autodesk Survey figure, then 
you can report additional data about the parcels by using the Autodesk 
Survey figure display, inverse, map check, and perimeter closure 
commands.    

To report parcel areas

Steps Use  to locate

1 Define the parcel to the parcel database. Defining Parcels

2 From the Parcels menu, choose Parcel Manager to 
display the Parcel Manager dialog box.

Managing Parcels

3 In the Select Parcel list, select one or more parcels about 
which you want to report information. 

When you select a parcel, it is marked with an asterisk. 
In the following illustration, parcels lot1 and lot2 are 
selected.

4 Click Output Settings and select the report options, such 
as the report name and destination.

Click OK to close the Output Settings dialog box.

Changing the Output 
Settings - concept

5 Click Area to create an area report. Reporting Parcel Area, 
Inverse, or Map 
Check Data
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Listing and 
Annotating Plans
In this chapter

� Listing object data

� Labeling objects
To check object characteristics, you can perform inquir-

ies which list object data at the command line or in a 

dialog box. To label objects with selected information, 

you can create dynamic and static labels, and you can 

create object tables that list detailed information about 

tagged objects in the drawing.
209



Using the
Comman

Extract o
Geometr
from Obj

Sea
Introduction

To check object characteristics, you can perform an inquiry on a drawing 
object. An inquiry shows you information about the selected object on the 
command line, the status bar, or in a tracking window. 

If you want a more permanent solution for identifying drawing objects—
especially when you are ready to plot the drawing—you can label the draw-
ing objects at any time during the drawing process. Autodesk Land Desktop 
can create dynamic labels, which update whenever you edit the drawing 
objects. If you do not want labels to update automatically, then you can 
create static labels. 

To annotate a drawing manually, then you can create text (TEXT), multi-line 
text (MTEXT), or text on a curve (CTEXT). Both text and multi-line text do 
not move or update when a drawing changes; however, as a curve is modi-
fied, the curve text moves with it. For more information about creating text, 
see “Working with Text” on page 143.

Listing Object Data

To quickly view data about objects, use the Inquiry commands. Autodesk 
Land Desktop has two types of inquiry commands:

� CAD-based
� Autodesk Land Desktop-specific

CAD-Based Inquiry Commands

These commands include the following commonly used commands that you 
can select from the Tools ➤ Inquiry menu:

Inquiry commands

Command Function

Distance Measures the distance between two points.

Area Calculates the area and perimeter of objects or defined areas.

 Inquiry 
ds

r Calculate 
ic Information 
ects
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Autodesk Land Desktop Inquiry Commands

To query Autodesk Land Desktop-specific objects, use the Inquiry com-
mands. Most commands on the Inquiry menu are list-based, meaning that 
the information is displayed on the command line. Track North/East, 
however, uses a dynamic tracking window that updates when you move the 
pointing device. 

Autodesk Land Desktop has several other specific, reporting and listing 
commands. For example, you can

� List the raster images that are inserted into a drawing and locate the source 
files by using the Manage command from the Map ➤ Image menu.

� List the alignments that are defined in the project by using the List 
Defined command from the Alignments ➤ Alignment Commands menu.

� List the breaklines that are defined in the project by using the List 
Breaklines command from the Breaklines shortcut menu in the Terrain 
Model Explorer.

� Show statistics for a surface model in the Terrain Model Explorer.
� Create alignment, stakeout, volume, and parcel reports.        

Region/Mass 
Properties

Calculates and displays the mass properties of regions or solids.

List Displays information of selected objects.

ID Point Displays the coordinate values of a location.

Time Displays the date and time statistics of a drawing.

Status Displays drawing statistics, mode, and extents.

Set Variable Lists or changes the values of system variables.

Inquiry commands (continued)

Command Function
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To track the elevation of a surface

Steps Use  to locate

1 Build a surface. Building a Surface

2 Make that surface the current surface. Making a Surface Current

3 From the Inquiry menu, choose Track Elevation. Tracking Elevations

4 Move the pointing device over the surface. 

The surface elevation is displayed on the status bar. If you 
move the pointing device outside the surface area, then 
an out-of-bounds message is displayed.

To list the station and offset of a location in relation to the current alignment

Steps Use  to locate

1 Define an alignment. Defining Alignments

2 From the Inquiry menu, choose Station/Offset Alignment. Listing the Station and 
Offset of a Location in 
Relation to the Current 
Alignment

3 Select a location in the drawing area that is adjacent to the 
current alignment.

The station and offset of the location is listed on the 
command line.

To list the alignments that are defined in the project

Steps Use  to locate

1 Define at least one alignment. Defining Alignments

2 From the Alignments menu, choose Alignment 
Commands ➤ List Defined.

The defined alignments are listed in the AutoCAD 
Text Window. 

Listing the Alignments 
Defined in the Current 
Project

3  To continue, press any key.
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Labeling Objects

You can label the lines, curves, spirals, and polylines in drawings by using the 
Autodesk Land Desktop labeling commands. Each object can have more than 
one label. You can customize label styles to apply to the drawing objects, or 
you can use one of the predefined label styles included with Autodesk Land 
Desktop. You can include the information either along an object, at a point 
next to the object, or in a table.

Depending on your requirements, you can choose from three different 
labeling methods:

� Dynamic labels: Creates labels that update automatically.
� Static labels: Creates labels that never change as you move an object or 

modify a style.
� Tag labels: Tags each object with a tag label and places detailed informa-

tion in a table.

All methods require you to select a label style, and then label the object. 

Label Styles

To control the display of labels, and to specify the type of information that 
is labeled, you can set up label styles. For example, you can set up a label style 
which labels the distance and direction of a line and displays on top of the 
line. Whenever you modify a style that was used to create dynamic labels, the 
labels are updated to reflect the edited style.

Point label styles control the use of description keys for points, and they can 
also be formatted to label points with information that is located in external 
Microsoft Access databases.

For more information about label styles see “Editing Label Styles” on 
page 219.

 Labels
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les
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Accessing Labeling Commands

You can access the labeling commands in one of three ways:

� Select commands from the Labels pull-down menu.
� Use the Object shortcut menu.
� Use the Style Properties dialog bar.

The Labels menu, shown in the following illustration, provides access to 
numerous labeling commands, such as those for labeling lines, curves, 
spirals, and points.
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Object Shortcut Menu
By using the Object shortcut menu, you can have quick access to the labeling 
commands. Select the objects that you want to label, right-click, and then 
select a labeling command from the shortcut menu.

Style Properties Dialog Bar
To choose the current label styles, you can use the Style Properties dialog bar 
to switch between tag and normal label styles, to change the label settings, 
and to edit label styles.

Labeling commands on the 
Object shortcut menu

 Style Properties 
ar
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To display the Style Properties dialog bar, select Show Dialog Bar from the 
Labels menu. You can dock the dialog bar either on the top or bottom, but 
not to the side, of the graphics window.

TIP To move the dialog bar into either the menu or the command line areas, 
but to not dock it, hold down CTRL as you move the dialog bar.

Key Concepts 

� You can label objects individually or as a group, and you can label any 
combination of lines, curves, spirals, and polylines simultaneously.

� Polylines use the current line label style for straight segments, and the 
current curve style for curved segments. Only lightweight polylines can be 
labeled.

� You can control label details, such as arrows, spacing, alternate units, and 
angle units, when you set up the label styles.

� To label alignments, contours, and parcels, use the labeling commands 
from the Alignments, Terrain, and Parcels menus. 

To label lines with dynamic labels 

Steps Use  to locate

1 Draw some lines by using the LINE or PLINE command. Draw Lines

2 From the Labels menu, choose Show Dialog Bar to display 
the Style Properties dialog bar.

Using the Style Properties 
Dialog Bar

3 Verify that the  icon is displayed. When this icon is 
displayed, the Current Label Style list shows only regular 
label styles. 

If the  icon is displayed, the list of styles shows only 
tag label styles. You can click the tag icon to display the 
labels icon.

Selecting the Current Label 
Style from the Style 
Properties Dialog Bar

4 Click the Line tab.

5 Select a style from the list, such as Direction Above, 
Distance Below.
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6 Click  to display the Label Settings dialog box.

7 Click the General tab.

8 Verify that the Update Labels When Style Changes and the 
Update Labels When Objects Change check boxes are 
selected. 

These check boxes control whether the labels are updated 
when you edit an object or label style.

The Update Labels When Objects Change check box must 
be selected if you want to create dynamic labels.

Specifying How Labels Are 
Updated

9 Click OK to return to the drawing.

10 Select the lines that you want to label.

11 Right-click, and then choose Add Dynamic Label from the 
shortcut menu.

Labels are added, as shown in the following illustration.

Creating Dynamic Labels

12 If you click a grip on one of the lines and drag it to a new 
location, the labels are updated with the new distances 
and angles.

To label lines with dynamic labels  (continued)

Steps Use  to locate
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To label lines with tag labels and create a table 

Steps Use  to locate

1 Draw some lines by using the LINE or PLINE command. Draw Lines

2 From the Labels menu, choose Show Dialog Bar to display 
the Style Properties dialog bar. 

Using the Style Properties 
Dialog Bar

3 Verify that the  icon is displayed. When this icon is 
displayed, the Current Label Style list shows only tag label 
styles.

If the  icon is displayed, then the list of styles shows 
only regular label styles. You can click the label icon to 
display the tag icon.

Selecting the Current Label 
Style from the Style 
Properties Dialog Bar

4 Click the Line tab.

5 Select the Tag Number style.

6 Select the lines that you want to label.

7 Right-click, and then choose Add Tag Label from the 
shortcut menu.

8 From the Labels menu, choose Add Tables ➤ Line Table to 
display the Line Table Definition dialog box.

By default, the Column Definitions are set up to place line 
number, line length, and bearing in the table.

Creating a Line Table

Changing the Column 
Definitions of a Line Table

9 Click OK to create the table.

10 Select an insertion point for the table. This is the upper-
left corner of the table.

The table is placed in the drawing.
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Editing Label Styles

Autodesk Land Desktop includes several different default label styles. You can 
edit these styles if needed, and you can create new styles.

A label style controls the appearance of the label text, such as the style, label 
offset, text layer, and text justification.

A label style also controls what pieces of information the label contains, such 
as direction and distance. These are called data elements. 

To edit a line label style 

Steps Use  to locate

1 From the Labels menu, choose Edit Label Styles to display 
the Edit Label Styles dialog box. 

Label Styles

2 Click the Line Label Styles tab. Editing Line Label Styles
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3 From the Name list, choose the name of the Label Style 
that you want to edit. 

4 When you select a style, the Text Above and Text Below 
sections of the dialog box display the selected data 
elements. The Preview area on the right shows you a 
preview image of this label.

If you want to modify any elements of the selected style, 
then you can type modifications in the Text Above and 
Text Below text boxes, or delete existing text in these 
boxes. You can also select different data elements to place 
in the label.

5 To add an arrow, tick marks, or crows feet to the objects 
you are labeling, select the appropriate check boxes.

6 Under Text Properties, select a text style, specify an offset, 
select a layer, and specify the justification method for the 
label.

7 Click Save to save the label.

8 Click OK.

To edit a line label style  (continued)

Steps Use  to locate
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Importing and Exporting 
Data in LandXML 
Format
In this chapter

� Using the LandXML Import and 
Export commands

� Exporting data in LandXML 
format

� Importing LandXML data
When you use the Import LandXML and Export 

LandXML commands, you can export and import 

points, surfaces, parcels, and alignments in LandXML 

format using the LandXML schema. If you have 

Autodesk Civil Design installed, you can export profile 

and cross section data and import profile data.
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Using the LandXML Import and Export 
Commands

LandXML is a data exchange standard for managing data, such as points, 
alignment geometry, and other information. It is based on the Extensible 
Markup Language (XML), a global standard for exchanging data via the 
Internet.

You can use the Import LandXML and Export LandXML commands to export 
and import point, surface, alignment, and parcel data in LandXML format.

By transforming project data to LandXML format, you can do the following:

� Exchange data. For example, you can import LandXML data into other 
software applications that support imported XML. The data can then be 
modified and delivered to customers and agencies in the required formats. 

� Transfer and archive data. For example, you can transfer data to another 
Autodesk Land Desktop project, or archive project data in a 
non-proprietary format. 

� Create custom reports. For example, you can transform the data into 
custom reports by applying XSL style sheets. See the www.landxml.org 
website for examples.

� Convert units. For example, you can export data from an imperial project, 
and then import it into a metric project to scale and convert values. 

� Translate and rotate coordinates. For example, you can use the Import 
LandXML and Export LandXML commands to globally adjust the eleva-
tions of project data.

� Identify project data that has changed. For example, if you change a 
project after exporting it, you can use the LandXML Import command 
(without actually importing data) to compare the current project to the 
exported LandXML file. Any differences between the project data are 
listed in the LandXML Import Comparison Results dialog box.

The Import LandXML and Export LandXML commands are based on the 
LandXML schema. For more information about the LandXML schema, go to 
www.landxml.org.
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Exporting Data in LandXML Format

Using the LandXML Export command, you can export the following 
LandXML data from an Autodesk Land Desktop project:

� COGO points
� Point groups
� Description keys
� Surfaces
� Parcels
� Alignments
� Profiles
� Cross sections

The following illustration shows the LandXML Export dialog box, which you 
can access by choosing Export LandXML from the Projects menu. Use the 
options in this dialog box to select the data to export and to specify Export 
Options and Point Reference settings.

Key Concepts

� When you select the points to export, you can also choose to export the 
point groups and description key definitions.

� When you select the surfaces to export, you can also choose to export the 
watershed definitions.

� When you select the alignments to export, you can also choose to export 
profiles and cross sections if Autodesk Civil Design is installed.
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� Use the Export Data Options to control the data precision and the 
imperial unit foot type. When working with imperial units, you can 
specify that feet are treated as U.S. Survey feet or International feet. An 
International foot is 1.000002 times the size of a U.S. Survey foot.

� Use the Export File Options to control the level of detail contained in the 
exported file. For more information, see “Outputting Minimal or Detailed 
Data” on page 224.

� You can export point references for alignments and parcels. Point refer-
ences substitute references to COGO points instead of using coordinates 
for the geometric points on an alignment or parcel. For more information, 
see “Exporting Point References” on page 225.

Outputting Minimal or Detailed Data

One of the options you can control by using the LandXML Export File 
Options is whether the exported data is minimal or detailed. To access the 
LandXML Export File Options dialog box, shown in the following illustra-
tion, click the File button in the LandXML Export dialog box.
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� To output the minimum amount of data required to recreate the project 
data when importing the file, select the Minimum Output option under 
File Options.

Use this option when you intend to transfer the data to another Autodesk 
Land Desktop project or to another software program. When imported 
into another Autodesk Land Desktop project, the additional information 
created with the Detailed Output option is not used by the LandXML 
Import command.

� To output all supported elements and attributes for the selected data 
types, select the Detailed Output option.

Select this option if you intend to create a formatted report of the data, or 
if you intend to use the data in a program that is not capable of calculating 
the information.

TIP If you want to use the data for a report, you can apply a style sheet to the 
data. To do this, select the Apply XSL Stylesheet check box in the LandXML 
Export File Options dialog box and specify a style sheet to use.

Exporting Point References

A point reference substitutes a known northing/easting coordinate of a line, 
curve, or spiral for a COGO point (CgPoint element) that is within a specified 
tolerance distance. 

You can export point references for the geometric coordinates of parcels and 
alignments. To use point references, select the Parcels or Alignments check 
boxes under Point References in the LandXML Export dialog box. Click the 
Advanced button to specify the tolerance value and to specify the points to 
use as references. You can also select the Export COGO Point References Only 
check box to export only those points that are used as point references.

NOTE You must export the COGO points that are used as point references in 
order to export the point reference data.

When you choose to export point references, the LandXML Export com-
mand creates COGO point references, where possible, for the parcel and 
alignment geometry. This means that if the geometry of parcels and align-
ments in the project match COGO point coordinates within a specified 
tolerance, the parcel and alignment coordinates are output in the LandXML 
file as references to those COGO points.
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For example, in LandXML a parcel line element definition could appear as 
follows:

<Line>
<Start>5832.87775298 3944.16966215</Start>
<End>5632.87775298 3944.16966215</End>
</Line>

If you choose to create the COGO point references the definition would 
appear as follows:

<Line>
<Start pntRef="250" />
<End pntRef="256" />
</Line>

This shows the line connecting points 250 to 256. It is also valid for a coor-
dinate geometry element to have a mix of pntRef and coordinate values as 
shown in the following example.

<Line>
<Start pntRef="250" />
<End>5632.87775298 3944.16966215</End>
</Line>

This situation could occur for the endpoint if a COGO point is not within the 
specified tolerance.

To export data in LandXML format

Steps Use  to locate

1 From the Projects menu, choose Export LandXML to 
display the LandXML Export dialog box.

Exporting LandXML Data 
from Autodesk Land 
Desktop

2 Select the data to export by using the Points, Surfaces, 
Parcels, and Alignments buttons.

NOTE To export the specified data, the check boxes next 
to the Points, Surfaces, Parcels, and Alignments buttons 
must be selected.

Selecting the Point Data to 
Export

Selecting the Surface Data 
to Export

Selecting the Parcel Data to 
Export

Selecting the Alignment 
Data to Export

3 To export point references for parcel and alignment 
geometry, select the Parcels and Alignments check boxes 
under Point References, and then click Advanced to set 
the tolerance value.

Changing the Point 
Reference Options
226 | Chapter 9 Importing and Exporting Data in LandXML Format



Importing LandXML Data

Use the LandXML Import command to import the following data into the 
current Autodesk Land Desktop project:

� COGO points
� Point groups
� Description keys
� Surfaces
� Parcels
� Alignments
� Profiles

NOTE The LandXML Import command does not support cross sections.

Importing LandXML data into Autodesk Land Desktop is a two-step process.

� First, select the file to import and select options that prepare the data to 
be imported. 

� After the data is processed, you can select the specific items in the file 
to import.

4 To set the data precision and foot type (for imperial 
projects only), click Data under Export Options.

Changing the LandXML 
Export Data Options

5 To specify the location and detail of the exported file, the 
default schema location, and to select an XSL style sheet 
to apply to the data, click File under Export Options.

NOTE The \Land Desktop 3\Data\LandXML Stylesheets 
folder contains four basic XSL stylesheets which you can 
use as a basis for creating your own XSL stylesheets. 

Changing LandXML Export 
File Options

6 Click Export, specify a file name, and click Save to export 
the data.

As the data is exported, the export progress is indicated 
on status bar at the bottom of the LandXML Export dialog 
box.

To export data in LandXML format (continued)

Steps Use  to locate
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The following illustration shows the LandXML Import dialog box, which you 
can access by choosing Import LandXML from the Projects menu.

Use the options in this dialog box to do the following:

� Select the data types to import, such as points or alignments, by selecting 
the check boxes under File Contents. (You refine the data selection in a 
subsequent step). 

� Select the Translate/Rotate check box to specify translation and rotation 
values for the imported data.

� Select the Select Region Boundary check box to limit the import to a 
selected region of the project.

� Use Data Options to control the data imported into the current drawing, 
such as
� Whether existing profile data is overwritten or whether data is merged.
� Whether surfaces are imported with breakline data (which maintains 

original surface triangulation) or point data only (which is a quicker 
method).

� Whether the foot type is U.S. Survey or International for imperial 
drawings.

Some of the options in this dialog box affect whether other dialog boxes are 
displayed during the data import process after you click OK. 
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For example, if you select the Translate/Rotate check box, then the LandXML 
Translate/Rotate dialog box is displayed, as shown in the following 
illustration.

Use this dialog box to specify a base point and translated point as well as a 
rotation angle for the data.

If you select the Select Region Boundary check box, then LandXML Import 
Region Selection dialog box is displayed, as shown in the following 
illustration.

Use this dialog box to specify a region type and selection method. When you 
click OK, you are prompted to select the region from the drawing. The import 
of data into the project is then limited to the coordinates of this region.
Importing LandXML Data | 229



If the LandXML file you are importing has different units than the current 
drawing, the LandXML Import Unit Conversion dialog box is displayed, as 
shown in the following illustration.

The Conversion Value box is filled in automatically with a standard 
conversion factor.

Import Results and Import Selection

After you have gone through the steps of specifying the data types to import 
and specifying the various import options, the data is summarized in the 
LandXML Import Comparison Results dialog box, as shown in the following 
illustration.
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Click OK to display the LandXML Import Selection dialog box, shown in the 
following illustration, which you can use to refine the selection of data to 
import.

Use the options in this dialog box to select the points, point groups, descrip-
tion keys, surfaces, parcels, and alignments to import, and then click Import 
to import the data into the current project.

Key Concepts

� You can specify the data to import in two phases. 
� First, in the LandXML Import dialog box, specify the general data types 

to import, such as points. 
� Then, in the LandXML Import Selection dialog box, use the options to 

specify exactly the points (or other data) to import.

� By using the LandXML Import Region Selection dialog box, you can limit 
the import of data to a specified region in the project. Use a polyline or a 
window selection to specify coordinates in the current drawing.

� To import profiles, Autodesk Civil Design must be installed on your 
system.
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To import LandXML data

Steps Use  to locate

1 From the Projects menu, choose Import LandXML to 
display the LandXML Import Select File dialog box.

Importing LandXML Data 
into Autodesk Land Desktop

2 Select the LandXML file to import and click Open to 
display the LandXML Import dialog box.

3 Under File Contents, select the check boxes for the data 
types you want to import.

If the file does not contain a data type, then that check 
box is unavailable for selection.

4 Under Data Processing, select the Translate/Rotate check 
box to translate or rotate the values in the LandXML file. 
Select the Select Region Boundary check box to limit the 
import to a specified region in the project.

5 Under Options, click Data to specify the data to be 
imported into the drawing, and how surface and profile 
data are imported.

Changing the LandXML 
Data Options

6 Click OK to close the LandXML Import Data Options 
dialog box, and then click OK again to continue.

7 Depending on the options you selected and depending 
on the file units, the following dialog boxes may be 
displayed:

� LandXML Import Unit Conversion
� LandXML Import Translate/Rotate
� LandXML Import Region Selection

Converting Units When 
Importing LandXML Data

Translating and Rotating 
LandXML Data

Importing LandXML Data 
Within a Region

8 Finally, the LandXML Import Comparison Results dialog 
box is displayed, which shows you the data in the file that 
is new or different compared to the current project. Click 
OK to continue.

LandXML Import 
Comparison Results

9 In the LandXML Import Selection dialog box, specify the 
points, point groups, description keys, surfaces, parcels, 
and alignments to import, and then click Import to import 
the data.

Selecting LandXML Data to 
Import
232 | Chapter 9 Importing and Exporting Data in LandXML Format



Glossary

2D polyline A polyline with all vertices at the same elevation.

3D face A 3D face is an AutoCAD object that represents the surface of a 3- or 4-sided 
area, with each vertex potentially at a different elevation. You can view TINs 
(Triangulated Irregular Networks) as 3D faces. Using the SHADE command, you can shade 
3D faces. Using the RENDER command, you can render the 3D faces.

3D grid The 3D grid command projects the vertices of a 2D, regularly spaced, square or 
rectangular grid onto a TIN surface. The calculated elevations of the projected vertices are 
then used to build 3D faces. The smaller the grid, the more detailed the representation of 
the surface becomes.

3D polyline A polyline with vertices at varying elevations.

3D skirts Vertical 3D faces from the border of the surface to the base elevation. 

A value (spirals) The spiral parameter A equals the square root of the product of the 
spiral length and the radius. This parameter measures the flatness of a spiral.

acre A measure of land: 160 square rods; 4,840 square yards; 43,560 square feet in a 
closed shape of any form.

alternate units A second dimension using another standard of measure. These labels 
are usually placed after the dimension in square brackets ([ ]). A common use of alternate 
units is to label a line’s distance in feet with alternate units of meters.

angle The difference in direction between two convergent lines. In surveying, the angle 
is on a horizontal or vertical plane.

Angles are measured in several different ways. The major differences between them are 
the units of angular measurement and how they are referenced. The main units used are 
the degree, radian, and grad. Degrees are the result of dividing a complete circle into 360 
equal parts. Grads are the result of dividing a complete circle into 400 equal parts. A 
radian is the angle subtended by an arc with a length equal to the radius of the circle.
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The two major angular references that are used in Autodesk Land Desktop are the 
azimuth and bearing.

An azimuth angle is referenced from North, and is always measured clockwise. South 
of the equator, however, azimuth angles are not referenced to due north, but to due 
south. 

A bearing angle is measured from either due north or south, with an east or west 
reference angle. For example, the notation N45°45'58'' E means that this angle was ref-
erenced from due north and was turned 45 degrees, 45 minutes, and 58 seconds 
toward the east. Bearing angles can never exceed 90 degrees (PI/2 radians or 100 grads). 
In addition, bearings are usually referenced by quadrant number. A quadrant is any of 
the sections resulting from dividing a circle into four equal parts. Quadrant one is con-
sidered to be the NE corner, and quadrants 2, 3, and 4 proceed clockwise.

Also, in AutoCAD, all lines have an angle in the X,Y plane, with 0 degrees typically to 
the right, or 3:00 on the dial, and all angles measured counter-clockwise. 

arc A part of a mathematically defined circular curve.

area The quantity of plane space in a horizontal plane enclosed by the boundary of 
any polygonal figure.

assumed coordinates A set of coordinates assigned to a point that are not the actual 
point coordinates. All points are set relative to these coordinates. For example, the 
coordinates N5000, E5000 can be assigned to the beginning point of a traverse. Later, 
if the actual coordinates were found to be N4578.99, E20987.66, you can adjust the 
points relative to the actual coordinates.

assumed elevation An elevation assigned to a base point that is not the actual point 
elevation. All other points are set relative to this elevation. For example, an elevation 
of 200 may be assigned to the beginning point of a traverse. Later, if the actual eleva-
tion was found to be 405.67, you can re-assign elevations relative to the actual, not the 
assumed, elevation.

AutoCAD login name When you install Autodesk Land Desktop, an AutoCAD login 
name is generated for you. This login name is based on your Windows login name, and 
is used by the program to manage the lock files for a project.

average end area A type of Section volume. The most common method of calculat-
ing volumes. The average of adjacent cross section areas is multiplied by the distance 
between them. For drawings that use feet as units, the volume is reported in cubic 
yards; for drawings that use meters as units, the volume is reported in cubic meters.

The following formula is used when you select the average end area volume 
calculation method:

S
h

A A= +
2

1 2( )
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average method (Surface Display) You can use the Average method to create 
surface views that show the elevation or slope ranges of a surface. The average method 
uses a centroid-averaging calculation to determine which surface triangles belong in 
which range. This may result in ranges that appear ″saw-toothed.″ See also banding 
method (Surface Display).

azimuth A clockwise angle measured from a reference meridian. Also known as 
north azimuth. It can range from 0 to 360 degrees. A negative azimuth is converted to 
a clockwise value. See also south azimuth.

banding method (Surface Display) You can use the Banding method to create 
surface views that show the elevation or slope ranges of a surface. The Banding method 
splits surface triangles based on elevation ranges to create smooth bands. See also 
average method (Surface Display)

base elevation A reference plane for 3D skirts and the vertical factor for a surface. 
3D skirts use the base elevation to determine the elevation at the bottom of the 
3D skirts. If you apply a vertical factor for scaling a 3D view of a surface, then the 
surface is scaled vertically from the base elevation.

base point The point of coordinate control for the Autodesk Land Desktop coordi-
nate system. This is the point on the Northing/Easting grid that is assigned to a point 
on the AutoCAD World Coordinate System X,Y grid. The base point setting is specific 
to each individual drawing, and typically starts with North = 0, East = 0, set on 
AutoCAD’s X = 0, Y = 0. 

You can use the base point setting to assign any northing/easting coordinate to any 
X,Y coordinate, effectively moving (but not rotating) the northing/easting grid over 
the X,Y grid. The northing/easting coordinates of the points in the database are 
unchanged by a base point manipulation. This feature is sometimes used when work-
ing with a dataset with high coordinates to move the area of the northing/easting grid 
closer to AutoCAD’s 0,0.

bearing An angle measured from North or South, whichever is nearest, with the 
added designation of East or West. The angle is always less than 90 degrees 
(PI/2 radians or 100 grads) and is usually referenced by quadrant number. For example, 
the notation N45°45'58'' E means this angle was referenced from due North and was 
turned 45 degrees, 45 minutes, and 58 seconds toward the East (in the first quadrant).

boundary (surface) A closed 2D or 3D polyline that limits the triangulation of the 
digital terrain model by not allowing TIN lines to cross it. Most common are outer 
surface boundaries constructed just outside the extremities of the dataset, eliminating 
unwanted interpolations across empty space where the surface has a concave shape. 
You can also use two types of internal surface boundaries: hide boundaries, to punch 

Variable Value

S volume

h distance between 
sections

A1 area of section 1

A2 area of section 2
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holes in a surface, (for example, a building footprint), or show boundaries, to create 
smaller surfaces by eliminating areas that fall outside the boundary. 

breakline A breakline is used to connect the data representing a distinct surface 
feature, like a ridge line, edge of pavement, toe of a slope, centerline of a road, or flow-
line of a ditch or stream. When a breakline is defined, the surface triangulation must 
follow the breaklines first, by placing triangle edges coincident with the breakline seg-
ments. This ensures the feature in the model is accurately depicted. The rest of the 
interpolation is then performed based on proximity. Breaklines are typically critical to 
creating an accurate surface model, because it is the interpolation of the data, not just 
the data itself, that determines the shape of the model.

breakline points A breakline point is a point of surface data included in the defined 
breakline’s list of vertices.

bulge For contours that contain curves, the bulge value is a maximum mid-ordinate 
distance along a polyline curve. If the mid-ordinate distance is longer than specified, 
then points are added to better define the shape of the curve. 

Polyline curves are not actually curves; they are small, straight segments that mimic 
the appearance of a curve. The bulge factor can add more vertices to a polyline curve, 
making it appear more curve-like. The smaller the value, the more vertices are added.

Used when creating contour data for a surface; not for creating contours.

catchment area The area tributary to a lake, stream, or drainage system.

centerline (CL) The center line of an alignment. Road lanes are created by offsetting 
the centerline a specified distance. When designing roadway templates, the centerline 
is usually the finished ground reference point.

chord A straight line connecting two points on a curve: the Point of Curvature (PC) 
and Point of Tangency (PT). The curve joins with a line or another curve at these 
points. 

COGO Short for Coordinate Geometry.

COGO point object The point objects that you create using the Points menu 
commands (and other Autodesk Land Desktop commands that create points) can have 
several pieces of information associated with them. The point object has a point node 
and a point number, northing and easting values, elevation, description, and optional 
name. The point data is stored in an external point database, and all elements of a 
point object are inserted on the same drawing layer unless description keys are used. 

composite surface volumes The composite volume method creates a surface that 
represents the depth of cut and fill over the site. You can use any of the Terrain com-
mands that generates information based on a surface with the composite surface. For 
example, you can create contours or points based on depth of cut and fill.

When you calculate the volumes using this method, the surface is re-triangulated 
based on points from both surfaces. This method uses the points from both surfaces, 
as well as any location where the triangle edges between the two surfaces cross. It then 
calculates the new composite surface elevations based on the difference between the 
elevations of the two surfaces.

compound curve A curve consisting of two or more arcs of different radii curving in 
the same direction, which have a common tangent or transition curve at their point 
of junction.
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compound spiral A spiral that provides a transition between two circular 
curves of different radii.

contour An imaginary line that connects points of the same elevation or value rela-
tive to a specified reference datum.

contour data Contours are one of the major categories of data (others are points, 
breaklines, boundaries, and DEM files), that you can use to build a surface. Contour 
data is unique inasmuch as it is the only data type that weeding and supplementing 
factors are applied to. The Create As Contour Data check box in the Contour Weeding 
dialog box actually determines whether the contours are defined as point data 
(unchecked), or breakline data (checked). 

coordinate transformation Also known as geodetic transformation. A coordinate 
transformation converts values established in one coordinate system and translates 
them to another. 

coordinates By its mathematical definition, a point is a geometric entity with no 
length. To specify exactly where that point is in space, you must specify its location in 
three different coordinate planes: X, Y, and Z; or Northing, Easting, and Elevation.

cross section Section views taken at a 90-degree angle to the alignment.

curve correction In volume calculations, the length between the end areas on 
horizontal curves is taken from the length along the centerline curve. With curve 
correction, the length is taken from the path of the area’s average centroid for a more 
accurate result.

curve to spiral (CS) A point where a curve meets a spiral is labeled as a CS.

datum A reference value. All elevations or coordinates are set relative to this value. 
In surveying, two datums (horizontal and vertical) are generally used.

For global coordinate systems, a datum refers to the ellipsoid information and the 
techniques used to determine positions on the Earth’s surface. An ellipsoid is part of a 
datum definition.

decimal degree One of the five choices for degree units, decimal degrees express the 
minutes and seconds of an angle as its decimal equivalent. For example, 3°30'36'' 
equals 3.51 decimal degrees.

In contrast, when using the DD.MMSS convention, in which the numbers after the 
decimal are read as minutes and seconds, not decimal degrees, 3°30'36'' is entered as 
3.3036, not 3.51. Care must given not to confuse the two methods, as they clearly yield 
very different results. See also degrees, minutes, seconds.

deflection angle A horizontal angle measured from an extension of the preceding 
line, right or left.

degrees, minutes, seconds A representation of an angle in degrees, minutes, and 
seconds in which a full circle contains 360 degrees, each degree 60 minutes, and each 
minute 60 seconds. A typical bearing in DMS measurement looks like: N45°45'58''E. 
Using this format, 3°30'36'' is entered as 3.3036.

DEM  Digital Elevation Model (DEM) consists of an array of elevations taken on a reg-
ularly spaced horizontal grid. You can get USGS (United States Geological Survey) 
topographic data in this form. 
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description keys When new point data is created in the point database, regardless of 
the method you use, the descriptions that you enter can be checked against a 
user-defined list of description keys. These consist of case-sensitive, literal character 
strings, with or without wildcards. Depending on how you set up the description keys, 
if a match is found, then:

� The current description can be replaced with an alternate description.

� The COGO point in the drawing that represents the record in the point database 
can be assigned to a specific layer.

� A symbol can be placed at the node of the point.

� The symbol can be assigned to a specific layer.

Using description keys to translate descriptions can help standardize point data if a 
variety of data sources are used. For example, descriptions of EROAD, EPAVE, ERD, and 
EDGEROAD can all be changed to EOP. The other layer and symbol options can greatly 
enhance automatic base plan generation and the overall organization of the drawing 
file.

digitize To digitize a paper drawing is to convert it into AutoCAD vector objects. 
Digitizing has traditionally been done by taping a paper drawing onto a digitizing tab-
let and tracing over it using AutoCAD commands. 

Alternately, you can trace bitmap files that are inserted in the drawing. Tracing bitmaps 
onscreen with AutoCAD commands is referred to as heads-up digitizing. 

Whatever the method used, the end result is AutoCAD objects that you can place on 
layers, edit, and use as a data source for design work.

distance A length between two points. It can be expressed as either feet or meters, 
and can be a horizontal or slope distance. In some functions, a negative distance 
reverses direction.

drawing settings Drawing settings control many different command parameters in 
Autodesk Land Desktop. Each drawing in a project can have its own drawing settings. 
Drawing settings are broken down by feature. For example, there are drawing settings 
for points, terrain, and so on. 

drawing template A drawing file with pre-established settings for new drawings and 
has the extension .dwt. Templates store layers, text styles, line types, dimension styles, 
and AutoCAD variables like Aperture. They can also store blocks, such as a border or a 
company logo. 

A template also stores drawing setup values. For example, if you use the Drawing Setup 
Wizard or the Drawing Setup command to set up a drawing, and then save that draw-
ing as a .dwt file, then the next time you create a new drawing based on the drawing 
template, all of the drawing setup values will be loaded.

dynamic labels Dynamic labels are labels that can change position, content, or style 
after you create them. Dynamic labels have the ability to auto-update whenever you 
edit the object the label is associated with, or whenever you edit the style of the label. 
You can turn off auto-updating options, and use commands to update the labels if 
desired. Or, you can convert the dynamic labels to static labels if you never want them 
to be updated. See also static labels.

E value (superelevation) The maximum allowable superelevation rate in either ft/ft 
or m/m. An E value of 0.10 equals a 10 percent grade.
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easting A linear distance eastwards from the North-South line which passes through 
the origin of a grid. Equivalent to the X coordinate in an X, Y, Z coordinate system. 

edit history When you edit a surface, your edits are recorded in an edit history which 
you can play back when you rebuild the surface. When the surface is rebuilt, the same 
edits are made in the order you made them. 

elevation The vertical distance from a datum to a point or object on the Earth’s 
surface. The datum is generally considered to be at sea level.

elevation banding The process of dividing a surface into user-defined elevation 
ranges and creating 2D solids or 3D faces on separate layers to represent the part of the 
surface that falls within each range.

end conditions Refers to the symbol at the end of lines or other objects. End condi-
tion symbols can be arrows, crows feet, and so on.

entity Synonymous with object. Any vector object that appears in the drawing. 

equations (stationing) Station equations are used to define points on an alignment 
where stationing is discontinuous.

existing ground An undeveloped terrain as it currently exists.

face A three-dimensional surface triangle. A face is represented by either a 3D face 
object or 3D line objects.

facet The planar face of a grid cell. Each grid cell has one, two, or four facets. 

finished ground A digital terrain model of a proposed final design, and the represen-
tation of that surface as linework on a profile or section. The proposed or actual terrain 
model of a developed terrain. 

foot Unit of linear measurement. An international foot is based on the conversion 
1 in. = 2.54 cm. while a US survey foot is based on 39.37 in. = 1 meter.

full description The description of a point after any point description key substitu-
tion has occurred. See also raw description.

geodesic On a surface, the shortest line between two points. The line or curve from 
one point along an ellipsoid to another.

geodesy The science that determines the Earth’s size and shape and the exact posi-
tions of points on its surface.

geodetic Signifies a basic relationship to the Earth that takes into account the 
curvature of the Earth’s sea level surface. For example, a geodetic distance is a distance 
or angle in which the Earth’s curvature is taken into account, versus a distance or angle 
measured on a flat paper map. 

geodetic transformation Also known as coordinate transformation. Converts values 
established in one coordinate system and translates them to a different coordinate 
system. 

global coordinate system Describes how the Earth’s sphere is projected onto a sheet 
of paper and converted to the Cartesian coordinate system. A global coordinate system 
can differ based on the projection type, datum, and units that are used. For example, 
a global coordinate system can be based on the Lambert Conformal Conic projection, 
the North American Datum of 1983, and metric units.
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grade The slope of a surface, with the vertical rise or fall expressed as a percentage of 
the horizontal distance.

grads A system of measure in which one grad equals 1/100 of a 90° angle, or 
360° = 400 grads.

grid A system of lines parallel to a given set of axes at a specific spacing. Grids are 
used in Autodesk Land Desktop to visualize surfaces and calculate volumes. A grid is 
also used for geodetic purposes.

grid azimuth At the point of observation, the angle in the projection's plane mea-
sured between the central meridian of the plane coordinate projection system and a 
line containing the object sighted.

grid distance The distance between two points based on a coordinate zone, not on 
local northing and easting coordinates.

grid easting The easting coordinate based on a selected coordinate zone, versus the 
local easting, which is based on the surveyor's base point.

grid m size The dimension of the grid cell in the M direction (equivalent to the 
drawing's X-axis if grid rotation angle is 0).

grid n size The dimension of the grid cell in the N direction (equivalent to the 
drawing's Y-axis (if the grid rotation angle is 0).

grid northing The northing coordinate based on a selected coordinate zone, versus 
the local northing, which is based on the surveyor's base point.

grid surface volumes The grid method of volume calculation measures the differ-
ence in elevation between two surfaces at each intersection in a user-defined grid. If 
only one surface exists at a grid intersection, then that point is not used in the volume 
calculation. Surface 2 in the defined stratum is always compared to surface 1. If 
surface 2 is lower than surface 1, then it is a cut condition, and if surface 2 is higher 
than surface 1, then it is a fill condition. 

The difference in elevation between the surfaces at all the usable grid intersections is 
then used as the Z value for a new grid surface data point. For example, a grid point 
with a fill condition of 2.39 generates a surface data point with an elevation of 2.3, a 
grid point with a cut condition of 1.79 generates a surface data point with an elevation 
of -1.7. Autodesk Land Desktop then builds a grid volume surface, and compares it to 
a flat plane surface at elevation 0 to determine the cut and fill volumes. 

grid tick A mark made at each sampled location in a volume grid. The ticks are 
placed on two different layers, depending on if they represent a cut condition or a fill 
condition, and are typically accompanied by labels showing the amount of cut or fill, 
similarly placed on separate layers. You can then use the ticks and labels to generate a 
color-coded graphic depicting the areas and amounts of cut and fill earthwork.

hectare A measure of area, generally relating to land, of 10,000 square meters or 
approximately 2.47 acres.

horizontal alignment A series of 2D coordinates (northings and eastings), con-
nected by lines, circular curves, and/or spiral curves, that Autodesk Land Desktop 
stores as an external data file. This defined alignment, in conjunction with a surface, 
can produce the station, offset, and elevation data needed to generate profiles and/or 
cross-sections. You can station the horizontal alignment and create parallel offsets to 
represent features such as edges of pavement, sidewalks, or rights-of-way. 
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horizontal scale In the drawing setup, the horizontal scale controls the size of anno-
tation placed in the drawing, including text, scaled blocks, and special lines. It does 
not affect the line lengths or point coordinates because they are always defined in real 
world coordinates, not to any scale. Neither does it affect the design data in the draw-
ing or project files.

If you change the horizontal scale in the middle of a drawing session, then any anno-
tation added subsequently is scaled accordingly. 

interpolate The process of calculating the elevation of any point on an infinite imag-
inary line that passes through two known horizontal and vertical control points. 

intersection The point where two or more lines, arcs, figures, or objects join or cross 
in two- or three-dimensional space.

least squares A method of balancing a traverse in which the squares of the differ-
ences between the unadjusted and adjusted measurements (angles and distances) are 
summed and reduced to a minimum. This method uses the error specifications in the 
current equipment settings to determine the expected source of errors, and weights the 
individual measurements accordingly.

lightweight polyline Optimized polyline first introduced in AutoCAD 14. These 
polylines list as “LWPOLYLINE” when you use the LIST command.

local easting The easting coordinate based on the surveyor's assumed horizontal 
base point, versus the grid easting, which is based on the global coordinate zone.

local elevation The elevation coordinate based on the surveyor's assumed vertical 
base point, or benchmark, versus a real world elevation value.

local northing The northing coordinate based on the surveyor's assumed horizontal 
base point, versus the grid northing, which is based on the global coordinate zone.

m direction The M and N directions are used for defining grids in Autodesk Land 
Desktop, due to the fact that a grid rotation angle can cause the grid axes to be different 
from either the X-Y axes or the Northing/Easting axes in the current drawing. The m 
direction is roughly equivalent to the X direction.

meter The basic metric measurement of length. In comparison to the international 
foot 1 in. = 2.54 cm.

middle ordinate On a circular arc, the distance from the midpoint of the chord to 
the midpoint of the subtended arc. 

minimize flat faces Minimizing the flat faces of contours helps to ensure that trian-
gulation does not occur from one point on a contour to another point on the same 
contour, creating flat ridges. A typical example is on a site that includes finger-like con-
tours such as you might find along a stream. Minimizing flat contours prevents the 
surface model from triangulating between a contour on one side of the stream and a 
contour on the other side of the stream. 

n direction The M and N directions are used for defining grids in Autodesk Land 
Desktop, due to the fact that a grid rotation angle can cause the grid axes to be different 
from either the X-Y axes or the Northing/Easting axes in the current drawing. The 
N direction is roughly equivalent to the Y direction.

NAD 27 zone North American Datum of 1927. A datum acts as a reference point, 
line, or surface for mapping. In general, NAD 27 uses feet as its unit of measurement.
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NAD 83 zone North American Datum of 1983. A datum acts as a reference point, 
line, or surface for mapping. In general, NAD 83 uses meters as its unit of 
measurement.

non-destructive breakline Triangulation lines in a TIN do not cross a 
non-destructive breakline. Instead, new vertices are added to the breakline at the inter-
section of each TIN line and the breakline. The new points create additional surface 
triangles. This is useful when you do not want the elevation of a surface to be interpo-
lated inside an area that you know to be a constant elevation.

north rotation Means of specifying a north rotation or direction in AutoCAD 
drawing files. Bearings and azimuths are referenced from the drawing’s north rotation.

object Any 2D or 3D vector figure that is displayed graphically in the drawing. This 
includes contours, points, lines, arcs, polylines, and so on.

offset distance A perpendicular distance from an object or point to a reference line 
or arc.

offset A distance measured, usually at a right angle from an established line, that is 
used to locate a new position. A positive number indicates a right offset, a negative 
number indicates a left offset.

offsets Can represent such things as edges of pavement, sidewalk lines, and shoulder 
lines for a road. You create these as either symmetric or asymmetric offsets from the 
alignment.

parcel A discrete piece of land. For example, a subdivision is comprised of numerous 
parcels. Synonymous with lot.

point database Autodesk Land Desktop uses a project point database to store the 
point information for a project. This file is named points.mdb and is stored in the 
project’s \cogo folder (for example, c:\Land Projects 3\<project name>\cogo). Autodesk 
Land Desktop prompts you to set up this point database whenever you start a new 
project. 

point filters Key combinations that you can use to select COGO point objects in 
specific ways.

� Type .g (dot g) to select a point by clicking on it.

� Type .p (dot p) to select a point by typing the point number.

� Type .n (dot n) to select a point by typing its northing and easting coordinates.

A point filter remains active until you turn it off by entering either the point filter 
again or another point filter.

point group Point groups are used to group the points in the project into smaller, 
more manageable units. You can use point groups for selecting points you want to edit, 
or for specifying which points to use in a surface. For example, you can create a point 
group that contains all of the points in a project or only those points that represent 
existing ground elevations. 

Point groups are a collection of point numbers. When you use a point group, the point 
data is pulled from the point database for each point number in the group.

The point group definitions are stored in c:\Land Projects 3\<project 
name>\cogo\<groups.mdb>.
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point marker A point marker is a point location marker (like a dot or X) and text that 
usually indicates the point number, point description, and point elevation. When you 
create COGO points, point markers are created to represent the points on the 
AutoCAD graphics screen. 

point node You can place point nodes in a drawing by using the AutoCAD POINT 
command. Point nodes are useful as reference points that you can snap to. You can 
specify a full three-dimensional location for a point. You can change the appearance 
or size of a point nodes using PDMODE or PDSIZE. 

A point node is made up of only a point symbol and X,Y,Z data and is placed on the 
current layer. It does not have any associated northing, easting, or elevational data 
associated with it. It does not store point information in an external database. See also 
COGO point object.

point of curvature (PC) The point where an arc is drawn from a tangent.

point of intersection (PI) The point where two tangents meet on a horizontal align-
ment. Curves and spirals also have points of intersection, which are based on where 
the tangents would meet if they were extended outward. 

point of tangency (PT) The point where a curve meets a tangent.

point of vertical intersection (PVI) The point where two tangents meet on a vertical 
alignment.

polyface A 3-dimensional (polygon) mesh object. Each face is capable of having 
numerous vertices. 

precision The number of decimals to the right of the decimal point. For example, 
49.96 has a precision of two. Precision settings will round numbers. For example, if the 
precision is 2, a value of 4.926 is rounded up to 4.93. A value of 4.923 is rounded down 
to 4.92.

prime meridian The meridian at 0 degrees longitude. The prime meridian runs 
through the original site of the Royal Observatory at Greenwich, England, and is also 
known as the Greenwich meridian. 

prismoidal volumes A type of Section volume. When using this method, a regular 
grid is overlaid on the two surfaces. The elevations on both surfaces are calculated at 
each grid intersection. The resulting face is then broken into two triangular prisms. 
This method is most accurate when both surfaces have some amount of variation 
within them.

The following formula is used when you select the prismoidal volume calculation 
method:

V
L

A A A A= + +
3

1 1 2 2( * )
Glossary | 243



profile A longitudinal section based on a horizontal alignment. Also, vertical section 
of the surface of the ground along any fixed line which is usually parallel to the 
centerline.

project A project is a way to help you organize all the drawing files and support data 
files and settings that are associated with each job that you work on. 

Every drawing is assigned to a project. A project can contain many drawings that share 
the same project files like the point database, the alignment database, the parcel data-
base, and surface files.

prototype A prototype is a saved group of settings that you base a project on. You 
select a prototype every time you create a new project. Default prototypes are included 
with Autodesk Land Desktop: one is based on feet, another on meters. 

You can save drawing settings to a prototype. After you save drawing settings to a 
prototype, then all new drawings that you create, based on that prototype, will be 
created with the new settings, making it easier to maintain standard program settings 
for your drawings and projects. 

proximity breakline A polyline, representing a breakline, that is drawn without 
snapping to points in the drawing. The northing, easting, and elevation of the break-
line vertices are determined from the nearest point contained in the surface point data, 
after generating the surface.

quadrant Bearings are usually referenced by quadrant number. A quadrant is any 
one of the sections resulting from dividing a circle into four equal parts. Quadrant 1 is 
the NE corner, and quadrants 2, 3, and 4 proceed clockwise around the compass.

raster Raster data is a series of dots, or pixels, that represents an image. This type of 
data is produced when you scan a paper drawing, blueprint, or a photograph. Raster 
images can be 2-color, grayscale, or color. 

raw description The original description of a point, before any description key 
substitution has occurred. See also full description.

reverse curve A curve composed of a clockwise and counterclockwise curve, 
back-to-back in a horizontal alignment. These two curves form an S-shape.

right-of-way (ROW) When building an alignment, one crucial factor is the allow-
able work area. Property lines of the property owners who reside adjacent to the con-
struction site generally specify these limits, which are called right-of-way lines.

rubbersheeting Matching a distorted raster image or vector object to known vector 
points. Because a raster image, such as an aerial photograph, likely contains some dis-
tortion, you can select control points on the raster image and match them to vector 

Variable Value

V volume

L distance between
sections

A1 area of section 1

A2 area of section 2
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control points (known points in the X,Y,Z coordinate system). You can also match 
vector-to-vector. 

section volumes A method of calculating volumes. The section method calculates 
cross sections from two surfaces and generates volumes using either of two methods: 
Prismoidal or Average End Area. 

setup profile (drawing) A saved group of drawing setup settings. 

shortcut menu A menu that is displayed when you select an object and then click 
the right button of your mouse. Shortcut menus are context-sensitive so that only 
commands that are relative to the object that you selected are displayed.

site To calculate volumes, you must define the area that will be used in the volume 
calculations. This area is called a site, which you can define using grid cells. The site is 
limited to rectangular shapes. The site definition is used by the Grid, Composite, and 
Section volume methods, and is stored in the control file, {project}.gcf. This file also 
holds any site definitions for the project, and all the volume calculations.

sliver triangles Triangles that have comparably little area, resulting from the trian-
gulation of three points in which one point is only slightly offset from the edge that 
is created from the other two points. 

slope The incline or decline of a surface, expressed as a ratio of either horizontal 
distance to vertical distance or run to rise. For example, the ratio for a 2-to-1 slope is 
expressed as 2:1 (2’ of run to 1’ of rise).

south azimuth Azimuths south of the equator are referenced to due South clockwise. 

speed table Common references that are found in various publications on highway 
design. A speed table for a horizontal alignment includes a design speed with a list of 
the following: degree of curve, radius, superelevation rate (e), spiral length or A factor 
for two-lane designs, and spiral length or A factor for four-lane designs.

spiral A curve comprised of short segments that does not have a consistent rate of 
curvature or radius. 

In modern transportation design, vehicle dynamics, as well as safety and comfort con-
siderations, dictate the need to avoid abrupt changes in horizontal curvature. Such 
changes, which are encountered either where a tangent meets a circular curve or at 
points of compound curvature, can be avoided by using spiral (or transition) curves. A 
spiral also provides the logical location for the introduction of superelevation, so that 
it is matched to the local curvature of the alignment at every point.

spiral to curve (SC) The point where a spiral meets a curve.

spiral to tangent (ST) The point where a spiral meets a tangent.

spot elevation Refers to the elevation of a single point in the drawing. Use spot 
elevations to define areas that are sparse in contour data when generating a TIN using 
the contour information. Areas that may also need spot elevations are the top of hills, 
valleys, and bottom of swales.

stakeout The process of placing stakes in the ground at control points on a site that 
is being developed. For example, after you place points in your drawing, or after you 
design an alignment, you can create stakeout reports that list the coordinates of each 
stake. Someone else can then use these stakeout reports to place (or adjust) the stakes 
at the site.
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standard breakline A breakline defined from selecting consecutive points or point 
numbers, or selected 3D polyline or 3D line objects.

state plane The plane-rectangular coordinate systems for use in defining geodetic 
stations. A grid is imposed upon a map projection of a specified zone or area. Northing 
and easting coordinates in a state plane system are called Grid Northing and Grid 
Easting.

static labels Static labels are labels that never change position, content, or style after 
you create them. Static labels cannot be updated unless you change their update 
properties. See also dynamic labels.

stationing (chainage) Horizontal alignments are generally labeled to provide a ref-
erence when talking about a specific point along the reference baseline. This labeling 
is called stationing and is marked out every 100 feet along the alignment (U.S. 
method). When referring to any point along the alignment, the station is given in 
hundreds of feet. For example, for information for a point that sits 1776.85 feet into a 
project, the station is 17+76.85. In the metric system, it is displayed in thousands of 
meters. For example, information for a point that sits 1776.85 meters into a project, is 
at station 1+776.85.

stratum The difference between two surfaces that exist in a drawing, usually the 
existing ground surface and a finished ground surface, and is used for calculating 
volumes. 

superelevation Used on curves to compensate for the centrifugal force on a vehicle. 
In order to maintain safe, continuous operation of a vehicle, the traveling lanes are 
superelevated, or banked, around the curve.

supplementing distance The supplementing distance is the maximum distance 
between contour vertices. If the distance between vertices on a contour is greater than 
specified, then points will be added along the contour in equal increments that are less 
than or equal to the supplementing distance. Used when creating contour data for a 
surface; not for creating contours.

surface A triangular irregular network (TIN) of elevational data. The points of a 
surface are connected into triangles, which are then used to interpolate contours, and 
to generate profiles and cross-sections. A surface represents the ground condition at a 
particular time or event. For example, the existing ground surface defines a ground 
before it was modified, and a proposed or finished ground surface is based on a site 
design of proposed earthwork.

surface area The 3-dimensional (3D) area of a triangle face computed from the 
northing, easting, and elevation of each triangle point. The total surface area is the 
sum of the 3D triangle face areas within the surface boundary(s).

surface border The limits of a surface based on the 2-dimensional extents (minimum 
and maximum northing and eastings) of the triangulated surface data.

surface boundary The active area(s) of a surface defined from a closed polyline.

tag label Tag labels are shortened labels used to mark a line, curve, or spiral. By 
default, a line is tagged with L, a curve with C, and a spiral with S. Each line, curve, 
and spiral is also given a tag number. For example, your lines would be tagged with L1, 
L2, and so on. 
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After you label your objects with tags, you can create tables which display the tag num-
ber and then list detailed information about the object. When you use a table, you can 
usually display more information about an object than you could if you were labeling 
the object itself.

tangent A straight line that touches a given curve at only one point, and does not 
intersect it (line slope equals curve slope at the point).

terrain A terrain model represents the surface of the Earth, either as it currently exists 
(existing ground or as-built), or at a future time (finished ground).

TIN Triangular Irregular Network. Created when you build a surface. A TIN is the 
most common method of interpolating elevational data. The points are connected 
into triangles which are used to interpolate for contours, and to generate profiles and 
cross-sections. The lines that make up the surface triangulation are called TIN lines.

triangle area The 2-dimensional (2D) area of a triangle face computed from the 
northing and easting of each triangle point. The total triangle area is the sum of all 
2D triangle areas with the surface boundary(s).

trim (surface) The process of removing unwanted TIN lines from a surface, thereby 
removing triangles.

vector Vector data is a group of mathematical equations that generates lines, arcs, 
and so on. This type of data is produced when you draw objects in your drawing. 

vertical factor A real number, other than 1.0, used to exaggerate the vertical repre-
sentation of a surface. To determine the elevations of the surface, apply the vertical 
factor to the difference between the real elevation and the base elevation, then add the 
result to the base elevation.

vertical scale The vertical scale is compared against the horizontal scale to calculate 
the vertical exaggeration in profiles and cross sections. It does not actually change the 
scale that is used when the drawing is plotted. 

volume surface A volume surface is created when you calculate volumes using the 
grid or composite methods. The surface is created from the two surfaces that make up 
the stratum. The elevational values of a volume surface are actually the difference 
between the two surfaces. For example, at point 1000,1000, the bottom surface has an 
elevation of 100, and the top surface has an elevation of 150. The elevation of point 
1000,1000 on the volume surface is the difference between the two surfaces, which 
is 50. 

In terms of cut and fill situations, if a point is in a fill situation, then the elevation of 
the volume surface at that point is a positive number. If a point is in a cut condition, 
then the elevation of the volume surface at that point is a negative number.

Because surfaces are generated from the grid and composite volume calculations, you 
can create cut and fill contours from a volume surface to show the depths of cut and 
fill, and you can use any of the surface display commands to view the surface.

wall breakline Represents terrain features such as retaining walls, curbs, bridge 
abutments, and so on. You can define these breaklines by selecting an existing 
polyline. The command extends this polyline by creating new polyline segments and 
vertices that are parallel to the original polyline, but offset at a very small incremented 
distance.
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water drop trail A polyline representing the trail of a water drop as it follows the 
3D triangle faces of the surface. The path of the water drop trail continues until it 
reaches an outflow area.

watershed The catchment area for rainfall that is delineated as the drainage area pro-
ducing runoff. Base flow in a stream also usually comes from the same area.

weeding factors You can use the weeding factor settings to reduce redundant points 
along the contours by ignoring contour vertices that are close together or along a 
straight line. A larger distance and deflection angle will weed a greater number of 
points. Distance is an absolute measure and the angle is measured in degrees. The 
larger the distance value, the greater the number of weeded points. The weeding 
factors must be less than the supplementing factors.

A point on the contour is weeded by calculating its location in relation to the vertices 
before and after it. If the length between these three points is less than the weeding 
length value, and the deflection angle is less than the weeding angle value, then the 
middle point will not be added to the contour data file.

Used when creating contour data for a surface; not for creating contours.

weeding The removal of points along a selected polyline representing a contour. The 
weeding factors determine the amount of points removed. You can use weeding to 
reduce the amount of point information taken from the contours that may not be nec-
essary to generate an accurate surface. See also weeding factors.

XDRef An XDRef is a pointer to a column of data in an external database. The data-
base must be keyed by point number. Then when an XDRef is used to get a value for 
some attribute of a point, the point number is looked up in the database, and the value 
from the specified column is used, in place of the point’s original attribute value.

z value Elevational value in an X,Y,Z coordinate system.

zero height text style An AutoCAD text style that has a height of zero assigned to it. 
For example, by default, the AutoCAD STANDARD text style is a zero-height style. 

A zero-height text style requires you to specify the height each time you use the text 
style. In contrast, a fixed-height text style does not require you to specify the text 
height each time that you use it. 

zone Synonymous with Global Coordinate System. The global coordinate system 
describes how the sphere of the Earth is projected onto a sheet of paper and converted 
to the Cartesian coordinate system. A global coordinate system can differ based on the 
projection type, datum, and units that are used.
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Index

3D graphics system requirements, 22

A
accessing commands, 39
adding components to stand-alone 

installations, 30
alignment database, 193
alignments, 192

deleting and importing, 199
editing, 197
exporting as LandXML data, 223
importing as LandXML data, 227
listing, 211
making current, 195
making into one object, 194
offsetting, 201
stationing, 201

annotation, leaders, 147
APWA symbol standards, 142
arcs, 138
ARX objects, 67

bounding box, 68
ASCII point files, importing into project, 97
associating drawings with projects, 6
authorizing Autodesk Land Desktop, 29
Autodesk Land Desktop, 2

accessing commands, 39
adding components, 30
authorizing, 29
commands on command line, 48
documentation, 12
drawing environment, 38
exiting, 84
installing, 19
menu palettes, 41

Autodesk Land Desktop (continued)
new features, 3
preference settings, 49
preferences, 9
projects, 5, 58
prototypes, 7
registering, 29
reinstalling on stand-alone computers, 30
repairing on stand-alone computers, 30
setting up drawing environment, 55
starting the program, 36
status bar, 46
templates, 8
toolbars, 43
uninstalling on stand-alone computers, 32
upgrading to, 24

AutoSnap, 80
AutoTrack, 82

B
bitmap files, digitizing, 148
blocks, 156

scaling, 155
symbols, 142

boundaries (surfaces), 167
breaklines in surfaces, 163, 165
breaklines, listing, 211
breaks, inserting in objects, 154

C
CAD point nodes, 88
CAD points, converting to COGO points, 89
catchment areas (watershed models), 171
checking points, 108
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circles, 138
clothoid spirals, 135
COGO points, 86

creating, 88
exporting as LandXML data, 223
from CAD points, 89
importing as LandXML data, 227
point creation settings, 93
See also points

color display, changing, 56
command history, viewing, 49
commands, accessing, 39

on command line, 48
pre-defined menu palettes, 41
pull-down menus, 40
shortcut menus, 47
status bar, 46
text window, 49
toolbars, 43
transparent commands, 48

Compact installation, 25
components, adding to stand-alone 

installations, 30
contours (surfaces), 167

creating, 180
creating from surfaces, 180
digitizing, 148
grading methods, 174
hiding in ponds and buildings, 183

converting units with LandXML, 222
coordinate geometry. See COGO points
coordinate zone transformations, importing 

points, 102
copying objects, 151, 153

multiple copies, 153
cosinusoidal spirals, 135
cross sections

exporting as LandXML data, 223
quick views, 178

Ctext, 145
curved

lines, 133, 139
objects, 138
text, 145

Custom installation, components, 25
custom objects and proxy graphics, 68
customized files and settings

using from previous versions, 28
customizing

menu bar, 42
menu palettes, 42

cut and fill areas, highlighting, 187

D
damaged or missing files, repairing, 30
data files, settings, 54

data, exporting in LandXML, 223
database, points, 90
DEM files, 163, 168

in surfaces, 162
description keys, 114

example, 117
exporting as LandXML data, 223
importing as LandXML data, 227
point markers and point labels, 115
point settings, 116

description parameters (points), 116
dialog bar, label style properties, 215
Digital Elevation Models.  See DEM files
digitizing

images, 148
methods, 148

Direct3D Heidi 3D display driver, 22
directories, choosing during installation, 26
display options, 56
displaying toolbars, 43
donuts, 138
drawing aids, 77

hatch patterns, 139
reference points, 79
snap points, 79

drawing environment, setting up, 38
drawing objects, 136

block definition, 156
curved objects, 138
polylines, 137
text, 143

drawing settings, 9, 52
points, 93
prototypes, 59

drawing sheets, laying out for plotting, 133
drawing tools

special lines, 136
spiral curves, 134
text, 143

drawings
adding external drawings, 158
associating with projects, 6
correcting mistakes, 152
creating, 62
modifying settings, 52
opening, 67
organizing layers, 73
paper space, 133
regenerating and redrawing, 73
scaling the view, 71
setup, 8, 64
sharing with other AutoCAD programs, 67
using named views, 72
viewpoints, 69

dynamic labels, 213
dynamic view, 70
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E
editing label styles, 219
editing points, 104

selecting, 105
editing surfaces, 175

edit history, 176
editing tools, 149

correcting mistakes, 152
creating selection sets, 150
using grips, 151
utilities commands, 155

ellipses, 138
erasing objects, 152
errors, correcting, 152
exiting the programs, 84
exporting LandXML data, 223

alignments, 223
cross sections, 223
parcels, 223
points, 223
profiles, 223
surfaces, 223

exporting point references, 225
external data references (xdrefs), 119
external drawings (xref), attaching, 158

F
fence lines (special lines), 136
file paths, setting, 50
files from previous versions, 28
filters

for layer groups, 76
in selections sets, 150
points, 102

finished ground data (surfaces), 174
floating viewports. See layout viewports
folders for prototypes, 61
font styles, in text, 143
Full installation, 25

G
Geodetic Calculator, 123

calculating state plane coordinates, 124
geodetic transformation (points), 123
grips, editing objects, 151

H
hard disk requirements

for stand-alone computers, 21
hardware requirements

for stand-alone computers, 20
hatch patterns, creating, 139
Heidi 3D display drivers, 22

Help
accessing, 13
how to use, 14, 16

history of commands, viewing, 49

I
importing

alignments, 199, 227
LandXML data, 227
parcels, 227
points, 97, 227
profiles, 227
surfaces, 227

inquiry commands, 210–211
installation types

Compact, 25
Full, 25
Typical, 24

Installation wizard for stand-alone 
computers, 23

installing Autodesk Land Desktop, 19
3D graphics system requirements, 22
adding components, 30
authorizing, 29
choosing directories, 26
on stand-alone computers, 22
repairing damaged or missing files, 30
system requirements, 20
uninstalling, 32
using files from previous versions, 28

installing on stand-alone computers
Autodesk Land Desktop, 24, 27
installation types, 24
Volo View Express, 27
write permissions required, 22

L
labels, 213, 215

accessing label commands, 214
editing, 219
label styles, 213
point labels, 88
style properties dialog bar, 215

LandXML schema, 222
LandXML, using, 222

exporting data, 223
import comparison results report, 230
importing data, 227

layers, 75
changing properties, 74
creating groups, 75
Layer Manager, 75
saving in snapshots, 75
using in drawings, 73
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layout mode, 130
layout viewports, 132

displaying objects, 133
drawing scale, 71

leaders, annotation, 147
lines

curved, 139
drawing, 133
polylines, 137
special lines, 136

linetypes, special lines, 136
listing object data, 210

M
macros, loading menu palettes, 42
Map project workspace

drawing environment, 38
menu palettes

customizing, 42
loading with a macro, 42
selecting, 10, 41
using, 9

MENULOAD command, 10, 42
menus

custom menu bar, 42
loading, 41
pull-down, 40

mistakes, correcting in drawings, 152
model space, 130

switching to layout mode, 130
modifying objects, 152

copying, 153
inserting breaks, 154
moving, 151, 153, 158
resizing, 154
using grips, 151

multiline text (MTEXT), 144
multi-user alignment database, 193

N
notes, attaching text to objects, 146

O
object data, listing, 210
Object Enabler, 67
object snaps, 79
Object Viewer, 69
objects

and proxy graphics, 68
changing properties, 74
custom, 68
defining as road alignment, 194
editing, 149
labeling, 213, 215
methods of selection, 149

objects (continued)
modifying, 152
proxy objects, 67
querying, 211

online Help, accessing, 13
Oops command, 152
Open GL Heidi 3D display driver, system 

requirements, 22
operating system requirements

for stand-alone computers, 20
options

drawing environment, 55
window display, 56

Oracle8i Spatial requirements
for stand-alone computers, 21

overriding point data in point groups, 113
external data references, 119

P
palettes.  See menu palettes
panning an image, 70
paper space, 130, 132–133

See also layout viewports
parcels, 204

calculating volumes, 185
exporting as LandXML data, 223
geometry, 204–205
importing as LandXML data, 227
managing, 207

persistent properties in point groups, 109
perspective views, 69
plotting drawings, configuring, 130
point database, 90

matching drawing points, 108
multi-users, 93
setting up, 92

point groups, 109
checking status, 112
exporting as LandXML data, 223
importing as LandXML data, 227
new features in Land Desktop, 109
overriding point data, 113
persistent properties, 109
saving to prototype, 110
updating, 112

point labels, 88
point markers, 87

changing settings, 95
description keys, 115

point references, exporting, 225
points

COGO point objects, 88
creating, 96
creating point groups, 109
creation settings, 93
description keys, 114
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points (continued)
description parameters, 116
editing, 104–105
geodetic transformation, 123
importing, 97
marker settings, 95
new features, 89
point database, 90, 92
point filters, 102
point labels, 88
point markers, 87
settings, 93
synchronizing, 108
text settings, 95

polar array, creating, 153
polylines, 137
preference settings, 50

AutoCAD overrides, 50
data files, 54
drawing setup, 51
drawings, 52
file paths, 50
prototype, 53

processor requirements
for stand-alone computers, 20

profiles
exporting as LandXML data, 223
importing as LandXML data, 227

project point databases, 90
matching points to, 108
setting up, 92

projects, 5, 58
associating drawings, 6
drawing setup, 64
file locks, 60
managing, 60
prototypes, 53
renaming, 60

properties, object and layers, 74
prototypes, 7

default folder, 61
introduction, 59
managing, 61
saving point groups to, 110
settings, 53

proxy graphics, 67

Q
quadratic spirals, 135
querying drawing objects, 211

R
RAM requirements

for stand-alone computers, 20

raster images
digitizing, 148
listing, 211

raw descriptions
point selection, 109

Readme file, 27
realtime zoom, 70
rectangular array, creating, 153
Redo command, 152
redraw and regenerate drawings, 73
reference points, 79

tracking, 82
registering Autodesk Land Desktop, 29
reinstalling Autodesk Land Desktop on 

stand-alone computers, 30
repairing

Autodesk Land Desktop on stand-alone 
computers, 30

damaged or missing files during 
installation, 30

reporting data with LandXML, 222
reports, from queries, 211
reports, LandXML import 

comparison results, 230
resizing objects, 151, 154
roadway alignments, 192

defining objects, 194
deleting and importing, 199
editing, 197
offsetting, 201
stationing, 201

rotate objects with grips, 151
rubber-sheeting vectors, 149
running object snaps, 79

S
scale factor, zooming, 70
scale, in layout viewports, 71
scaling blocks, 155
schema, LandXML, 222
sections, quick views of surface, 178
selecting points, 105, 107

methods, 110
selection methods (objects), 149
selection sets, using filters, 150
settings, 49

data files, 54
drawing setup, 51
file paths, 50
modifying in drawing, 52
overriding AutoCAD commands, 50
point creation, 93
point marker, 95
point text, 95
points, 93
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settings (continued)
prototypes, 53, 59
using customized from 

previous versions, 28
window display, 56

setup profiles, 8
sheets, laying out for plotting, 133
shortcut menus, 47
single-line text, 144
sinusoidal spirals, 135
snaps, 79
software requirements

for stand-alone computers, 20
special lines (linetypes), 136
spiral curves, 134
splines, 139
stand-alone computers

hard disk requirements, 21
Installation Wizard, 23
installing Autodesk Land Desktop 3, 22
reinstalling Autodesk Land Desktop, 30
system requirements, 20
types of installations, 24

starting Autodesk Land Desktop, 36
display options, 56

static labels, 213
stretching objects with grips, 151
subdivisions

parcels, 204
summary, LandXML import results, 230
surface grid, projecting 2D objects onto, 189
surface models, 162

hiding contour lines, 183
showing statistics, 211
using Terrain Model Explorer, 164

surfaces, 168
breaklines, 165
calculating volumes, 185
creating contours, 180
cutting cross sections of, 178
data, 165, 174
displaying, 189
editing, 175
exporting as LandXML data, 223
finished ground data, 174
hiding regions, 183
importing as LandXML data, 227
viewing in 3D, 188
viewing information about, 177
vizualizing, 177
watershed models, 171

surfaces, creating, 162
boundaries, 167
breaklines, 163
contours, 167
surface data, 165
Terrain Model Explorer, 164

surfaces, creating (continued)
triangulated irregular networks.  See TIN
using various data, 162

symbols
accessing, 142
associating with points, 114
in special lines, 136
using for description keys, 114

system folder
write permission requirements, 22

system registry
write permission requirements, 22

system requirements
for stand-alone computers, 20

T
tabs, model and layout, 130
tag labels, 213
templates, 8
Terrain Model Explorer, 164, 177

edit history (surfaces), 176
text

attaching to objects, 146
curved, 145
inserting, 143
multiline, 144
single line, 144

text window, 49
tiled viewports (model space), 130
TIN (triangular irregular networks), 162
Today window, using, 36–37
toolbars, displaying in Land Desktop, 43
tracking, 82
transferring and archiving data with 

LandXML, 222
transformations, geodetic, 123
translating and rotating coordinates with 

LandXML, 222
transparent commands, 48
tree lines (special lines), 136
Trimble Link

installing, 27
uninstalling, 32

tutorial, Autodesk Land Desktop, 12, 16
Typical installation, 24

U
Undo command, 152
uninstalling

Autodesk Land Desktop, 32
Trimble Link, 32
Volo View Express, 33

updating
point groups, 112
points, 108
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upgrading to Autodesk Land Desktop 3, 24
user preferences, 9

V
vector objects, 148

from raster objects, 149
vectors, rubber-sheeting, 149
viewports

displaying objects, 133
laying out a drawing sheet, 133
layout, 132
tiled (model space), 130

views
Object Viewer, 69
quick access from toolbar, 69
saving, 75
scaling, 71
using named views, 72
viewpoints, 69
zoom and pan, 70

Volo View Express, 27
uninstalling, 33

volumes
calculating cut and fill, 185
calculating methods, 185
cut and fill tick marks, 187

W
waterdrop paths, 171
watershed models

catchment areas, 171
channel network, 171
creating, 171
drain targets, 171
watersheds, 171

window
display options, 56
Object Viewer, 69

Windows 98
uninstalling Autodesk Land Desktop on, 33

Windows Millennium Edition (ME), 3
uninstalling Autodesk Land Desktop on, 33

Windows NT
uninstalling Autodesk Land Desktop on, 33

write permission requirements
for stand-alone installations, 22

X
xdrefs. See external data references
xrefs. See external drawings

Z
zoom options, 70

naming and saving views, 72
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